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STAAD.Pro is the choice of 47 out 
of 50 leading Structural Engineering 
firms, 46 out of 50 state DOTs and 7 
out of the top 10 engineering 
universities. 

WHY WHY STAAD.STAAD.ProPro
STAAD.Pro was developed for practicing engineers.

For static, pushover, dynamic,
P-delta, buckling or cable 
analysis, STAAD.Pro is the 
industry standard

STAAD.Pro has design codes for most
countries including US, BS, Canada,
Russia, Aus, France, India, China,
Euro, Japan… NO THAI?



WHY WHY STAAD.STAAD.ProPro
STAAD.Pro is fully COM (Component Object Model).
Any 3rd party applications can be used with STAAD.Pro.

STAAD.Pro’s User Interface is  the
industry standard. Complex models 
can be easily generated.

STAAD.Pro supports multi-material design 
codes such as timber, steel, cold-formed steel,
concrete and aluminum.

EaseEase--ofof--UseUse
Graphical User Interface with tabbed page layout.

Structure Wizard



Model Generation

• Create Model using Graphical 

Environment, Spreadsheet style input, 

AutoCAD DXF Import etc 

• Repeat either translational or circular 

• Mirror, Rotate, Copy and Paste 

• Remove Duplicate/Orphan Nodes 

• Dynamic Zoom Capability 

• Create Beams, Plates and Solids 

• Offset Members, Semi Rigid 

Connections, Partial Moment Release 

Built-in Command File Editor

• Simple Command Language



Finite Element Modeling

• Plate Element

• Surface Element

• Solid Element

Load Types and Generation
• Categorized load into group types like
dead, live, wind, seismic, user-defined. 

• Auto-generate load combinations based
on standard codes: ACI, AISC, UBC 

• ASCE 7 Wind load generator

• Loading: Concentrated, Uniform, Temp.,
Strain, Support disp,, Prestress

• AASHTO Moving Load Generator

• Seismic Load Generator

• Automatic generation of load envelopes



Model Verification

Multiple zooming and shadow box windows

New 3D rendering of structure using shading 
and lighting

Isometric or any rotations for full 3D viewing 

Display of Loads, Supports, Orientations, 
Properties, Hidden line removed, Joint/Member 
numbering, Dimensions, etc. 

Compatible with spreadsheet software such as 
Microsoft Excel 

Plots of displacement vs. time, velocity vs. time,
acceleration vs. time for dynamic analysis

Single File Archive to save All STAAD Input /
Output Files

Analysis Capabilities
Powerful analysis and design engines with advanced finite
element and dynamic analysis capabilities.

§ 2D/3D Static Analysis

§ Dynamic/Sesmic Analysis

§ Secondary Analysis



Analysis Capabilities

New 2007 Features

• Advanced Analysis Engine

• P-Delta analysis including
stress stiffening effects

• P-Delta including small delta

• Modal analysis including
stress stiffening

• Buckling load analysis

Full buckling analysis to obtain buckling 
modes and factors for various loading 
conditions

Design Codes
Steel Design: 

Design Codes : AISC (ASD/LRFD), 
AASHTO, BS, Japanese, Chinese, Indian

Interactive design and report step-by-step 
calculations.

Built-in Steel Tables of several countries 
including AISC, British, Canadian, Australian

Code Check, Member Selection consisting of 
Analysis/Design cycles



Design Codes
Concrete Design: 

Interactive concrete design and detailing with bar scheduling and 
interactive rebar layout

Rectangular concrete shear wall design (with deep beam design).

Two-way slab design to design irregular-
shaped slabs. Full reinforcement contour and
reinforcement layout plans are created.

Automatic calculation of cracked moment of inertia for concrete design

Design of Concrete Beam/Column/Slab per ACI 318.

Numerical and Graphical Design Outputs with reinforcement details

Timber Design: Aluminum Design: 

Result Verification

Exhaustive dynamics capabilities 
including time history, response spectra, 
blast loading and harmonic loading

Plot moments, stresses, 
displacements and mode shapes



User Customized Report Generation

Take a picture
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1 
แนะนําโปรแกรม STAAD.Pro 

 

1.1 รูจักกับโปรแกรม 
STAAD.Pro เปนซอพทแวรวิศวกรรมโครงสรางท่ีไดรับความนิยมท่ีสุดในการสรางแบบจําลอง
สามมิติ, การวิเคราะห, และการออกแบบ มีระบบติดตอกับผูใชงานแบบกราฟฟกท่ีใชงานงาย มี
เครื่องมือในการแสดงผลท่ีหลากหลาย มีความสามารถในการวิเคราะหและออกแบบท่ีมีประสิทธิภาพ 
ซอพทแวรใชงานไดกับทุกระบบปฏิบัติการวินโดวแตจะใชไดดีท่ีสุดกับ Windows XP 

 STAAD.Pro เปนโปรแกรมท่ีถูกเลือกโดยมืออาชีพในการออกแบบท่ัวโลกเลือกใช ท้ังการ
วิเคราะหแบบสถิตยศาสตรหรือจลศาสตรของสะพาน, โครงสรางถังบรรจุ, โครงสรางใตดิน, 
โครงสรางเหล็ก, คอนกรีต, อลูมินั่ม หรือ โครงสรางไม, หอคอยเสาสง, สเตเดียม หรือโครงสรางท่ี
ซับซอนอ่ืนๆ 

 1.2 ความสามารถของเครื่องท่ีติดตั้ง 
• เครื่อง PC ท่ีมีซีพียูเพนเทียมของอินเทลหรือเทียบเทา 

• การดแสดงผลและหนาจอความละเอียด 1024x768, 256 สี (แนะนํา 16 bit high color) 

• 128 MB RAM หรือมากกวา 

• Windows NT 4.0 หรือระบบท่ีสูงกวา ไมแนะนําใหรันโปรแกรมบน Windows 95 & 

Windows 98 เพราะสมถนะการทํางานตกลง โปรแกรมทํางานดีท่ีสุดบน Windows 2000 และ 
XP 

• พ้ืนท่ีวางเพียงพอในฮารดดิสก ขึ้นกับโมดูลท่ีติดตั้ง โดยท่ัวไปตองการอยางนอยท่ีสุด 500 MB 

• ระบบมัลติมิเดียท่ีมีการดเสียงและลําโพงเพ่ือรันวีดิโอและสไลดสอนการใชงาน 

หมายเหตุ: การเพ่ิม RAM และความจุฮารดดิสกจะชวยเพ่ิมประสิทธิภาพการทํางานของโปรแกรม 
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นับตั้งแต STAAD.Pro 2001 เปนตนมาขนาดโครงสรางท่ีโปรแกรมจัดการไดมีขนาดเพ่ิมขึ้นมาก 
ทําใหขนาดของหนวยความจําจริงและแบบเสมือนเพ่ิมขึ้นเกิน 600MB ผูใชจึงตองตรวจสอบวามี
หนวยความจําเพียงพอหรือไม 

1.3 องคประกอบของ STAAD.Pro 
STAAD.Pro เปนโปรแกรมท่ีมีการพัฒนาอยูตลอดเวลาในชุดโปรแกรมจะประกอบดวยโปรแกรม
ยอยตางๆดังนี้ 
 

 

STAAD.Pro ตัวโปรแกรมหลักใชสรางโมเดล วิเคราะหและออกแบบ 
แสดงผลแบบกราฟฟกและแบบตาราง และสรางเปนรายงาน 

OpenSTAAD เปนแหลงเก็บรวมฟงกช่ันของ STAAD.Pro ซ่ึงจะ
ยอมใหผูใชนําไปใชในโปรแกรมของตนเองได 

  

 

STAAD.etc เปนเครื่องมือชวยทางวิศวกรรมโครงสรางทุกอยางท้ัง
วิเคราะหและออกแบบไมวาจะเปน พ้ืน แผนรองฐานเสา ฐานราก และ
อ่ืนๆ 

  

 

 

STAAD.foundation เปนโปรแกรมท่ีใชในการวิ เคราะหและ
ออกแบบฐานรากของโครงสรางท่ีถูกสรางใน STAAD.Pro โดย
ออกแบบไดท้ัง ฐานเดี่ยว ฐานรวม ฐานรากแบบแพ และฐานรากเสาเข็ม 

  

 

Section wizard เปนโปรแกรมท่ีใชในการคํานวณคุณสมบัติหนาตัด
ของช้ินสวนโครงสราง ตารางเหล็กตามมาตรฐานตางๆ และหนาตัดท่ี
ผูใชสรางขึ้นเอง 

  

 Advance Mesher เปนโปรแกรมแยกใชในการสราง mesh ของ
ช้ินสวนท่ีเปนแผน เชนผนังและพ้ืน 
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1.4 การรันโปรแกรม STAAD.Pro 
คลิกไอคอน STAAD.Pro จากกลุมโปรแกรม STAAD.Pro 2007 

 
 
หนาจอหลัก STAAD.Pro แสดงขึ้นมาดังในรูปขางลาง 
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หรือถาเปน STAAD.Pro 2005 และ 2006 หนาจอเริ่มตนจะเปน 

 
 

คลิกเลือก Cancel แลวคลิกไอคอน Open Structure  เพ่ือเปดไฟลตัวอยางท่ีมีอยูแลว 

เลือกไฟลตัวอยางจากในโฟลเดอร: 

SPro2005/STAAD/Examp/US/EXAMP09.STD 
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1.5 สวนประกอบหนาจอ STAAD.Pro 

 

หนาจอ STAAD.Pro เปนดังในรูปขางลาง มีสวนประกอบหลัก 5 สวนคือ 

เมนูบาร (Menu Bar) 

อยูบนสุดของหนาจอ เราสามารถเรียกไดทุกคําส่ังของ STAAD.Pro ไดจากเมนูนี ้

ทูลบาร (Toolbar) 

ทูลบารท่ีอยูถัดลงมาจากเมนูและท่ีอยูในแนวดิ่งดานซายซ่ึงสามารถถอดเขาออกได ใชในการส่ังคําส่ัง
ท่ีใชบอย เพ่ือความสะดวกรวดเร็วในการทํางาน โดยผูใชสามารถกําหนดไดเอง 

เมนวินโดว (Main Window) 

เปนพ้ืนท่ีใหญท่ีสุดบริเวณกลางหนาจอ ใชแสดงโมเดลและผลการคํานวณ 

เพจคอนโทรล (Page Control) 

เปนชุดแถบดานขางซายของเมนวินโดว มีสองแถวคือแตละหนาหลัก (Pages) จะแยกออกเปนหนา
ยอย (Subpages) ใชทํางานเฉพาะอยาง การเรียงหนาหลักและหนายอยจะเปนไปตามลําดับการ
ทํางาน  

พ้ืนที่ขอมูล (Data Area) 

เปนพ้ืนท่ีทางขวาของหนาจอ แสดงกลองโตตอบ (Dialog Boxes) ตาราง (Tables) หรือ กลอง
รายการ (List Boxes) ตางๆตามลักษณะการทํางาน 
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1.6 โหมด (Mode) ในการทํางาน 
STAAD.Pro มีหลายโหมดการทํางาน เลือกไดจากเมน ูMode มีใหเลือกดังนี้ 

การสรางโมเดล (Modeling) 

หรือโหมดกอนการประมวลผล (Pre-processing) เปนขั้นตอนในการกําหนดขนาดโครงสราง 
น้ําหนักบรรทุก จุดรองรับ และอ่ืนๆ โดยปกติแลวเม่ือเริ่มใชงานโปรแกรมเขาสูโหมดนี้กอน 

หลังการประมวลผล (Post -processing) 

จะเปนขั้นตอนท่ีผูใชตรวจสอบผลการคํานวณวิเคราะหของโปรแกรม ท้ังแบบกราฟฟกและแบบ
ตัวเลข ตลอดจนการสรางรายงานสรุป 

การออกแบบเชิงปฏิสัมพันธ (Interactive Design) 

จะใหผูใชออกแบบช้ินสวนโครงสราง (จุดตอโครงสราง, ฐานราก, แผนเหล็กรองฐานเสา และอ่ืนๆ) 

กอนการประมวลผลสะพาน (Bridge Deck Preprocessor) 

จะใหผูใชสรางน้ําหนักบรรทุกบนหลังสะพานเนื่องจากการเคล่ือนท่ีของยานพาหนะ ใชกับโปรแกรม
ยอย STAAD.beava 

งานทอ (Piping) 

โหมดนี้จะใชรวมกับ ADLPIPE เพ่ือใหสามารถเรียกดูรูปรางของโครงสรางดงักลาวได 

1.7 โหมดสรางโมเดล 
การสรางโมเดลใน STAAD.Pro ทําไดสองวิธีคือ 

a. ใชไฟลคําส่ัง (Command file) 

b. ใชการสรางแบบโตตอบเชิงกราฟก 

ไฟลคําส่ังคือไฟลขอความบรรจุขอมูลโครงสราง โดยจะเปนคําส่ังในภาษาท่ีเขาใจงายตามรูปแบบ
ของ STAAD.Pro ผูใชสามารถสรางไฟลนี้ไดโดยใชโปรแกรมอิดิเตอรท่ัวไปเชน Notepad หรือ 
WordPad หรือใชท่ีมากับโปรแกรม STAAD.Pro โดยระหวางใชงาน STAAD.Pro ผูใชสามารถ
เปดไฟลคําส่ังขึ้นมาตรวจสอบและแกไขได 

  การเปด STAAD Editor ทําไดโดยการคลิกไอคอน    บนทูลบาร 

วิธีการสรางแบบกราฟกจะใชเครื่องมือทางกราฟกในโหมดสรางโมเดล และกําหนดขอมูลเชน  
คุณสมบัติวัสด,ุ คาคงท่ีตางๆ, น้ําหนักบรรทุก และอ่ืนๆ โดยขณะท่ีสรางโมเดลไปไฟลคําส่ังก็จะถูก
สรางขึ้นโดยอัตโนมัติอยูเบ้ืองหลังซ่ึงผูใชสามารถเปดดูไดตลอดเวลา 
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วิธีหนึ่งท่ีจะรูวาเราอยูในโหมดไหน คือดูจากขอความบนแถบสถานะดานลาง (ดูรูปขางลาง) 

 

1.8 หนาตางๆในโหมดสรางโมเดล 
หนาหลัก (Pages) และหนายอย (Subpages) ในโหมดการสรางโมเดลมีดังนี้คือ 

 

• Setup 
Ø Job 

• Geometry 
Ø Beam 
Ø Plate 
Ø Surface 
Ø Solid 
Ø Parametric Models 
Ø Composite Deck 

• General 
Ø Property 
Ø Spec 
Ø Support 
Ø Load 
Ø Material 

• Analysis/Print 
Ø Pre-print 
Ø Analysis 
Ø Post-print 

• Design 
Ø Steel 
Ø Concrete 
Ø Timber 
Ø Aluminum 
Ø Footing 
Ø Shearwall 
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1.9 หนา Setup | Job 
หนา Setup | Job ใชใสขอมูลท่ัวไปของโครงสราง เม่ือคลิกเลือกหนา Setup | Job กลองโตตอบ
จะแสดงขึ้นมาดังในรูป 

  

คลิกปุม More จะมีหนาจอ Structure Information แสดงขึ้นมาจะแสดงจํานวนจุดตอ, คาน, และ
แผนท้ังหมดในโครงสราง 
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1.10 หนา Geometry | Beam 

 

ใชสําหรับสรางองคอาคารแบบเสนเช่ือมระหวางสองจุดตอเชน คาน, เสา, และองค
อาคารโครงถัก เม่ือเปดหนา Geometry | Beam ตารางจุดตอและตารางคานจะ
แสดงขึ้นมา 

 

ตารางคานแสดงจุดตอ คุณสมบัต ิวัสดุ และความยาว ดังแสดงในรูปขางลาง 
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1.11 หนา General | Property 

ใชสรางและกําหนดคุณสมบัติตางๆใหกับองคอาคาร หนาจอ Properties ทางดานขวาจะใชในการ
สรางและกําหนดคุณสมบัติขององคอาคาร 

 
 

 

เม่ือคลิกท่ี Values… โปรแกรมจะแสดงตารางรายละเอียดของคุณสมบัติท่ีสรางขึ้นหรือ 

เลือกไว  พร อมหมายเลขอางอิง ดังแสดงในรูป 
 

 
 

 

เม่ือคลิกท่ี Section Database จะแสดงกล องโต ตอบตารางหนาตัดขึ้นมาใหเลือกโดยมีแถบเลือก
วัสดุสามชนิดคือ Steel, Timber, และ Aluminum ตัวอยางเชนตารางเหล็กมาตรฐานจะมีใหเลือก
ของหลายประเทศเชน อเมริกัน อังกฤษ ญี่ปุน สวนของไทยนั้นอาจใชตามเกาหลี 
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เม่ือคลิกท่ี Define… จะเปนการนิยามหน าตัดตามต องการเชน ส่ีเหล่ียม วงกลม รูปตัวที 

เปนต น และสามารถกําหนดคุณสมบัติวัสดุใหเปน คอนกรีต/เหล็ก/อลูมิเนียม หรือกําหนด 

ภายหลังก็ได  ดังในรูป 
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เม่ือคลิกท่ี Materials… โปรแกรมจะแสดงตารางรายละเอียดคุณสมบัติวัสดุ ท่ีมีอยู ในฐานข อมูล
โดยปกติจะมี 3 อย างคือ คอนกรีต เหล็ก และอลูมิเนียม 

 

เม่ือคลิกท่ี Thickness… จะเป นการกําหนดความหนาให แก เอลิเมนต แบบแผ น ดังแสดงในรูป
ขางลาง จะเห็นได ว าสามารถกําหนดความหนาของแผนท่ีแตกต างกันได ท่ีส่ีมุม 

ต องการกําหนดความหนาคงท่ี อาจจะกําหนดค าท่ี Node 1 เพียงจุดเดียวก็ได  

 
 

Assignment Method คือการกําหนดคุณสมบัติท่ีสรางขึ้นไวแลว ใหแกองคอาคารหรืออิลิเมนตทํา
ไดหลายวิธี ดังตอไปนี ้

• Assign to Selected Beams โดยเลือกคุณสมบัติท่ีตองการจากรายการท่ีเตรียมไวแลว แลวทํา
การเลือกองคอาคารหรืออิลิเมนตแลวคลิกเลือกปุม Assign 

• Assign To View  คือการกําหนดคุณสมบัติใหทุกองคอาคารในวิวท่ีแสดงอยู ทําโดยการคลิก
เลือกหนาตัดแลวคลิกปุม Assign 

• Use Cursor to Assign  เปนการใชเคอรเซอรท่ีเหมาะสมเลือกองคอาคารท่ีตองการโดยตรง
จากหนาจอ ทําไดโดยการเลือกหนาตัดท่ีตองการ กดปุม Assign แลวใชเคอรเซอรไปคลิกเลือกท่ี
องคอาคาร  
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1.12 หนา General | Spec 

เปนสวนท่ีใชกําหนดเง่ือนไขพิเศษใหแก จุดต อ (Node) องค อาคาร (Beam) หรือเอลิเมนต แบบแผ น 

(Plate) ซ่ึงจะมีคุณสมบัติพิเศษแตกต างจากเง่ือนไขปกติของโปรแกรม 

 

กลองโตตอบในรูปขางบนประกอบดวย 3 สวนคือ สวนแสดงรายการ สวนสรางหรือเลือกคุณสมบัต ิ
และสวนกําหนดคุณสมบัติใหแกองคอาคาร 

Highlight Assigned Geometry 

เม่ือชองนี้ถูกคลิกเลือก องคอาคารท่ีถูกกําหนดคุณสมบัติจะปรากฏเปนไฮไลทในโครงสราง 
ตัวอยางเชนถาคลิกเลือกรายการ MEMBER TRUSS องคอาคารท่ีเปนโครงถักท้ังหมดจะถูก
ไฮไลท 

Edit/Delete 

สองปุมนี้ยอมใหเราปรับปรุงคาท่ีกําหนดไวหรือลบคานั้น เชนถาเราตองการแกไขรายการ START 

MZ และเปล่ียนเปน START MY MZ ก็ใหคลิกเลือกรายการแลวคลิกปุม Edit กลองโตตอบดัง
ในรูปขางลางจะแสดงขึ้นมา 

ถาคุณอยากลบรายการ MEMBER TRUSS ใหคลิกเลือกรายการแลวคลิกปุม Delete 
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Toggle Specification 

เปนสวิตชไปยังโหมด toggle ซ่ึงในโหมดนี้ เม่ือเลือกรายการและใชวิธีกําหนด Use Cursor to 

Assign จะมีขั้นตอนดังนี ้

• คลิกท่ีองคอาคารหรืออิลิเมนทหนึ่งครั้ง – จะเปนการกําหนดคุณสมบัติ 
• คลิกท่ีองคอาคารหรืออิลิเมนทเดิมครั้งท่ีสอง – จะถอดการกําหนดคุณสมบัติ 
• คลิกท่ีองคอาคารหรืออิลิเมนทเดิมอีกครั้ง – คุณสมบัติจะถูกกําหนดกลับมาคืน 

ดังนั้นแตละครั้งท่ีคลิกจะหมายถึงการกําหนดถายังไมถูกกําหนด และจะถอดการกําหนดถาถูกกําหนด
ไวแลว 

 
ปุม Node… ใชตั้งขอกําหนดเกี่ยวกับจุดตอเชนการกําหนด master/slave เม่ือกดปุมหนาจอ Node 

Specs จะถูกแสดงขึ้นมาดังในรูปขางลาง 
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Master/Slave 

Master node หมายถึงจุดตอท่ีเปนท่ีอางอิงสําหรับการเคล่ือนตัวของจุดตอ Slave node อ่ืนๆ ให
คลิกเลือกจุดตอท่ีจะเปน Master จากรายการ 

Rigid หมายถึงลิงคท่ียึดระหวาง master และ slave มีคาสติฟเนสเปนอนันตในท้ังหกดีกรีอิสระ ถา
คลิกชองนี้ออกก็จะแสดงดีกรีตางๆขึ้นมาใหเลือก 

1.13 หนา General | Support 

ใชในการสรางและกําหนดจุดรองรับ กลองโตตอบในรูปขางลางประกอบดวย 3 สวนคือ สวนแสดง
รายการ สวนสรางหรือแกไขคุณสมบัต ิและสวนกําหนดคุณสมบัติใหแกองคอาคาร 

 

ในครั้งแรกท่ีเริ่มเปดหนานี้จะมีแตรายการ S1 No support เทานั้น ตองสรางจุดรองรับแบบอ่ืนๆ
ขึ้นมาเองตามท่ีตองการ 

 

คลิกปุมนี้เพ่ือสรางจุดรองรับตามตองการ โดยจะมีกลองโตตอบแสดงขึ้นมาดังในรูปขางลาง เม่ือใส
คาลักษณะตามตองการเสร็จใหคลิกปุม Add 

สวนการกําหนดคานั้นก็ทําแบบเดิม เหมือนการกําหนดคุณสมบัติใหจุดตอตามปกต ิ
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1.14 หนา General | Load 

ใชในการสรางและกําหนดน้ําหนักบรรทุก กลองโตตอบในรูปขางลางประกอบดวย 3 สวนคือ สวน
แสดงรายการ สวนสรางหรือแกไข และสวนกําหนดน้ําหนักใหแกองคอาคาร 
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น้ําหนักบรรทุกมีหลายประเภทไดแก น้ําหนักบรรทุกคงท่ี น้ําหนักจร แรงลม แผนดินไหว และอ่ืนๆ 
ใน STAAD.Pro นั้นผูใชสามารถสรางขึ้นไดเอง และมีมาตรฐานใหเลือกเชน UBC, IBC สําหรับ
แรงแผนดินไหว และ ASCE สําหรับแรงลม  

การสรางน้ําหนักบรรทุกจะเริ่มจาก Primary Load Case กอนโดยคลิกเลือกรายการ Load Cases 

Details แลวคลิกปุม Add… หนาจอดังในรูปขางลางจะปรากฏขึ้นมา 

 

เม่ือสราง Primary Load Case ครบทุกกรณีแลว ตอมาก็จะกําหนดน้ําหนักบรรทุกรวมกระทํา ทํา
โดยเลือก Load Cases Detail คลิกปุม Add… แลวเลือก Define Combinations ในรายการ
ทางดานซาย หนาจอจะเปนดังในรูปขางลาง 
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1.15 หนา General | Material 

ใชในการสรางและกําหนดวัสดุ กลองโตตอบในรูปขางลางประกอบดวย 3 สวน คือ สวนแสดง
รายการ สวนสรางหรือแกไข และสวนกําหนดใหแกองคอาคาร 

 

จะมีวัสดุท่ีโปรแกรมมีอยูแลวคือ STEEL, ALUMINUM และ CONCRETE มีคุณสมบัติดังใน
ตาราง 

 

ถาตองการสรางขึ้นเองใหกดปุม Create จะมีกลองขอความแสดงขึ้นมาใหกรอกขอมูล 

1.16 หนา Analysis/Print | Pre-Print 

ใชบอกโปรแกรมใหพิมพขอมูลตางๆท่ีเกี่ยวของกอนการวิเคราะหโครงสรางเชน ขอมูลโครงสราง จุด
รองรับ น้ําหนักบรรทุก และอ่ืนๆ 

ในรายการใดท่ีมีการกําหนดเรียบรอยแลวจะแสดงเปนเครื่องหมายถูก แตถาเปนเครื่องหมายคําถาม
แสดงวายังไมเรียบรอยใหผูใชแกไขกอนทําการวิเคราะห 
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1.17 หนา Analysis/Print | Analysis 

จะใชกําหนดขั้นตอนในการวิเคราะหเชน น้ําหนักบรรทุก การตรวจสอบเชิงสถิตยเปนตน 
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โดยท่ัวไปแล วจะสนใจเฉพาะแท็บ Perform Analysis ส วนตัวเลือกอ่ืน ได แก  Nonlinear 

Analysis, P-delta Analysis และ Change เป นตัวเลือกสําหรับการวิเคราะห ขั้นสูง เช น การวิ
เคราะหแบบไมเปนเชิงเสน ซ่ึงไมขอกลาวในท่ีนี ้

รายละเอียดตัวเลือก ในหัวข อ Perform Analysis สามารถสรุปได ดังต อไปนี ้
• No Print ไมแสดงข อมูลใด 

• Load Data แสดงข อมูลน้ําาหนักบรรทุก 

• Statics Check ตรวจสอบผลรวมของแรงภายนอก แรงปฏิกิริยาท่ีจุดรองรับ รวมท้ังโมเมนต 
ของแรงดังกลาวท่ีจุดกําเนิด 

• Statics Load เช นเดียวกับ Statics Check แต เพ่ิมการแสดงผลรวมของแรงภายนอกและ
แรงภายใน ท่ีแต ละจุดต อด วย 

• Mode Shapes แสดงค าดังกลาวท่ีจุดต อ 

• Both มีค าเทากับ Load Data รวมกับ Statics Check 

• All มีค าเทากับ Load Data รวมกับ Statics Load 

1.18 หนา Analysis/Print | Post-Print 
เปนขั้นตอนในการกําหนดขอมูลผลจากการคํานวณวิเคราะห ท่ีตองการใหแสดงในไฟลผลลัพธของ 

STAAD/Pro (นามสกุล .ANL) ซ่ึงเม่ือเขาสูหนายอย Analysis/Print > Post-print และเม่ือ
คลิกปุม Define Command… จะแสดงกลองโตตอบดังในรูปขางลาง 
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• Load List แสดงชุดน้ําหนักท่ีเลือก 

• Section กําหนดหน าตัดในช้ินสวนคานท่ีต องการใหแสดงค าโมเมนต และแรง 

• Joint Displacement แสดงค าการเสียรูป (เล่ือนท่ี, หมุน) ของจุดต อ 

• Member Forces แสดงแรงในช้ินสวน เชน แรงตามแนวแกน แรงเฉือน โมเมนต ในรูปแบบ
ตารางสําหรับทุกชุดน้ําหนัก 

• Support Reactions แสดงค าแรงปฏิกิริยาในรูปแบบตาราง 

• Force แสดงค าเอนเวลโลป (Envelopes) ของโมเมนต และแรงสําหรับช้ินสวนท่ี  ต องการ 

• Max Force แสดงค าแรงและโมเมนต ท่ีสูงสุดและต่ําสุด 

• Story Drift แสดงค าการเคล่ือนท่ีในแนวราบระหว างพ้ืนสองช้ัน ท้ังสองทิศทาง 

• Element Force แสดงค าแรงต างๆ ท่ีเกิดขึ้นในเอลิเมนต แบบแผน 

• Element Force Solid แสดงค าแรงต างๆ ท่ีเกิดขึ้นในเอลิเมนต แบบตัน 

• Mode Shapes แสดงค าการเสียรูปของจุดต อ สําหรับทุกโหมด (Mode) 

• Entire Table แสดงรายการตารางเหล็กท่ีเลือกใช 
• Section Displacement ทําการคํานวณและแสดงค าการเสียรูปของหน าตัดท่ีเลือกค าอยู ใน

ระบบพิกัดโกลบอล 

• Analysis Results มีค าเท ากับคําส่ัง Joint Displacements, Support Reactions และ 

Mode Shapes รวมกัน 

• Member Section Forces แสดงแรงในหน าตัด (ตามท่ีกําหนดไว โดยคําส่ัง Section) 
สําหรับช้ินสวนท่ีเลือก เชน แรงตามแนวแกน แรงเฉือน โมเมนต  ในรูปแบบตาราง 

• Member Stresses แสดงค าหน วยแรงท่ีจุดเริ่มและจุดปลายของช้ินส วน และทุกหน าตัดท่ี
กําหนดสําหรับช้ินสวนท่ีเลือก 
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1.19 หนาหลัก Design 

 

เปนขั้นตอนการกําหนดค าตัวแปร (Parameter) ต างๆ ท่ีจําเปนใหแก โปรแกรม 

เพ่ือนําไปใชในการออกแบบต อไป เม่ือเข าสู หน าหลัก Design จะประกอบดวย
หน าย อย Steel, Concrete, Timber, Aluminum, Footing ซ่ึงแต หน าย อย
จะมีข อกําหนด (Code) ท่ีแตกต างกันตามแต ชนิดวัสดุท่ีจะออกแบบ แต จะมี
ขั้นตอนการทํางานโดยรวมคล ายกันคือเม่ือคลิกท่ี Select Parameter… จะ   
เป นการเลือกตัวแปรท่ีจะกําหนดในการออกแบบ และเม่ือคลิกท่ี Design 

Parameter… จะเป นแก ไขค าตัวแปรท่ีได เ ลือกไว แล ว  แล วคลิกท่ี 

Command เพ่ือกําหนดคําส่ังท่ีใชในการออกแบบ ดังในรูปขางลาง 

 

 

 

เม่ือคลิกปุมนี้จะใหผูใชเลือกพารามิเตอรท่ีจะถูกรวมอยูในการคํานวณออกแบบ โดยคลิกเลือก
พารามิเตอรท่ีตองการจากรายการ 
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เม่ือคลิกปุมนี้จะใหผูใชกําหนดพารามิเตอรออกแบบ โดยจะมีกลองโตตอบแสดงขึ้นมา 

 
 

 

คลิกปุมนี้จะยอมใหผูใชกําหนดคําส่ังในการออกแบบ โดยเลือกจากกลองโตตอบดังในรูป 
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2 

 

การสรางโมเดล 
 

เนื้อหาในบทนี้ 
n ขั้นตอนการใชงาน STAAD.Pro 

n เริ่มตนโปรแกรม 

n สรางโมเดลโดยใช Structure Wizard 

n สรางโมเดลโดยใช Snap/Grid 

n สรางโมเดลโดยใช Copy/Cut และ Paste 

n สรางโมเดลจากขอมูลใน Spreadsheet (EXCEL) 

n สรางโมเดลจากไฟล นําเขา DXF (ACAD) 
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ขั้นตอนการใชงาน STAAD.Pro 
เพ่ือใหการใชงาน STAAD.Pro เปนไปอยางมีประสิทธิภาพ ในเบ้ืองตนเราตองเขาใจขั้นตอน
การใชงาน STTA.Pro กันกอน 

 

จากแผนภูมิขางบนจะเห็นวาเม่ือเปดไฟลใหมขึ้นมา ขั้นตอมาก็คือการสรางโมเดลซ่ึงเปนหัวขอ
สําคัญท่ีเราจะกลาวถึงในบทนี้ 

โมเดลคือตัวโครงสรางท่ีเราตองการจะทําการวิเคราะหมีองคประกอบเชน เสา, คาน, พ้ืน, ผนัง 
และอ่ืนๆ ซ่ึงในการท่ีเราจะสรางโมเดลขึ้นมาใน STAAD.Pro ตองมีขอมูลดังนี ้

• โครงสรางเปนแบบ 2 มิต ิหรือ 3 มิต ิ 

• ขนาดของแตละองคประกอบ 

• คุณสมบัติวัสดุโครงสรางท่ีใช, จุดตอ, จุดรองรับ 

• น้ําหนักบรรทุก 
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เริ่มตนโปรแกรม 
คานตอเนื่องรับน้ําหนักดังแสดงในรูปขางลาง 

จากหนาจอ STAAD.Pro เริ่มตน 

 

ระบบหนวย (ความยาว, แรง, อุณหภูมิ)ในโปรแกรมมีสองระบบหนวยคือ ระบบอังกฤษ(นิ้ว, 
ฟุต, ปอนด) และเมตริก(กิโลกรัม, เมตร) ซ่ึงจะมีผลตอคาท่ีแสดงในภาพกราฟก, ตาราง, และ
รายงาน รวมถึงคาคงท่ีตางๆท่ีจะใชในการคํานวณเชน โมดูลัสยืดหยุน, ความหนาแนน, และ
อ่ืนๆ ของวัสดุท่ีเลือกใชคือ เหล็ก, คอนกรีต, อลูมินั่ม 

ในระหวางการติดตั้งโปรแกรมจะใหผูใชเลือกหนวยท่ีจะใชเปนประจํา แตเราสามารถเปล่ียนได
โดยเลือกหัวขอ Configure ในชอง Project Tasks  
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ในตัวอยางนี้เราจะเลือกระบบ Metric 

 
 

คลิกปุม Accept เพ่ือปดกลองตัวเลือกขางบน 

จากนั้นเลือกเมนู File > New  หรือเลือก New Project จากกรอบ Project Tasks 
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เม่ือโปรแกรมถูกโหลดขึ้นมาจะแสดงหนาตาง New ดังในรูป แลวใสขอมูลดังนี ้
<  ชนิดโครงสราง : Space <  หนวยแรง : KiloNewton 

<  ช่ือไฟล : Structure1 <  เสร็จแลวคลิกปุม Next 

<  หนวยความยาว : Meter  

 

 
 

คลิกปุม Next 

ในหนาตางท่ีปรากฎตอมาใหเลือก Add Beam แลวคลิกปุม Finish 
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เม่ือโปรแกรมถูกโหลดเขามาจะแสดงแบบเสนกริดเริ่มตนในพ้ืนท่ีโมเดลหลักในรูปขางลาง ไอ
คอนแสดงทิศทางแกนพิกัดรวม(Global Axes: X, Y, Z) จะอยูท่ีมุมซายลางของจอ 
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วิธีสรางโมเดล 
ใน STAAD.Pro เรามีวิธีสรางโมเดลไดหลายวิธีให ผูใชเลือกตามความเหมาะสมของ
โครงสราง ความถนัดของผูใช เพ่ือใหการสรางโมเดลทําไดอยางสะดวกรวดเร็ว และมีโอกาส
ผิดพลาดนอยมาก ทางเลือกในการสรางโมเดลมีดังนี้คือ : 

• สรางแบบสําเร็จรูปโดยใช  Structure Wizard 

• สรางโมเดลโดยผูใชวาดเองใช  Snap/Grid 

• ใชการ Copy/Cut และ Paste 

• ใชขอมูลจากสเปรดชีตเชน Excel 

• นําเขาไฟล DXF จาก AutoCAD 

วิธีที่ 1 : สรางโมเดลโดยใช Structure Wizard 
Structure Wizard  เปนสวนท่ีจะชวยผูใชสรางโมเดลอยางรวดเร็ว โดยการใสขอมูลเพียง
เล็กนอย เริ่มโดยการเลือกจากเมนู  Geometry > Run Structure Wizard หนาตางท่ีแสดง
ขึ้นมาจะมีหนาตาดังในรูปขางลาง 
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เลือกชนิดของโมเดลท่ีตองการสรางจากชอง Model Type โดยมีใหเลือก 7 แบบคือ 

•  โมเดล Truss •  โมเดล Frame 

•  โมเดล Surface/Plate •  โมเดล Solid 

•  โมเดล Composite •  โมเดล CAD นําเขา 
•  โมเดล VBA-Macro  

ในหนาจอสวนลางจะมีโครงสรางในแตละแบบใหเลือก เชนในกรณีของโมเดล Frame มี
โครงสรางใหเลือกคือ 

•  Bay Frame •  Grid Frame 

•  Floor Grid •  Continuous Beam 

•  Cylindrical Frame •  Reverse Cylindrical Frame 

•  Circular Frame  

< Frame Models / Bay Frame 
Bay Frame เปนเฟรมสามมิติท่ีประกอบดวยเสาและคาน ดับเบิลคลิกไอคอน Bay Frame 

จะมีหนาตางใหกรอกขอความแสดงขึ้นมา 

 

กรอกคาขอมูลดังตอไปนี ้: 

• Length : ความยาวหรือขนาดในแนวแกน X 

• Height : ความสูงหรือขนาดในแนวแกน Y 

• Width : ความกวางหรือขนาดในแนวแกน Z 

• จํานวนชองตามความยาว 

• จํานวนช้ันตามความสูง 

• จํานวนชองตามความกวาง 



STAAD.Pro : Model Generation  2 - 9 
 

หมายเหตุ <  ตัวเลขท้ังหมดตองเปนบวก 

< ถาไมตองการขนาดในทิศทางไหนใหใสเปนศูนย โครงสรางจะกลายเปนสองมิติ 

< แตละชองจะถูกแบงเทากัน เชนยาว 12 เมตร จํานวน 3 ชอง แตละชองจะยาว 4 เมตร 

   n  ถาแตละชองยาวไมเทากัน ใหคลิกปุมท่ีมีสามจุด (ทางดานขวาของ Number of bays)  
         กําหนดระยะของแตละชอง อยาลืมวาผลรวมทุกชองจะตองเทากับความยาวท้ังหมด 
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เม่ือไดโมเดลท่ีตองการแลว เลือกเมน ูFile > Merge Model with STAAD.Pro Model 

หรือปดหนาตาง Structure Wizard โปรแกรมจะถามวาจะนําโมเดลท่ีสรางเขาสู 
STAAD.Pro โปรแกรมหลักหรือไม? 

 
< Frame Models / Grid Frame 

เปนเหมือน Bay Frame ท่ียกเวนหนึ่งแกน จะไดผังคานพ้ืนในแนวระนาบ X-Z ดังในรูป 

 

< Frame Models / Floor Grid 
เปนโครงสรางสองมิติในแนวระนาบ X-Z โดยดับเบิลคลิกไอคอน Floor Grid 
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< Frame Models / Continuous Beam 
เปนโครงสรางหนึ่งมิติในแนวแกน X โดยดับเบิลคลิกไอคอน Continuous Beam 

 

< Truss Models / All types 
จากรายการในชองชนิดโมเดลเลือก Truss Models จะมีโครงสรางตางๆใหเลือกดังนี ้

 

เม่ือคลิกเลือกไอคอนจะมีกลองโตตอบแสดงขึ้นมาใหกรอกขอมูลเหมือนกันคือ 

 

จากในรูปคาพารามิเตอรท่ีสามารถเปล่ียนแปลงไดคือ : 

• Length : ความยาวหรือขนาดในแนวแกน X 

• Height : ความสูงหรือขนาดในแนวแกน Y 

• Width : ความกวางหรือขนาดในแนวแกน Z สําหรับโครงถักสามมิติ ถาตองการสองมิติ
ใหใสคาเปนศูนย 
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• จํานวนชองตามความยาว 

• จํานวนช้ันตามความกวาง ใสคาเปนศูนยถาเปนโครงถักสองมิติ 

< จุดอางอิง 
ในหัวขอกอนหนานี้ไดกลาวถึงวิธีสรางโมเดลใน Structure Wizard และวางลงใน 
STAAD.Pro ในกรณีท่ียังไมมีโครงสรางอยู 

คราวนี้จะลองวางโมเดลจาก Structure Wizard ลงใน STAAD.Pro ท่ีมีโครงสรางเดิมอยู 
ใหทําตามขั้นตอนดังนี ้

• สรางโมเดลใน Structure Wizard 

• เลือก Edit/Add Paste Model ใน STAAD.Pro หรือคลิกปุม Transfer Model จาก
ทูลบาร 

• ยืนยันการสงผานโดยคลิก Yes กลองโตตอบจะแสดงขึ้นมา 

 
 

เราสามารถใสคาพิกัด XYZ ไดเลย โดยระยะจาก  2 nodes หรือ(วิธีนี้ดีกวา)คลิกปุม 
Reference Pt 

 
จะมีหนาจอแสดงขึ้นมาใหเรากําหนด node เพ่ือสรางโมเดล คลิกเลือก node แลวกด OK 
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รูปแบบของตัวช้ีจะเปล่ียนไปดังนี ้    

คลิกท่ี node ท่ีตองการในหนาตาง STAAD.Pro โปรแกรมจะกลับมาแสดงกลองโตตอบเดิม
พรอมดวยพิกัดท่ีกรองแลวของจุดท่ีตองการ ดังแสดงในรูปขางลาง 
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คลิก OK เพ่ือยอมรับผล STAAD.Pro จะแสดงขอความวา Duplicate nodes ignored 
หมายความวา nodes ท้ังสอง (หนึ่งจากโครงสรางเดิม และอีกหนึ่งจากโมเดลใหมท่ีสรางขึ้น)
นั้นทับซอนกันอยูท่ีพิกัดเดียวกัน ดังนั้น STAAD จึงยกเลิก node ท่ีมาจากโมเดลท่ีสรางใหม 
ใหคลิก OK 

 

ในทํานองเดียวกัน ในกรณีของ Beam ขอความจะแสดงวา Duplicate beams ignored 

แบบฝกหัด : การใช Structure Wizard สรางโครงถักโดยใชจุดอางอิง 
1. เปดไฟลใหมขึ้นมาโดยเลือกแบบ Space และ Add Beam 

2. เลือก Geometry / Run Structure Wizard 

3. เลือก Frame Models / Bay Frame ใสขอมูลดังในรูปขางลาง 

 

Length: 9 m แบงเปน 4 ชวง: 2 + 2.5 + 2.5 + 2 

Height: 12 m แบงเปน 3 ชวง: 4 + 4 + 4 

Width: 16 m แบงเปน 3 ชวง: 5 + 6 + 5 

4. เลือกเมนู Edit > Add/Paste Model in STAAD.Pro แลวกด Yes เพ่ือยืนยัน 

5. ใสคาพิกัดในการวางท่ี X = 0, Y = 0, Z = 0 คลิก OK 

6. เราอาจปดเสนกริดไดโดยคลิกปุม Close ปดหนาตาง Snap Node/Beam ทางดานซาย โดย
สามารถเปดกลับมาคืนได โดยเลือกเมนู Geometry > Snap Grid/Node > Beam 
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7. เลือกเมนู Geometry > Run Structure Wizard อีกครั้ง คราวนี้เลือก Truss Models / 

Howe Roof ใสคาพารามิเตอรดังในรูปขางลาง 

 

Length: 9 m แบงเปน 4 ชวง: 2 + 2.5 + 2.5 + 2 

Height: 3 m 

Width: 16 m แบงเปน 3 ชวง: 5 + 6 + 5 

จะไดโครงหลังคาดังแสดงในรปู ขั้นตอไปคือการนําไปวางบนอาคารหรือ Bay Frame ท่ีเรา
สรางและนําไปวางใน STAAD.Pro กอนหนานี้ 
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8. เลือกเมนู Edit > Add/Paste Model in STAAD.Pro แลวกด Yes เพ่ือยืนยัน 

9. คลิกปุม Reference Pt. คลิกเลือกจุดท่ีเปนจุดรวมของท้ังสองโมเดลและสังเกตไดงาย เชนใน
กรณีนี้เราเลือกจุดมุมซายลางดังในรูป แลวคลิก OK เพ่ือยอมรับ 

 

10. คลิกท่ีจุด node บนเฟรมท่ีมุมซายบน ยืนยันโดยคลิก OK 
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< Surface / Plate Models / Quad Plate 
ใชเพ่ือสรางแผนแบบสามจุดหรือส่ีจุด บนระนาบ XY, XZ และ YZ โดยเลือกจากรายการ
โมเดล Surface/Plate Models แลวดับเบิลคลิกไอคอน Quad Plate กรอกขอมูลดังนี้ 

 
ในกรอบ Element Type (ทางดานขวา) เลือก Quadrilateral แบบกําหนดส่ีจุดมุมคือ A, 

B, C และ D แกน XYZ ไมไดหมายถึงระบบแกน XYZ จริง แตเปนแกน XYZ ใน 
Structure Wizard การใช XYZ จะบอกโปรแกรมวาเราตองการสรางแผนในระนาบไหน 
เชนในรูปอยูในระนาบ XZ 

 

อีกตัวอยางหนึ่งลองกําหนด ABCD เปน: 

A  =  0, 0, 0 
B  =  0, 4, 0 
C  =  0, 4, 5 
D  =  0, 0, 5 
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ตอนใสคาพิกัดของสามหรือส่ีจุด ตองใสแบบวนตามเข็มนาฬิกา หรือทวนเข็มนาฬิกา 

STAAD.Pro จะคํานวณความยาวของแตละดานโดยอัตโนมัติ 

ในสวนของ Bias และ Division กําหนดจํานวนชองท่ีจะแบงในแตละดาน โดยคา Bias จะถูก
ตั้งไวท่ี 1 หมายความวาแผนจะถูกแบงเทาๆกัน 

คลิก Apply แลววางลงบนโครงสรางในหนาตาง STAAD.Pro โดยใชจุดอางอิง ตามใน
หัวขอกอนหนานี้ 

หมายเหตุ เม่ือเราวางแผนขนาด 1X1 m บนคาน 2 m คานจะถูกแบงเปนสวนละ 1 m โดยสราง node  
 ใหมท่ีกึ่งกลางคานดังแสดงในรูปขางลาง 
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แบบฝกหัด : การใช Structure Wizard สรางแผนพ้ืน 
1. ทํางานตอจากไฟลเดิม Bay Frame + Truss 

2. สรางแผนส่ีเหล่ียมตามขอมูล 

A  =  0, 0, 0  B  =  2, 0, 0 
C  =  2, 0, 5  D  =  0, 0, 5 
AB Division  =  2 BC Division  =  5 
CD Division  =  2 DA Division  =  5 Bias  =  1 

3. วางพ้ืนท่ีสรางลงในโครงสรางตามรูปขางลาง 
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วิธีที่ 2 : สรางโมเดลโดยใช Snap/Grid 
Snap/Grid เปนเครื่องมือสําหรับใหผูใชสรางโมเดลดวยตนเอง 

หนาตาง Snap/Grid จะเปดขึ้นมาเม่ือผูใชเริ่มสรางโมเดลใหมโดยอัตโนมัติ 

 
 

ถาเราเผลอปดไปหรือหาไมเจอ ก็สามารถเรียกขึ้นมาไดหลายวิธีดังนี ้

• คลิกเลือกแถบ Geometry จากแถบหนาควบคุมแนวดิ่งดานขาง 

• เลือกเมน ูGeometry > Snap/Grid Node > Beam 

• คลิกไอคอน Snap Node/Beam จาก Geometry ทูลบารดานบน 
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ในหนาตาง STAAD.Pro หลักจะแสดงเสนกริดในระนาบ XY ดังในรูปขางลาง 

 

n เลือกวาจะสรางโมเดลบนระนาบไหน XY, XZ, หรือ YZ 

n กําหนดมุมของระนาบ (ปลอยเปน 0 ไวกอน) 

n กําหนดจํากําเนิด (ปลอยไวท่ี 0,0,0) 

n กําหนดเสนรางโดยคํานึงถึงประเด็นตางๆดังนี ้

• ถาเราตองการใหจุดกําเนิดอยูท่ี 0,0,0 ชอง Left ของ X และ Y ตองมีคาเปน 0 

• ในชอง Right ของท้ัง X และ Y ใสจํานวนชองกริดท่ีตองการในแนวแกนนัน้ 

• ในชอง Spacing จะมีสองชองใหใสคา m และ Skew ในชอง m ใหใสความยาว
ของแตละชองกริด ตัวอยางเชนถาเราใสคาในชอง Right = 10 และ m = 1 ความ
ยาวท้ังหมดคือ 10X1 = 10 m 

n คลิกปุม Snap Node/Beam เปนการเปดใชงานเริ่มวาดโมเดล  

• กากบาทสีดําเขมจะปรากฎขึ้นตามตําแหนงท่ีเราช้ีตามจุดกริด 

• พิกัดของจุดจะแสดงขึ้นท่ีดานลางขวาของหนาจอ 
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• วงกลมซ่ึงจะปรากฏขึ้นท่ีมุมลางซายของกริดซ่ึงเปนจุดกําเนิด 

Adding Beam : วาดคาน  
n คลิกปุม Snap Node/Beam เปนการเปดใชงานเริ่มวาดโมเดล  

n คลิกท่ีเริ่มตนแลวคลิกท่ีจุดตอไปเรื่อยๆจนเสรจ็ คลิกถอนปุม Snap Node/Beam 

ขณะท่ีคลิกจะสังเกตเห็นจุดแดงกระพริบเรียกวา Hot Spot จะเปนจุดเริ่มตนขององคอาคารท่ี
กําลังถูกสรางไลเรียงตอกันไปเรื่อยๆดังในรูปขางลาง 

 
 

การเปลี่ยนจุด “Hot Spot” 

การท่ี Hot Spot ซ่ึงเปนจุดตั้งตนของการสรางองคอาคารใหมจะเปนจุดปลายขององคอาคาร
กอนหนา จะเหมาะสําหรับโครงสรางท่ียาวตอกันเชน คานตอเนื่อง แตในโครงสรางอ่ืนบางครั้ง
เราตองการจุดเริ่มตนใหมเพ่ือสรางองคอาคารใหม เราสามารถทําไดโดยการคลิกปุม Snap 

Node/Beam ขึ้น แลวคลิกปุมนี้ลงอีกครั้งเพ่ือเริ่มตนใหม หรือกดปุม Ctrl คางไว แลวเล่ือน 
Cursor ไปคลิกยังจุดเริ่มตนใหมท่ีตองการ 
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การแกไขขอผิดพลาด 

ในการสรางโมเดลเราลากเสนผิดได ใหคลิกปุม Snap Node/Beam ขึ้น เพ่ือหยุดการสราง
กอน แลวคลิกท่ีองคอาคารท่ีวาดผิด ซ่ึงจะถูกเนนเปนสีแดงดังในรูปขางลางใหกดปุม Delete 
เพ่ือลบออก 

 

หนาตางขอความจะปรากฏขึ้นมาใหยืนยันการลบ เม่ือคลิก OK โปรแกรมจะถามวาจะลบ 
Node จะตออยูดวยหรือไม 

 

ถามี Node เหลืออยูอาจใช Node Cursor  คลิกเลือกเพ่ือลบทีละจุด หรือถามีหลายจุดอาจ
เลือกเมนู Tools > Orphan Nodes > Remove 

การแสดงระยะระหวาง Nodes 

คลิกไอคอน  หรือเลือกเมน ู Tools > Display Node to Node Distance เคอรเซอรจะ
เปล่ียนรูปเปนแบบไอคอนใหคลิกท่ี Node ท้ังสองท่ีตองการรูระยะ 
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การใชสเปรดชีตในการสรางและแกไขโมเดล 

เราสามารถสรางและแกไขโมเดลไดโดยตรงในหนาตาง Nodes และ Beams ซ่ึงมีลักษณะเปน
ตารางสเปรดชีตในหนา Geometry หรือเลือกเมนู Geometry > Nodes 

 

การใชเครื่องมือ Add Beam from Point to Point 

เลือกเมน ูGeometry > Add Beam จะมีเมนูยอยใหเลือกคือ 

 

Add Beam from Point to Point เพ่ิมคานใหมระหวางจุด เคอรเซอรจะเปล่ียนเปน  ใน 
STAAD.Pro เวอช่ันเกา การเพ่ิมคานตองเลือกจุดเริ่มตนและปลายท่ีเปน Nodes ท่ีมีอยูแลว แต
ในเวอช่ันใหมนี้เราสามารถสราง Nodes ปลายคานใหมได 
 

 
 

คลิกท่ีจุดใดๆบนคานท่ีมีอยูเดิมซ่ึงตองการใหเปนจุดเริ่มตนของคานใหม ถาตําแหนงนั้นยังไมมี 
Node จะปรากฏกลองขอความขึ้นมาถามวาจะสราง Node ใหมหรือไม 
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Adding Plates : วาดแผนพื้น  
n เลือกเมน ูGeometry > Snap/Grid Node > Plate > Quad 

n คลิกเลือกระนาบ X-Z ในการวาด 

n คลิกปุม Snap Node/Plate เปนการเปดใชงานเริ่มวาดโมเดล  

n คลิกจุดเริ่มตน และคลิกตอไปจนครบส่ีจดุ แลวคอยถอนปุม Snap Node/Plate 

 
เม่ือสรางแผนแรกเสร็จจุดกากบาทดําจะใหเราสรางแผนถัดไปตอจากแผนแรก ถาไมตองการ
สรางตอกันใหกด Ctrl คางไว แลวท่ีจุดเริ่มตนใหม 

Fill Plates : ระบายสแีผนพื้น  
n เพ่ือใหมองเห็นแผนพ้ืนชัดเจนขึ้น ใหคลิกขวาในพ้ืนท่ีหนาจอ เลือก  Structure 

Diagrams จากรายการท่ีแสดงขึ้นมา 
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ในกรอบ View คลิกเลือก Fill Plate/Solids/Surface แลวคลิก OK 
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แบบฝกหัด : สรางโมเดลโดยใช Snap/Grid 
1. เริ่มไฟลใหมแบบ Space Frame 

2. เลือกแถบ Geometry จาก Page Control 

3. คลิกเลือกระนาบ X-Y ในการทํางาน 

4. ในสวนของเสนราง ใสขอมูลดังนี ้: 
For X, Left = 0, Right = 3, m = 4 
For Y, Left = 0, Right = 2, m = 3 

5. คลิกเปด Snap Node/Beam 

6. คลิกตามพิกัดดังนี ้(ใชแถบแสดงพิกัดชวย) 
0, 0, 0 
0, 3, 0 
12, 3, 0 
12, 0, 0 

กดปุม Ctrl คางไวแลวคลิกท่ี  4, 3, 0 

4, 0, 0 

กดปุม Ctrl คางไวแลวคลิกท่ี  8, 3, 0 

8, 0, 0 

7. ตอนนี้โมเดลของเราควรจะมีลักษณะดังในรูปขางลางนี ้: 
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8. เปล่ียนระนาบทํางานเปน X-Z 

9. เปล่ียนจุด Origin เปน 0, 3, 0 เสนกริดจะลอยขึ้นมาอยูดานบนของโครง 

10. ในสวนของเสนราง ปลอยใหคาแกน X เหมือนเดิม เปล่ียนคาแกน Z เปน Left = 0, 
Right = 1, m = 4 

11. คลิกตามพิกัดดังนี ้(ใชแถบแสดงพิกัดชวย) 
0, 3, 0 
0, 3, 4 
12, 3, 4 
12, 3, 0 
Ctrl + 4, 3, 0 
4, 3, 4 
Ctrl + 8, 3, 0 
8, 3, 4 

12. โมเดลจะมีลักษณะดังในรูปขางลางนี ้: 
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13. ลองสรางโมเดลเพ่ิมเติมใหไดดังในรูปขางลางโดยใชวิธีเดิม : 

 

14. ปด Snap Node/Beam 

15. ใช Geometry ทูลบาร คลิก Snap Grid/Node > Plate > Quad เพ่ือวาดแผนพ้ืน 

16. เปล่ียนระนาบเปน X-Z 

17. เปล่ียน Origin เปน 0, 3, 0 

18. ในสวนของเสนราง Construction Lines : 

For X, Left = 0, Right = 3, m = 4 
For Z, Left = 0, Right = 1, m = 4 

19. คลิกตามพิกัดดังนี ้(ใชแถบแสดงพิกัดชวย) (คลิกวนตามเข็มนาฬิกาหรือตามเข็ม) 
4, 3, 0 
0, 3, 0 
0, 3, 4 
4, 3, 4 
8, 3, 4 
8, 3, 0 
4, 3, 0 
Ctrl + 8, 3, 0 
8, 3, 4 
12, 3, 4 
12, 3, 0 
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20. เลือกเมน ูView > Structure Diagram… คลิก Fill Plates/Solids/Surface 

โมเดลจะมีลักษณะดังในรูปขางลางนี ้: 

 
 
* คลิก node วนตามเข็มกับทวนเข็มจะไดแผนพ้ืนคนละสีกัน 
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กอนท่ีเราจะเรียนรูวิธีตอไป จะตองกลาวถึงฟงกช่ันท่ีสําคัญคือ การเปล่ียนมุมมอง (Viewing) 
และการเลือก Nodes, Beams, และ Plates 

การเปล่ียนมุมมอง : Viewing 
การเปล่ียนมุมมองของโมเดลสามารถทําไดโดยสะดวกโดยคลิกจากทูลบาร Viewing 

 

 
มุมมองจากแกน +Z เปนมุมมองดานหนา 

 
มุมมองจากแกน –Z เปนมุมมองดานหลัง 

 มุมมองจากแกน –X เปนมุมมองดานซาย 

 
มุมมองจากแกน +X เปนมุมมองดานขวา 

 
มุมมองจากแกน +Y เปนมุมมองดานบน 

 มุมมองจากแกน -Y เปนมุมมองดานลาง 

 
มุมมองไอโซเมตริก (Isometric) แบบสามมิติท่ีเราใชมาตั้งแตแรก 

นอกจากนั้นยังสามารถหมุนไดอีก 6 แบบ ไดแก : 

 
หมุนขึ้น & หมุนลง รอบแกน X  

 
หมุนซาย & หมุนขวา รอบแกน Y  

 
หมุนซาย & หมุนขวา รอบแกน Z  

 
กําหนดจุดหมุน 

*เราสามารถใชปุมลูกศรในการหมุนโมเดลเชนกัน 

- ลูกศร ขวา และ ซาย หมุนรอบแกน Y 

- ลูกศร ขึ้น และ ลง หมุนรอบแกน X 
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การเลือก Node, Beam และ Plate 
เราตองเลือก node, beam หรือ plate กอน จึงจะใชคําส่ังกับองคอาคารนั้นๆได 

ขั้นตอนแรกในการเลือกใน STAAD.Pro คือการใชเคอรเซอรท่ีถูกตอง 

 Node Cursor ใชเลือก node 

 Beam Cursor ใชเลือก beam 

 Plate Cursor ใชเลือก plate 

หลังจากเลือกเคอรเซอรแลว เรามีวิธีเลือกองคอาคารท้ังหมดส่ีวิธีไดแก : 
Single Selection  

คลิกท่ี node, beam หรือ plate ท่ีตองการ องคอาคารท่ีถูกเลือกจะถูกไฮไลทเปนสีแดงดังใน
รูปขางลาง 

  
ในพ้ืนท่ีขอมูล คลิกท่ีหมายเลข node, beam หรือ plate ท่ีตองการ 
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Multiple Selection  
ถาตองการเลือกมากกวาหนึ่ง ใหคลิกเลือกองคอาคารแรก กด Ctrl คางไวแลวคลิกเลือกองค
อาคารตอไป 

 
 
จากพ้ืนท่ีขอมูลคลิกท่ีหมายเลของคอาคารท่ีตองการ โดยใชการกด Ctrl คางเหมือนเดิม 
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ตีกรอบลอมรอบองคอาคารท่ีตองการ 

  
 
สําหรับคาน กึ่งกลางคานเปนจุดสําคัญท่ีตองตีกรอบลอมถาตองการเลือก 
 

 
 
Ctrl + A : เพ่ือเลือกองคอาคารท้ังหมด node, beam หรือ plate ตามชนิดเคอรเซอร 
 
Unselect : ถาเปล่ียนใจไมตองการเลือก ใหคลิกในพ้ืนท่ีวาง 
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การเลือกในมุมมองสามมิต ิ
ใชการเปล่ียนมุมมองมาชวยในการเลือกองคอาคารหลายองคอาคารพรอมกัน การใชมุมมอง
สามมิติตางๆจะชวยใหเราเลือกองคอาคารซ่ึงถามองในระนาบจะซอนบังกันอยู 

ลองใช Structure Wizard สรางโครงอาคารสามมิติดังในรูปขางลาง 

 
 
คลิกไอคอน View From +Z เปล่ียนมุมมองเปนดังในรูปขางลาง 
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คลิกท่ีคานตัวหนึ่งดังในรูป : 

 

คลิกเปล่ียนเปนมุมมอง Isometric จะพบวา : 

 
 

*เพ่ือใหการเลือกองคอาคารสามมิติทําไดรวดเร็วขึ้น ควรใชการตีกรอบเลือกจากในมุมมองสอง
มิติในทิศทางตางๆกันประกอบ 
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 แบบฝกหัด : การเปล่ียนมุมมอง & การเลือกองคอาคาร 
1. เริ่มสรางโมเดลใหมแบบ Space Frame 

2. ใช Structure Wizard สรางโมเดลโครงอาคารสามมิติดังนี ้
Length = 12 m, # of Bays = 4 
Height = 15 m, # of Bays = 5 
Length = 12 m, # of Bays = 4 

3. เปล่ียนมาใช Node เคอรเซอร 

4. ใชมุมมอง View From +Z แลวใชการตีกรอบเลือกโหนดบนสุด 

5. เปล่ียนมุมมองเปนสามมิต ิIsometric ดูผลการเลือก 

6. คลิกท่ีพ้ืนท่ีวางเพ่ือยกเลิกการเลือก 

7. เปล่ียนเปน Beam เคอรเซอร 

8. เปล่ียนมุมมองเปน View From +Y แลวใชเคอรเซอรและปุม Ctrl เลือกคานใน
แนวราบท้ังหมด 

9. เปล่ียนมุมมองเปนสามมิต ิIsometric ดูผลการเลือก 

10. คลิกท่ีพ้ืนท่ีวางเพ่ือยกเลิกการเลือก 

11. กด Ctrl + A 

12. เปล่ียนมาใช Node เคอรเซอร แลวกด Ctrl + A เปรียบเทียบดูความแตกตาง 
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วิธีที่ 3 : การสรางโมเดลโดยใช Copy/Cut และ Paste 
วิธีสรางโมเดลท่ีไดกลาวถึงมาแลวสองวิธีเปนการสรางโมเดลขึ้นมาใหม ในกรณีท่ีโมเดลมี
ลักษณะซํ้าๆกัน เราสามารถทําการกอปปแลวมาปะเพ่ิมได แนนอนวาเม่ือเรากอปปคานหรือ
แผนพ้ืน STAAD.Pro จะกอปปโหนดมาดวย 

ขั้นตอน : เลือกวัตถุท่ีตองการกอปป (โหนด, คาน หรือ พ้ืน) โดยใชเคอรเซอรท่ีถูกตอง 

เลือกเมน ูEdit > Copy หรือกด Ctrl + C (ถาตองการยายท่ีหรือลบของเดิมใหเลือก Edit > 

Cut หรือ Ctrl + X) 

เลือกเมนู Edit > Paste หรือกด Ctrl + V จะปรากฏกลองโตตอบขึ้นมาใหเรากําหนด
ตําแหนงการวางซ่ึงทําไดหลายวิธี 

 

 
 
กลองโตตอบนี้จะเหมือนกับท่ีเราเคยใชตอนนําเขาโมเดลจาก Structure Wizard นั่นเอง 
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แบบฝกหัด : สรางโมเดลโดยใช Copy/Cut และ Paste 
1. เริ่มสรางโมเดลใหมแบบ Space Frame 

2. ใช Structure Wizard สรางโมเดลโครงอาคารสามมิติดังนี ้
Length = 6 m, # of Bays = 1 
Height = 3 m, # of Bays = 1 
Length = 4 m, # of Bays = 1 

3. กด Ctrl + A เพ่ือเลือกคานท้ังหมด 

4. เลือก Edit > Copy หรือกด Ctrl + C เพ่ือกอปปคาน 

5. เลือก Edit > Paste Beams หรือกด Ctrl + V เพ่ือวางคาน 

6. ใสคาพิกัดในการวางดังนี ้X=0, Y=3, Z=0 หรืออาจลองใชจุดอางอิงดูก็ได 

7. โมเดลท่ีไดจะมีลักษณะดังในรูปขางลาง 
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วิธีที่ 4 : การสรางโมเดลโดยใช Spreadsheet (EXCEL) 
การสรางโมเดลโดยวิธีนี้เหมาะสําหรับผูใชท่ีมีความชํานาญในการใช Excel โดยมักจะใชสูตร
คํานวณพิกัดแลวก็อปปขอมูลโดยใช OLE มายัง STAAD.Pro เพ่ือสรางโมเดล 

ขัน้ตอน : เริ่มโปรแกรม Excel (หรือซอฟทแวร spreadsheet อ่ืน) 

สรางขอมูลโดยอาจใชสูตรคํานวณพิกัด X, Y, Z (โดยเฉพาะเม่ือโครงสรางเปนเสนโคง) 

เลือกคอลัมนท่ีมีคา X, Y, Z (เลือกเฉพาะคาตัวเลข) 

จากเมนู Excel เลือก Edit > Copy 

เขาโปรแกรม STAAD.Pro 

ไปยังหนา Geometry ในตาราง Nodes เลือกโหนดหมายเลขหนึ่งดังในรูป 
 

 
 
เลือกเมน ูEdit > Paste หรือคลิกขวาแลวเลือก Paste กลองโตตอบจะแสดงขึ้นมา 
 

 
 
คลิกปุม Change Mapping เพ่ือเลือกคอลัมนแรกเปน X, คอลัมนท่ีสองเปน Y และคอลัมนท่ี
สามเปน Z แลวคลิก OK โหนดใหมจะถูกสรางขึ้นมา 
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Add Beams จากขั้นตอนท่ีกลาวมา เราพ่ึงสรางโหนดเทานั้น ตองใช Add Beams เพ่ือ 

 สรางคานเช่ือมระหวางโหนด 
 

 

จากทูลบาร Geometry เลือก Add Beam หรือเลือกเมนู Geometry >  
 Add Beam > Add Beam from Point to Point 
  

 ลักษณะของตัวช้ีเมาทจะเปล่ียนไปดังรูป คลิกท่ีโหนดแรกแลวลากไปท่ี 

 โหนดท่ีสอง ทําตอไปจนครบท้ังหมด 

Note เราสามารถใช Add Beams ชวยในการสรางองคอาคารยึดโยงในโครง 

Add 3-Noded Plates ใชสําหรับเช่ือมตอโหนดดวยแผนพ้ืนสามเหล่ียม 

จากทูลบาร Geometry เลือก Add 3-Noded Plates หรือเลือกเมนู  
 Geometry > Add Plate > Triangle 

ลักษณะของตัวช้ีเมาทจะเปล่ียนไปดังรูป คลิกท่ีโหนดแรกแลวลากไปท่ี 
 โหนดท่ีสอง และโหนดท่ีสาม จะไดแผนสามเหล่ียม 

Add 4-Noded Plates ใชสําหรับเช่ือมตอโหนดดวยแผนพ้ืนส่ีเหล่ียม 

จากทูลบาร Geometry เลือก Add 4-Noded Plates หรือเลือกเมนู 
 Geometry > Add Plate > Quad 

ลักษณะของตัวช้ีเมาทจะเปล่ียนไปดังรูป คลิกท่ีโหนดแรกแลวลากไปท่ี 
 โหนดท่ีสอง โหนดท่ีสาม และโหนดท่ีส่ี จะไดแผนส่ีเหล่ียม 

การใช Labels ในหนาตาง STAAD.Pro คลิกขวา จะมีรายการเมนูแสดงขึ้นมา เลือก  
 Labels จากรายการ จะมีกลองโตตอบแสดงขึ้นมาใหเปด Node Numbers 

 Node Points, Beam Numbers และ Plate Numbers 
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แบบฝกหัด : สรางโมเดลโดยใช Excel Copy & Paste 
1. เริ่ม Excel สรางชีตใหม กรอกขอมูลดังนี้ : 

X Y Z 
0.00 25.00 0.00 
0.50 24.75 0.00 
1.00 24.00 0.00 
1.50 22.75 0.00 
2.00 21.00 0.00 
2.50 18.75 0.00 
3.00 16.00 0.00 
3.50 12.75 0.00 
4.00 9.00 0.00 
4.50 4.75 0.00 
5.00 0.00 0.00 

*สูตรสําหรับคา Y คือ 25-X2 เม่ือ X  

2. เริ่ม STAAD Pro สรางไฟล Space ใหม 

3. กอปปตารางท่ีสรางขึ้นใน Excel มาใสตารางโหนดของ STAAD Pro 

4. กําหนดใหคอลัมนแรกเปน X, คอลัมนสองเปน Y และคอลัมนสามเปน Z 

5. จากกลองโตตอบ Labels เปด Node Points 

6. ใช Add Beams ใสคานเพ่ิม โมเดลจะเปนดังรูป 
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วิธีที่ 5 : การสรางโมเดลโดยนําเขาไฟล DXF 
การสรางโมเดลโดยวิธีนี้เหมาะสําหรับผูใชท่ีมีความชํานาญในการใช AutoCAD เพ่ือสราง
โมเดลสองมิติ หรือสามมิต ิ

ขั้นตอน : n เริ่มโปรแกรม AutoCAD (หรือซอฟทแวร CAD อ่ืนท่ีสรางไฟล DXF ได) 

n วาดโครงสรางสองมิติ หรือสามมิต ิ

n Save As เปนไฟลแบบ DXF 

n เริ่มโปรแกรม STAAD Pro 

n ในการอานไฟล DXF เรามีสองวิธี : 

- โดยใช Structure Wizard 

- โดยใช File/Import 

Structure Wizard 
n เริ่มตนเลือกเมน ูGeometry > Run Structure Wizard 

n จากชอง Model Type เลือก Import CAD Models 

 

n ดับเบิลคลิกไอคอน Scan DXF  

n เลือกไฟล DXF ท่ีตองการ แลวคลิก Open 

File/Import 
n เลือกเมนู File > Import… 

n โปรแกรมจะถามชนิดของไฟลท่ีจะนําเขา 

 

n คลิกเลือก 3D DXF แลวกด Import 

n เลือกไฟล DXF ท่ีตองการ แลวคลิก Open 



STAAD.Pro : Model Generation  2 - 44 
 

 

n เลือกวิธีการนําเขาหนึ่งในสามทางเลือกคือ : 

• No Change; แกน XYZ ของ STAAD จะตรงกับ XYZ ใน AutoCAD 

• Y Up; กําหนดให STAAD ใชแกน Y ช้ีขึ้น แลวปรับเปล่ียนแกน Y ใน AutoCAD 
ตาม (นี่คือทางเลือกท่ีควรเลือกในเกือบทุกกรณี) 

• Z Up; กําหนดให STAAD ใชแกน Z ช้ีขึ้น แลวปรับเปล่ียนแกน Z ใน AutoCAD 
ตาม 

n กลองโตตอบเพ่ือใหเลือกหนวยจะแสดงขึ้นมา ใหเลือกหนวยความยาวและหนวยแรงท่ี 

 ตองการแลวคลิก OK โครงสรางจะถูกถายโอนเขามา 

หมายเหตุ n ใน AutoCAD ใชคําส่ัง Line ในการเขียนแบบคานและเสา 

n STAAD จะคิดให Line หนึ่งเสน เทากับ หนึ่งคาน หรือ หนึ่งเสา ดังนั้นเสนตรงท่ียาวคลุม 

     หลายชวงคานจะถูกคิดวาเปนหนึ่งวัตถุ จึงควรตดัเสนตรงเปนชวงๆท่ีโหนดทุกโหนด 

n ใช AutoCAD เวอรช่ันลาสุดกับ STAAD เวอรช่ันลาสุด 
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3 

 

ฟงกช่ันชวยสรางโมเดล 
 

ฟงกช่ันที่จะกลาวถึงในบทนี้ 
n Translation Repeat 

n Circular Repeat 

n Mirror 

n Rotate 

n Move 

n Insert Node 

n Adding Beams (Connecting & Intersecting) 

n Cut Section 

n Renumber 

n Miscellaneous Functions 
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บทนํา 
< วิธีการท้ังหาท่ีไดกลาวถึงในบทท่ีสองจะใชในการสรางโมเดลพ้ืนฐาน แตอาจยังไมสามารถ

ใชสรางโมเดลท่ีซับซอนบางโครงสรางได 

< ในบทนี้ เราจะเรียนรูฟงกช่ันท่ีจําเปนซ่ึงจะชวยในการสรางโมเดลในรูปแบบตางๆท่ี
หลากหลายมากขึ้น 

< ผูใชควรเลือกองคอาคารกอนท่ีจะเริ่มส่ังฟงกช่ัน 

< เม่ือเราเรียนรูครบท้ังบทท่ีสองและสาม เราจะสามารถสรางโมเดลโดยใชฟงกช่ันท้ังหมดท่ี
มีอยูใน STAAD Pro 

Translational Repeat 
< เปนการก็อปปและวางวัตถุตามแนวเชิงเสน 

< เลือกโหนด, คาน หรือ แผน ท่ีตองการทําซํ้า 

 < จากทูลบาร Generate เลือก Translational Repeat 

< หรือเลือกเมน ูGeometry > Translational Repeat… 

 

Global Direction : เลือกทิศทางท่ีจะทําซํ้าตามแนว X, Y, Z 

No of Steps : จํานวนครั้งของการทําซํ้า 

Default Step Spacing : ระยะหางระหวางการทําซํ้า ซ่ึงเราสามารถเปล่ียนของแตละชวงได
อีกภายหลัง 

Renumber Bay : เม่ือคลิกเลือกจะใหผูใชกําหนดหมายเลขคานเริ่มตนใหมสําหรับแตละ
โครงท่ีถูกเพ่ิมเขาไป 
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Link Steps : จะสรางองคอาคารเช่ือมระหวางโครงท่ีถูกทําซํ้า และถาเลือก Open Base ท่ี
ฐานจะไมถูกสรางองคอาคารเช่ือม 

Generation Flags : เราสามารถเลือกไดวาจะทําซํ้าอะไรบาง โดยปกติจะถูกเลือกไวท่ี All ก็
จะทําซํ้าท้ังหมดคือองคอาคาร น้ําหนักบรรทุก คุณสมบัติ และอ่ืนๆ แตถาตองการทําซํ้าเฉพาะ
องคอาคารใหคลิกเลือก Geometry Only 

ลองสรางโครงดังในรูปขางลาง คลิกขวาในพ้ืนท่ีวาง เลือก Labels… คลิกใหแสดง Beam 
Numers 
 

 
 

เลือกคานท้ังหมด โดยกด Ctrl + A แลวคลิกไอคอน Translational Repeat ใสขอมูลดังใน
รูปขางลาง 
 

 
 
เม่ือคลิก OK โมเดลจะถูกสรางขึ้นดังในรูปขางลาง 



STAAD.Pro : Useful Functions to Complete the Geometry  3 - 4 
 

 
แบบฝกหัด : สรางโมเดลอาคารสูงโดยใช Translational Repeat 

< เริ่มตนโปรแกรมใหมแบบ Space ช่ือไฟล tallbld หนวยความยาวเปน Meter 

< เลือก Add Beam คลิกปุม Finish 

< คลิกเลือกระนาบ X-Y และเปล่ียนมุมมองเปน View From +Z 

< สรางโมเดลดังในรูปขางลาง 

 

< เลือกโมเดลท้ังหมด กด Ctrl + A 

< ทํา Translation Repeat โดยคลิกไอคอน  หรือเลือกจากเมนู Geometry > 
Translational Repeat… 

< เม่ือหนาตางแสดงขึ้นมา ใหใสคาตามในรูปขางลาง 
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< คลิก OK แลวเปล่ียนมุมมองเปนสามมิติจะได 
 

 
 

< คลิกไอคอน Add 4-Noded Plates  จากทูลบารดานบน 

 

  
 

< คลิกท่ีจุดตอในโครงสรางเพ่ือสรางผนังดังในรูปขางลาง 
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< คลิกตอเพ่ือสรางแผนพ้ืนโดยเวนชองกลางเอาไวดังในรูปขางลาง ซ่ึงอาจทําโดยสรางแผน

พ้ืนขึ้นมากอนหนึ่งแผนแลว Copy & Paste โดยใชจุดอางอิง 

 
< คลิกเลือกคานและพ้ืนท้ังหมด โดยใชเคอรเซอรคาน กด Ctrl + A เปล่ียนเปนเคอรเซอร

แผน กด Ctrl + A 

< ส่ัง Translational Repeat โดยใสขอมูลดังนี้ 
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คลิก OK แลวเปล่ียนมุมมองเปนสามมิต ิจะไดโมเดลอาคารสูงดังในรูปขางลาง 
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Circular Repeat 
< เปนการก็อปปและวางวัตถุตามโคงตามแนวรัศมีวงกลม 

< เลือกโหนด, คาน หรือ แผน ท่ีตองการทําซํ้า 

 < จากทูลบาร Generate เลือกไอคอน Circular Repeat 

< หรือเลือกเมน ูGeometry > Circular Repeat… 

 

< เลือกแกนหมุนในกรอบ Axis of Rotation วาจะเปนแกน X, Y, หรือ Z 

< เลือกมุมท่ีตองการหมุนในชอง Total Angle (+ve=CCW)  

< กําหนดจํานวนท่ีตองการจะทําซํ้าเพ่ิมในชอง No of Steps 

< กําหนดตําแหนงของแกนหมุน ซ่ึงก็คือจุดท่ีแกนหมุนผาน ในกรอบ Trough จะมีวิธีให
เลือกสามวิธี : 

• คลิกท่ีไอคอน  แลวกําหนดจุดบนจอภาพ 

• กําหนดหมายเลขโหนด 

• กําหนดพิกัด 

< Use this as Reference Point for Beta angle generation 

เม่ือคลิกเลือกชองนี้ หนาตัดขององคอาคารท่ีถูกทําซํ้าเพ่ิมจะถูกหมุนตามไปดวยตามรูป
ขางลาง 

< กําหนด Link Steps และ Open Base เหมือนใน Translation Repeat 
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หนาตัดไมหมุนตาม หนาตัดหมุนตาม 

Mirror 
< เปนการทําซํ้าแบบกระจกเงา โดยเริ่มดวยการเลือกวัตถุท่ีตองการ 

< จากทูลบารเลือกไอคอน  หรือเลือกเมนู Geometry > Mirror… 

 

< เลือกระนาบในกรอบ Mirror Plane วาจะเปนระนาบ X-Y, X-Z, หรือ Y-Z 

< กําหนดตําแหนงของระนาบ Plane Position จะมีวิธีใหเลือกสามวิธี : 
• คลิกท่ีไอคอน  แลวกําหนดจุดบนจอภาพ 

• กําหนดหมายเลขโหนด 

• กําหนดพิกัดบนแกน X (สําหรับระนาบ Y-Z) 

< กําหนดวิธีการสราง Generate Mode จะมีวิธีใหเลือกสองวิธี : 
• Copy จะสรางรูปใหมแบบกระจกโดยท่ียังคงของเดิมไว 
• Move จะสรางรูปใหมแบบกระจกโดยลบของเดิมท้ิง 
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Rotate 
< เปนการหมุนองคอาคารรอบแกนท่ีกําหนด โดยเริ่มดวยการเลือกวัตถุท่ีตองการ 

< จากทูลบารเลือกไอคอน  หรือเลือกเมนู Geometry > Rotate… 
 

 
 

< เลือกมุมหมุน Angle มีหนวยเปนดีกรี 

< กําหนดจุดท่ีแกนผาน Axis Passes Through จะมีวิธีใหเลือกสามวิธี : 

• คลิกท่ีไอคอน  แลวกําหนดจุดสองจุดบนจอภาพ 

• กําหนดหมายเลขโหนด 

• กําหนดเปนพิกัด X, Y, Z 

< กําหนดวิธีการสราง Generate Mode จะมีวิธีใหเลือกสองวิธี : 

• Copy จะสรางรูปใหมจากการหมุนโดยท่ียังคงของเดิมไว เลือกวาจะ Link Bays 
หรือไม 

• Move จะสรางรูปใหมจากการหมุนโดยลบของเดิมท้ิง 

< มุมหมุนเปนบวกจะหมุนทวนเข็มนาฬิกา ( +ve = CCW ) 
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แบบฝกหัด : สรางโมเดลสเตเดียมโดยใช Circular Repeat 
< เริ่มตนโปรแกรมใหมแบบ Space ช่ือไฟล stadium หนวยความยาวเปน Meter 

< คลิกเลือกระนาบ X-Y และเปล่ียนมุมมองเปน View From +Z 

< สรางโมเดลดังในรูปขางลาง 

 

โมเดลท่ีเราพ่ึงสรางขึ้นมาอยูบนระนาบ X-Y มีความยาวในแนวแกน X = 10 ม. จากจุด X = 0 

ถึง X = 10 ม. เราตองการ copy เฟรมท่ีสรางขึ้นมานี้ท้ังแบบ translation และ circular ซ่ึง
จะมีแนวทางดังในรูปขางลางเม่ือมองจากแกน Y ลงมา 

 
 

z 
 

x 
 

x = 20, z = 0 
 

10 m 
 

40 m 
 

40 m 
 

Origin 
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< เลือกองคอาคารท้ังหมด กด Ctrl + A 

 < จากทูลบาร Generate เลือกไอคอน Circular Repeat 

< หรือเลือกเมน ูGeometry > Circular Repeat… 
 

 
 
< เม่ือคลิก OK โมเดลจะถูกสรางขึ้นดังในรูปขางลาง 
 

 

เฟรมเดิมยังถูกเลือกอยู อยาพ่ึงไปคลิกอะไรเพราะท่ีถูกเลือกจะหายไป ตองมาเลือกใหมเพ่ือทํา
ขั้นตอไป 

ถาเผลอคลิกไปแลวตองเลือกใหมโดยคลิกเลือกมุมมอง View From + Y แลวใชเมาทตีกรอบ
เลือกดังในรูปขางลาง ถาเลือกไดมาเกินใหกด Ctrl คางไวแลวคลิกคานท่ีเลือกเกินมาออก 
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< ทํา Translational Repeat คลิกไอคอน  หรือเลือกจากเมนู Geometry 

< เม่ือหนาจอแสดงขึ้นมาใหใสคาตามในรูปขางลาง 

 

 

เราอาจใช Circular Repeat และ Translational Repeat ทําสวนท่ีเหลือตอไป หรือลอง
ทํา Mirror ดูดังนี้ 
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< การปรับมุมมองทําไดโดยใชทูลบารดานบนใหลองคลิกแตละปุมดูตามตองการ 
 

 
 
< เลือกสวนท่ีตองการทํา Mirror ดังในรูปขางลาง 

 

< คลิกไอคอน Mirror  หรือเลือกเมนู Geometry > Mirror… เม่ือหนาจอแสดง
ขึ้นมาใหใสขอมูลดังในรูปขางลาง 
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< เลือกโมเดลในสวนโคงดังในรูปขางลาง 

 
 
< ส่ัง Mirror โดยเลือก Mirror Plane : X – Y, Plane at Z = -20 m จะไดโมเดลดัง

ในรูปขางลาง 
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< คลิกมุมมอง Isometric View  เพ่ือดูโมเดลสามมิต ิหรือคลิกไอคอน 3D Rendered 

View  

 

Move 
คานและแผนถูกกําหนดดวยโหนดท่ีปลายหรือท่ีมุม ดังนั้นถาเรายายโหนดก็จะสามารถการ
เคล่ือนยายหรือเปล่ียนขนาดคานหรือแผนได 

< กอนใชคําส่ัง Move ตองเลือกวัตถุท่ีตองการเลือกกอน โดยมีวิธีส่ังสามวิธี : 
• กดปุม F2 

• คลิกเมาทขวา แลวเลือก Move จากรายการ 

• เลือกเมน ูGeometry > Move 
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แบบฝกหัด : สรางโมเดลหลังคากริดสามมิต ิ
< เริ่มตนโปรแกรมใหมแบบ Space ช่ือไฟล stadium หนวยความยาวเปน Meter 

< คลิกเลือกระนาบ X-Z และเปล่ียนมุมมองเปน View From +Y 

< สรางโมเดลดังในรูปขางลาง 

 
 

< เลือกโหนดตรงกลาง แลวใชคําส่ัง Move ขยับโหนดลงในแนวแกน Y = -1 

< เปล่ียนมุมมองเปนสามมิติจะไดรูปปรามิดคว่ําดังในรูปขางลาง 

 
 

< เลือกองคอาคารท้ังหมด แลวส่ัง Translation Repeat ในแนวแกน X 
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< จะไดโมเดลดังรูป 

 
 
< เลือกองคอาคารท้ังหมดอีก คราวนี้ส่ัง Translation Repeat ในแนวแกน Z 

 

 
 

< จะไดโมเดลดังรูป 
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< คลิกใหแสดงโมเดลในสามมิต ิ
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Insert Node or Split Beam 
ใน STAAD.Pro เราสามารถแทรกโหนดเพ่ิมเติมในระหวางคานไดตามตําแหนงท่ีตองการ 

< เริ่มตนโดยการเลือกคาน โดยมีวิธีส่ังสามวิธี : 
• คลิกไอคอน Insert Node บนทูลบาร Geometry ดานบน 

 

• เลือกเมน ูGeometry > Insert Node… หรือ Geometry > Split Beam 

• คลิกเมาทปุมขวาแลวเลือก Insert Node… 

 

ในหนาตางท่ีแสดงขึ้นมาจะมีรูปของคานท่ีเราเลือกไวพรอมท้ังโหนดท่ีปลายคาน เราสามารถ
กําหนดตําแหนงของโหนดท่ีจะแทรกไดหลายวิธีและหลายโหนด โดยโหนดท่ีแทรกจะปรากฏ
ขึ้นบนคานในรูปและในชอง Insertion Points 

< กําหนดระยะจากจุดเริ่มตนของคานแลวคลิกปุม Add New Point หรือใสเปนสัดสวนตอ
ความยาวคานในชอง Proportion 

< คลิกปุม Add Mid Point เม่ือตองการแทรกโหนดท่ีกลางชวงคาน 

< คลิกปุม Add n Points เม่ือตองการแทรก n โหนด 

< ถาเราเลือกมากกวาหนึ่งคานจะมีหนาตางอีกแบบแสดงขึ้นมา 
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<  การใชงานเหมือนเดิม แตจะชวยใหเราทํางานกับคานหลายคานไดดวยคําส่ังเดียว 

Add Beam ระหวาง Mid-Points 
< เม่ือตองการเพ่ิมคานเช่ือมระหวางกึ่งกลางคานหนึ่งไปยังอีกคานหนึ่ง 

 

< เลือกไอคอน  Add Beam between Mid-Points จาก Geometry ทูลบาร 

< ลูกศรจะเปล่ียนรูปเปน   

< คลิกท่ีคานตัวแรก โหนดจะถูกแทรกท่ีกึ่งกลางคาน 

< คลิกท่ีคานตัวท่ีสอง คานใหมจะถูกสรางขึ้นมา 

Add Beam แบบจุดตัดตั้งฉาก 
< เม่ือตองการเพ่ิมคานเช่ือมระหวางโหนดไปยังจุดตั้งฉากของอีกคานหนึง่ 

< เลือกไอคอน  Add Beam by Perpendicular Intersection จาก Geometry ทูล
บาร 

< ลูกศรจะเปล่ียนรูปเปน   

< คลิกท่ีโหนด แลวไปคลิกท่ีคาน คานใหมจะถูกสรางขึ้นมา 
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แบบฝกหัด : การใชเครื่องมือชวยเพ่ิมโหนดและคาน 

< เริ่มตนโปรแกรมใหมแลวสรางโมเดลดังในรูป 

 

 

< เลือกคานแลว Insert Node สรางโมเดลเพ่ิมใหเปนตามในรูปขางลาง 
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< ใชคําส่ัง Add Beam between Mid-Points สรางโมเดลเพ่ิมใหเปนตามในรูปขางลาง 

 

Cut Section 
< เม่ือสรางโมเดลสามมิติท่ีซับซอน การแสดงคานและแผนท้ังหมดอาจทําใหเกิดความสับสน

และการทํางานของโปรแกรมจะชาลง การ Cut Section จะตัดโมเดลออกเปนสวนเฉพาะ
ใหผูใชทํางานไดชัดเจนขึ้น 

< เลือกไอคอน  จาก Structure ทูลบารดานบน 
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< มีวิธีสามวิธีในการสรางรูปตัดของโมเดล : 
§ Range By Joint : กําหนดระนาบท่ีจะตัดผานโหนดท่ีระบุ 

§ Range By Min/Max : กําหนดระนาบท่ีจะตัดตามระยะนอยท่ีสุดถึงมากท่ีสุด 

 

§ Select to View : มีสามทางเลือกในการตัด 

 

§ Window/Rubber Band : กําหนดโดยการใหผูใชตีกรอบ(คลิกเมาทซายแลว
ลากตีกรอบ)รอบส่ิงท่ีตองการใหแสดง(จุดกึ่งกลางคานเปนตัวกําหนดวาถูกเลือก
หรือไม) 

§ เลือกโหนด, คาน หรือ แผน แลวคลิก View Highlight Only เฉพาะองคอาคาร
ท่ีถูกเลือกจะถูกแสดง 
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§ คลิก Select To View แลวเลือกสวนท่ีตองการจะใหแสดง 

< ถาตองการยกเลิกการดูบางสวน ใหคลิก Show All โมเดลท้ังหมดจะถูกแสดงเหมือนเดิม 

Renumber 
< STAAD.Pro จะทําการกําหนดหมายเลขโหนด, คาน และแผนอยูแลว แตเราสามารถชวย

แกไขจดัการเองไดตามตองการ 

< เลือกองคอาคารท่ีตองการแลวเลือกเมนู Geometry > Renumber เลือกวิธีท่ีเหมาะสม 

< ขอความเตือนจะแสดงขึ้นมา 

 

< อานขอความอยางระมัดระวัง เพราะเราจะไมสามารถแกไขยอนกลับหรือ Undo ได 

< ถาเราคลิก Yes หนาตางจะปรากฏขึ้นมา 

 

< เลือกหมายเลขเริ่มตน Start numbering from จะเรียงขึ้นหรือเรียงลง Ascending หรือ 
Descending จากนั้นกําหนดเง่ือนไขการเรียง Sort Criteria 
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แบบฝกหัด : การใชเครื่องมือชวยแสดงบางสวนและเรียงลําดับโหนด 
< จากโครงสรางในแบบฝกหัดท่ีแลว 

 

< ใชคําส่ัง Translation Repeat สรางโมเดลเพ่ิมดงัในรูป 
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< คลิกเมาทขวาแลวเลือก Labels คลิกใหแสดง Node Numbers ดูหมายเลขโหมดท่ีมุมบน
ซายของโครงตัวแรก (ในรูปคือโหนดหมายเลข 2) 

 

< เริ่มคําส่ัง Cut Section โดยเลือกไอคอน  หรือเลือกเมนู Tools > Cut Section… 
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< โมเดลจะถูกแสดงเพียงบางสวนดังในรูปขางลาง 

 

< เปล่ียนมุมมองเปน View from +Y และ Rotate จนได 

 

< สรางคานเช่ือมระหวางโครง อยางลืมกําหนดคาในหนาตาง Snap Node/Beam ดังนี ้
Plane: X-Z  Grid Origin: 0, 4, 0 
Construction Lines: X: Left=0, Right=4, m=1 
   Z: Left=0, Right=15, m=1 

 

< เปล่ียนเปนโหนดเคอรเซอรแลวเลือกโหนดท้ังหมด 

< เลือกเมน ูGeometry > Renumber > Nodes 

< เลือกหมายเลขเริ่มตนจาก 100 เรียงแบบ Ascending กําหนดเง่ือนไขเปน Joint No. 
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< เลือก Cut Section อีกครั้งแลวเลือก Show All และเปล่ียนมุมมองเปน Isometric 
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แบบฝกหัด : การสรางโมเดลปายโฆษณา 
< เปดไฟลใหมแบบ Truss ตั้งช่ือวา ComSign ใชหนวยความยาว m 

< บนระนาบ X-Y วาดโครงดังในรูปขนาดความสูง 1 m กวาง 1 m 

 

< เลือกทุกองคอาคารแลวส่ัง Translation Repeat  สรางเพ่ิมขึ้นอีกสามโครงวางเรียง
กันดังในรูปขางลาง 
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< ตอมาเราจะ “มวน” ท้ังส่ีโครงนี้เพ่ือเปนดานท้ังส่ีของเสา ดังในรูปจากมุมมองดานบน
ขางลาง แสดงการมวนซ่ึงจะทําโดยใชคําส่ัง Rotate 

42
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< เลือกสามโครงท่ีถูกสรางขึ้นมาใหม แลวส่ัง Rotate  
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< เปล่ียนมุมมองเปน View from +X เลือกสองโครงทางดานขวา 

 

< แลวส่ัง Rotate :  Angle = 90 degrees 
  X1 = 1 X2 = 1 
  Y1 = 0 Y2 = 1 
  Z1 = -1 Z2 = -1 

 

< เปล่ียนมุมมองเปน View from -Z เลือกโครงทางดานขวา 

 

< แลวส่ัง Rotate :  Angle = 90 degrees 
  X1 = 0 X2 = 0 
  Y1 = 0 Y2 = 1 
  Z1 = -1 Z2 = -1 

< ถามีโหนดเหลือคางบนหนาจอโดยไมมีคานมาตอเช่ือม ใหลบโดยเลือกเมนู  
Tools > Orphan Nodes > Remove 
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< ตอนนี้เราไดเสาหนึ่งบล็อกแลว เลือกทุกองคอาคารแลวใชคําส่ัง Translation Repeat  
 สรางขึ้นไปใหสูงซัก 10 บล็อก 

  

< ส่ัง Translation Repeat   อีกครั้งเพ่ือสรางเสาอีกตน 
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< คราวนี้เราจะเริ่มสรางสวนท่ีเปนปาย เพ่ือความสะดวกในการวาด เราจะซอนเสาสวนใหญ
ไว แสดงเฉพาะหัวเสาโดยใชคําส่ัง Cut Section  โดยเลือกระนาบ X-Z และโหนดท่ี
หัวเสาเชนในตัวอยางนี้คือ Node 48 

 

โมเดลจะแสดงเฉพาะท่ีหัวเสาดังในรูปขางลาง 

 

< ไปท่ีหนา Geometry > Beam เลือก Snap Node/Beam  บนระนาบ X-Z  

กําหนดคาเสนกริด: 
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< เปล่ียนมุมมองเปน View from +Y แลววาดโมเดลดังในรูปขางลาง 

 

< กด Ctrl + A เลือกทุกองคอาคาร(ท่ีแสดง) ส่ัง Translation Repeat ขึ้นมา 1 m แบบมี
การ Link Step 

 

 

< คลิกปุม Add Beams  เพ่ิมองคอาคารยึดทแยงตามในรูปขางลาง ทําแคหนึ่งบล็อกก็
พอแลว Copy ไปทุกบล็อก องคอาคารท่ีซํ้ากันโปรแกรมจะลบออกโดยอัตโนมัติ 
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< ส่ัง Translational Repeat 

 

 
< เลือกทุกองคอาคารแลวส่ัง Translational Repeat 
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< เม่ือส่ัง Cut Section > Show All จะได 
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4 

 

หนาตัด, จุดรองรับ, ขอกําหนด และคาคงที ่
 

เนื้อหาที่จะกลาวถึงในบทนี้ 
n Portal 2D 

n Properties 

n Steel Section  

n Supports 

n Specifications 

n Constants 
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Portal 2D 
< หลังจากท่ีเราสรางโมเดลซ่ึงไดแก โหนด คาน และแผนพ้ืนแลว ในบทนี้เราจะกําหนด

คุณสมบัติของหนาตัดองคอาคาร ความหนาแผนพ้ืน ชนิดและคุณสมบัติของวัสดุท่ีใช จุด
รองรับ ตลอดจนคุณสมบัติอ่ืนๆท่ีเกี่ยวของของโครงสราง 

< สรางโมเดลใหมแบบ Plane ตั้งช่ือวา Portal2D หนวยความยาวเปน Meter สรางโมเดล
งายๆดังในรูปขางลาง 

 

< โมเดลท่ีเราพ่ึงจะสรางขึ้น STAAD.Pro จะเก็บเปนไฟลคําส่ังคือ Portal2D.std เรา
สามารถดูไดตลอดเวลาโดยคลิกไอคอน  บนทูลบาร หรือเลือกจากเมนู Edit > Edit 

Input Command File หนาตางแสดงไฟลคําส่ังจะแสดงขึ้นมาดังในรูปขางลาง 

 

ขอมูลคําส่ังท้ังหมดท่ีเราทํางานใน STAAD.Pro จะถูกบรรจุอยูในไฟลนี้ เนื่องจากเปน
ไฟลตัวอักษรมีขนาดเล็ก ทําใหสะดวกในการตรวจสอบขอผิดพลาดและจัดเก็บ 
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< คําส่ังท่ีเราใชกําหนดโหนดและคานคือ 

JOINT COORDINATES 
1 0 0 0; 2 0 4 0; 3 6 4 0; 4 6 0 0; 
MEMBER INCIDENCES 
1 1 2; 2 2 3; 3 3 4; 

ซ่ึงเปนคําส่ังท่ีส้ันเขาใจงาย นับจากนี้เม่ือเราเรียนรูคําส่ังใหม จะอางอิงถึงคําส่ังท่ีถูกสราง
ขึ้นในไฟลคําส่ังนี้ดวย ซ่ึงจะชวยใหเราเขาใจการทํางานของโปรแกรมไดดีขึ้น หากเกิด
ขอผิดพลาดในการรันโปรแกรมก็สามารถตรวจสอบไดจากไฟลคําส่ังนี ้

< ปดหนาตาง Snap Node/Beam แลวคลิก Labels ใหแสดงหมายเลขคาน 

 

Properties : กําหนดคุณสมบัติองคอาคาร 

 

< คลิกแถบดานขาง หนาหลัก General หนายอย Property หรือ 

< คลิกไอคอน Property Page บนทูลบารดานบน 

 

< หนาตาง Property จะแสดงขึ้นมา มีสองขั้นตอนท่ีตองทําคือ 

• กําหนดหนาตัดขึ้นมากอนโดยอาจเลือกจากตารางในกรณีของหนาตัดเหล็ก หรือ
กําหนดขนาดเองถาเปนหนาตัดคอนกรีต ซ่ึงจะแสดงเปนหนาตัดอางอิงในรายการ 

• กําหนด (Assign) หนาตัดอางอิงใหแกองคอาคารท่ีตองการ มีส่ีวิธีคือ 

− Assign To Selected Beams : กําหนดใหคานท่ีถูกเลือก 

− Assign To Edit List : กําหนดตามหมายเลขคาน 

− Use Cursor To Assign : ใชเคอรเซอรกําหนด 

− Assign To View : กําหนดใหทุกองคอาคารในมุมมอง 
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Steel Section 
< สมมุติวาเราตองการใชหนาตัดเหล็ก ใหคลิกปุม Section Database หนาตางแสดงตาราง

เหล็กจะแสดงขึ้นมา 
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< จะมีหนาตัดจากหลายประเทศใหเลือก ยกเวนไทย ดังนั้นจึงใหเลือกท่ีใกลเคียงกับเราท่ีสุด
คือ South Korean หนาตัด W Shape อาจลองคลิกปุม View Table 

< เลือกหนาตัด W300X200X56 คลิกปุม Add 

< เลือกหนาตัด W350X250X69 คลิกปุม Add 

< คลิกปุม Close ในหนาตาง Properties จะมีหนาตัดอางอิงแสดงขึ้นมา 

 

< คลิกเลือกรายการ Ref 1 : W300X200X56 ในกรอบ Assignment Method เลือก 
Use Cursor To Assign  

< กดปุม Assign เคอรเซอรจะเปล่ียนเปนรูป  นําไปช้ีแลวคลิกเลือกเสา 1 และ 3 เสร็จ
แลวคลิกถอนปุม Assign คืน  

 
จะเห็นวา Label เสา เปล่ียนเปน 1:R1 และ 3:R1 แปลวาถูกกําหนดเปน Ref 1 แลว 
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<  ใชวิธีเดิม Assign หนาตัด Ref 2 : W350X250X69 ใหกับคาน 2 

 Beta Angle 
< เปนอีกแถบหนึ่งในหนาตาง Properties เพ่ือใหกําหนดมุมในการวางหนาตัด ซ่ึงโดย

ปกติแลว STAAD.Pro จะวางใหโดยอัตโนมัติ 

< ลองใชคา Beta Angle = 90 แลว Use Cursor To Assign ใหเสาหมายเลข 3 

 

ถาดูในตารางแสดงขอมูลคาน จะเห็นวาคา Beta Angle ของเสาหมายเลข 3 เปล่ียนไป 

 

< คลิกขวาแลวเลือก 3D Rendering เพ่ือดูการเปล่ียนแปลงในสามมิต ิ
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< เปล่ียน Beta Angle ของเสาหมายเลข 3 กลับไปเหมือนเดิม 

< คําส่ังท่ีเพ่ิมขึ้นในไฟลคําส่ังคือ 

MEMBER PROPERTY KOREAN 
1 3 TABLE ST W300X200X56 
2 TABLE ST W350X250X69 

การเปล่ียนหนวยความยาว 
ในการกําหนดคาออฟเซตของ member จะสะดวกกวาถาใชหนวยความยาวเปน ซม. แทนท่ีจะ
เปน เมตร คําส่ังท่ีใชเปล่ียนหนวยคือ 
 

UNIT  CM  MTON 
 

< เพ่ือเปล่ียนหนวยใหคลิกไอคอน Input Units บนทูลบารดานบน: 

 
หรืออาจเลือกจากเมนู Tools > Set Current Input Unit เม่ือมีหนาจอแสดงขึ้นใหคลิก
เลือกหนวยความยาวเปนเซนติเมตรแลวคลิก OK 

 

กําหนดออฟเซตขององคอาคาร 
เนื่องจากคานเบอร 2 มีชวงความยาวจริงคือระยะชองวางระหวางผิวในของเสาท้ังสองขาง ไมใช
ระยะระหวางศูนยกลาง เราสามารถใชขอไดเปรียบนี้ไดโดยกําหนดออฟเซต member 2 จะถูก 
OFFSET ท่ีจุด START ไป 15 cm ตามแกนรวม X และ 0.0 และ 0.0 ตามแกนรวม Y และ 
Z ตัวเลขเดียวกันออฟเซตท่ีปลาย END เปนคาลบ 15 cm คําส่ัง STAAD ท่ีใชคือ : 
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MEMBER OFFSET 
2  START 15  0  0 
2  END  -15  0  0 

< เริ่มจากเลือกคาน 2 กอน โดยคานท่ีถูกเลือกจะถูกไฮไลทขึ้น 

< ในการออฟเซตขององคอาคาร ใหคลิกไอคอน Specification Page บนทูลบารบนสุด 

 

หรืออาจคลิกเลือกหนา General > Spec จากแถบทางดานซายของหนาจอวาดภาพหลัก 

< หนาตาง Specification จะแสดงขึ้นมา ดังในรูปขางลาง ใหคลิกท่ีปุม Beam 

 
 

< เม่ือหนาจอ Beam Specs แสดงขึ้นมาใหเลือกแถบ Offset เพ่ือกําหนดออฟเซตท่ี node 

เริ่มตนในทิศทาง X ใสคา 15 ลงในชองวาง แลวกดปุม Add 
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< ทําขั้นตอนซํ้า แตเลือก End และใสคา -15 ในชอง X จะไดรายการดังในรูปขางลาง  

 

< Assign ท้ังสองรายการใหแกคานหมายเลข 2 ดังในรูปขางลาง 

 
คาน 2 จะส้ันลงปลายละ 15 cm  

< คลิกท่ีใดๆในภาพเพ่ือเอาไฮไลทออก แลว Save งาน 
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Prismatic Section 
< หลังจากท่ีเราสรางโมเดลซ่ึงไดแก โหนด คาน และแผนพ้ืนแลว ในบทนี้เราจะกําหนด

คุณสมบัติของหนาตัดองคอาคาร ความหนาแผนพ้ืน ชนิดและคุณสมบัติของวัสดุท่ีใช จุด
รองรับ ตลอดจนคุณสมบัติอ่ืนๆท่ีเกี่ยวของของโครงสราง 

กําหนดจุดรองรับ 
< การกําหนดจุดรองรับทําโดยการเลือกหนายอย Support ในหนาหลัก General หรือ 

< คลิกไอคอน Support Page ท่ีทูลบารบนสุด 

 

 

< ใชหลักการเดียวกับการกําหนดหนาตัดคือ เลือกจุดรองรับขึ้นมากอนแลว assign ให
โหนดท่ีตองการ 

< ในหัวขอนี้จากรูปเดิม Portal 2D ตองการจุดรองรับท่ีโหนด 1 เปนแบบ FIXED และท่ี 
โหนด 4 เปนแบบ PINNED คําส่ังท่ีใชคือ 

SUPPORTS 
1  FIXED  ;  4  PINNED 
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< ในหนาตาง Supports จะแสดงขึ้นมา คลิกปุม Create เพ่ือสรางจุดรองรับ 

< เลือกแบบ Fixed แลวกดปุม Add จากนั้นก็สรางแบบ Pinned ดังแสดงในรูปขางลาง 

 

< คลิกเลือก S2 จุดรองรับแบบ FIXED และเลือก Use Cursor To Assign คลิกปุม 
Assign แลวเลือกคลิกท่ีโหนด 1 เสร็จแลว Assign S3 จุดรองรับแบบ PINNED 
ใหแกโหนด 4 โดยวิธีเดียวกัน โมเดลจะกลายเปนดังรูป 
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Specification : Member Truss 
< สมมุติวาเราตองการใสหลังคาโครงถักลงบนโครง Portal 2D เดิมของเรา 

< เลือกเมน ูGeometry > Run Structure Wizard 

< เลือก Truss Models > Howe Roof ใสคาตัวแปรดังนี ้
 

 
 

< เลือก Edit > Add/Paste Model in STAAD.Pro วางแบบ Reference Pt. จะได 

 

< เลือกหนาตัดแลวลอง Assign ใหกับองคอาคารท่ีเพ่ิมขึ้นมาใหม 

< อาจใชวิธี Assign To Edit List โดยพิมพหมายเลขคาน 7 To 15 ดังในรูป 
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< เนื่องจากเรากําหนดมาตั้งแตเริ่ม องคอาคารทุกตัวจะเปนแบบโครงขอแข็ง(Frame) ถา
เราตองการใหโครงหลังคาท่ีเพ่ิมขึ้นมาใหมนี้เปนโครงขอหมุน(Truss) ตองกําหนดเปน
การเฉพาะ 

< เลือกหนายอย Spec จากหนาหลัก General แลวคลิกปุม Beam… เลือกแถบ Truss 
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< จะมีรายการ MEMBER TRUSS แสดงขึ้นมา อาจใชวิธี Assign To Edit List 

เหมือนเดิม หรือใช Use Cursor To Assign แลวตีกรอบเลือก จะไดโมเดลดังในรูป 

 

กําหนดคาคงที ่
< กลับมาท่ีหนายอย Property ในหนาหลัก General ในรายการแสดสงหนาตัดจะเห็น

วาหนาตัดถูกกําหนดวัสดุเปน STEEL 
 

 
 

< ใน STAAD.Pro จะมีวัสดุพรอมท้ังคุณสมบัติมาใหเราใชอยูแลวเพ่ือความสะดวก
รวดเร็ว สามารถดไูดโดยคลิกปุม Materials… 
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< ถาลองเปดคอมมานดไฟลดูจะพบการกําหนดคุณสมบัติวัสดุดังนี้ 
DEFINE MATERIAL START 
ISOTROPIC STEEL 
E 2.05e+008 
POISSON 0.3 
DENSITY 76.8195 
ALPHA 1.2e-005 
DAMP 0.03 
END DEFINE MATERIAL 
MEMBER PROPERTY KOREAN 
1 3 TABLE ST W300X200X56 
2 4 TO 6 TABLE ST W350X250X69 
7 TO 15 TABLE ST L50X50X4 
CONSTANTS 
MATERIAL STEEL ALL 

เริ่มจากการนิยามวัสดุขึ้นมากอน แลวนํามากําหนดใหองคอาคาร การกําหนดคาวัสดุตอง
ระวังเรื่องหนวยใหดี โดยดูวากอนจะถึงการนิยามวัสดุนั้นมีคําส่ังกําหนดหนวยเปนอะไร 
ในท่ีนี้จะเปน UNIT METER KN 

< ท่ีสมมุติวาเราตองการกําหนดคุณสมบัติวัสดุเอง ก็ใหคลิกท่ีรายการหนาตัดท่ีละหนาตัด 
คลิกปุม Edit… หนาตางตารางหนาตัดเหล็กท่ีเราเคยจะแสดงขึ้นมา ใหสังเกตุใน
หนาตางจะเห็นการเลือกวัสดุเปน STEEL ไวใหเลือกหนาตัดใหมโดยคลิกถอนการ
เลือกออก แลวคลิกปุม Change… 
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< ทําเชนเดียวกันนี้จนครบทุกหนาตัด ในรายการแสดงหนาตัดจะไมมีการกําหนดวัสดุ 
 

 
 

< กอนอ่ืนใหทําการกําหนดหนวยเสียกอน คลิกไอคอน  หรือเลือกเมนู Tools > Set 

Current Input Unit… เปล่ียนหนวยความยาวเปน cm และแรงเปน kg 

< เลือกหนายอย Material ในหนาหลัก General 
 

 
 

< คลิกปุม Create แลวตั้งช่ือเปน STEEL2 ใสขอมูลดังนี้ 

Young’s Modulus (E) : 2.05e6 kg/cm2 

Poisson’s Ratio (nu) : 0.3 

Density : 7.85 kg/cm3 
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< คลิกเลือก STEEL2 เลือก Assign To View ใหทุกองคอาคาร 

< เปดคอมมานดไฟลเพ่ือตรวจดูอีกครั้ง เราอาจพิมพแกในคอมมานดไฟลเลยก็ได 
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5 

 

น้ําหนักบรรทุก 
 

เนื้อหาที่จะกลาวถึงในบทนี้ 
n Portal 2D 

n Create Primary Load 

n Selfweight 

n Member Loads 

n Load Combinations 

n Example Problem 15: Wind and floor load generation on a spaceframe 

n Example Problem 14: Seismic load generation on a spaceframe 
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Portal 2D 
< ในบทนี้เราจะใช Portal2D เปนโมเดลเดิมแบบงายๆดังในรูปขางลาง ขอแนะนําใหสราง

ขึ้นมาใหมเพ่ือเปนการทบทวนไปในตัว 

< สรางโมเดลใหมแบบ Plane ตั้งช่ือวา Portal2D หนวยความยาวเปน Meter สรางโมเดล
งายๆดังในรูปขางลาง 

 

< เปดตาราง W Shape ของ South Korean เลือกหนาตัด W300X200X56 เปนเสา
หมายเลข 1 และ 3 เลือกหนาตัด W350X250X69 เปนคานหมายเลข 2 

 

< การกําหนดจุดรองรับท่ีโหนด 1 เปนแบบ FIXED และท่ี โหนด 4 เปนแบบ PINNED 
คําส่ังท่ีใชคือ 

 



STAAD.Pro : Loading  5 - 3 
 

Create Primary Load 
< เลือกหนายอย Load ในหนาหลัก General จะมีหนาตางแสดงการกําหนดน้ําหนักบรรทุก

แสดงขึ้นมา มีสามรายการคือ 

• Definition : ใชกําหนดขอมูลในการสรางน้ําหนักบรรทุกเชน แรงลม แผนดินไหว 
ตามมาตรฐานตางๆเชน IBC และ UBC 

• Load Cases Details : กําหนดน้ําหนักบรรทุกในแตละกรณี กําหนดการรวมกระทํา
(Load Combination) และการสรางน้ําหนักบรรทุกแบบตางๆ 

• Load Envelopes : ในเวอรช่ันใหมจะมีรายการนี้ใหเราไดกําหนดกรณีบรรทุกเพ่ือ
นําไปสรางสภาวะขอบเขตบรรทุก(Load Envelope)ได 

< เลือกรายการ Load Cases Details แลวกดปุม Add จะมีหนาตางแสดงขึ้นมาใหเรา
กําหนด Primary Load 

 
 

< ตั้งช่ือวา DEAD LOAD แลวกดปุม Add แลวกดปุม Close 

< จะมีรายการ DEAD LOAD แสดงขึ้นมา 
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< คลิกเลือกรายการ DEAD LOAD บนทูลบารจะแสดง DEAD LOAD ขึ้นมา ซ่ึงถามี
หลายกรณีเราก็สามารถเปล่ียนกรณีบรรทุกไดท่ีนี ่

 

< คลิกปุม Add จะมีหนาตาง Add New : Load Items แสดงขึ้นมาเพ่ือใหเราเลือกวาจะ
ใสน้ําหนักบรรทุกใดลงใน DEAD LOAD บาง 

< น้ําหนักบรรทุกแรกท่ี DEAD LOAD มักตองมีเสมอคือน้ําหนักของตัวโครงสรางเอง 
ดังนั้นเลือก Selfweight Load ในทิศทาง Y -1 ดังในรูป คลิกปุม Add 

 

< คลิกรายการ Member Load > Uniform Force กําหนดคาน้ําหนักบรรทุกและทิศทาง
ดังในรูป คลิกปุม Add 

 

< สังเกตรายการท่ีแสดงขึ้นมา จะเห็นวาของ Uniform load ยังมีเครื่องหมายคําถาม ? ไม
เหมือนของ Selfweight เนื่องจากน้ําหนักตัวเองจะถูกกําหนดใหทุกองคอาคารโดย
อัตโนมัติ แตสําหรับน้ําหนักบรรทุกอ่ืนเราตองกําหนดวาใหกระทํากับองคอาคารใด 
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< คลิกท่ีรายการ UNI GY -1 kN/m แลวกําหนดใหกับคานหมายเลข 2 เครื่องหมายคําถาม
จะหายไป รูปโมเดลจะมีน้ําหนักบรรทุกแสดงขึ้นมาดังในรูป  

 

< สรางน้ําหนักบรรทุกกรณีใหมตั้งช่ือวา LIVE LOAD โดยคลิกเลือก Load Cases 

Details แลวกดปุม Add… เชนเดิม  

<  ใสน้ําหนัก Member Load > Uniform Force ในทิศ GY -2 kN/m แลวกําหนดให
คานหมายเลข 2 เชนเดิม 

< สังเกตท่ีทูลบารดานบน ในชองท่ีแสดงน้ําหนักบรรทุกคราวนี้เรามาสองกรณ ีสามารถเลือก
สลับไปมาไดอยางสะดวก 

 

< สราง Load case 3 ตั้งช่ือวา WIND LOAD คราวนี้ใสเปน Nodal Load > Node ใส
คา Fx = 5 kN ดังแสดงในรูปขางลาง กําหนดใหโหนดหมายเลข 2 
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< เราไดสราง Load case ขึ้นมาท้ังหมด 3 กรณีดังรายการในรูปขางลาง 

 

< ถาเปดไฟลคําส่ังจะมีขอความเพ่ิมขึ้นคือ 

LOAD 1 LOADTYPE None  TITLE DEAD LOAD 
SELFWEIGHT Y -1 
MEMBER LOAD 
2 UNI GY -1 
LOAD 2 LOADTYPE None  TITLE LIVE LOAD 
MEMBER LOAD 
2 UNI GY -2 
LOAD 3 LOADTYPE None  TITLE WIND LOAD 
JOINT LOAD 
2 FX 5 
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< คราวนี้เราจะมากําหนด Load Combination ซ่ึงก็เปนอีก Load Case หนึ่ง ดังนั้นจึงใช
วิธีสรางเหมือนเดิมคือ คลิกเลือก Load Cases Details แลวกดปุม Add… 

< ในหนาตาง Add New : Load Case เลือกรายการ Define Combinations 

 

< ตั้งช่ือ Load Case 4 นี้วา 1.2DL+1.6LL ใสคาตัวแปร ai = 1.2 เลือกรายการ DEAD 

LOAD คลิกปุม  แลวเลือก LIVE LOAD โดยใชตัวแปร 1.6 ในรายการจะเปน 

 

< คลิกปุม Add จะมารายการ Load Combination 4 : 1.2DL+1.6LL แสดงขึ้นมา 
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< สราง Load Case 5 : 0.75[DL+LL+WIND] โดยใชคาตัวแปร 0.75 แลวกดปุม  
ทุกรายการจะถูกนําเขามาโดยใชตัวแปร 0.75 เทากัน 

 

< คลิกปุม Add จะมี Load Case 5 แสดงขึ้นมาในรายการ  

 

< คําส่ังท่ีเพ่ิมขึ้นสําหรับการกําหนดน้ําหนักบรรทุกคือ 

LOAD COMB 4 1.2DL+1.6LL 
1 1.2 2 1.6  
LOAD COMB 5 0.75[DL+LL+WIND] 
1 0.75 2 0.75 3 0.75 

< คลิกปุม Save ขอมูลเก็บไวในช่ือไฟล Portal2D.std เพ่ือใชในบทตอไป 
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Example Problem 15:  
Wind and floor load generation on a spaceframe 

โครงสรางเฟรมสามมิติในตัวอยางนี้จะถูกวิเคราะหโดยใชเครื่องมือการสรางแรงลมและ
น้ําหนักบนพ้ืนท่ีมีมากับโปรแกรม 

 

< เริ่มตนโปรแกรม เลือกชนิดโครงสรางเปน Space ตั้งช่ือวา BLDWIND หนวยความยาว
เปน Meter หนวยแรงเปน Metric Ton 

< เลือก Open Structure Wizard ในหนาตางถัดมาเลือกชนิดโมเดลแบบ Frame 

Models ดับเบ้ิลคลิกท่ีไอคอน Bay Frame  เม่ือหนาจอแสดงขึ้นมาใหใสขอมูลดังในรูป
ขางลาง 

 

 
 

< ถาแตละ bays มีขนาดไมเทากันใหคลิกปุม ... เพ่ือเปล่ียนแปลง เม่ือคลิก Apply จะได
โครงสรางดังในรูปขางลาง วางกลับลงบนตัวโปรแกรมหลัก 
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< ไปท่ีหนา General > Property เลือกหนาตัดเหล็ก WF แลว Assign To View ใหองค

อาคารท้ังหมด ใชวัสดุเปน STEEL  

< ไปท่ีหนา General > Support สรางจุดรองรับแบบ FIXED BUT MX MZ แลว 
assign ใหทุกจุดรองรับ 
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ในการวิเคราะหโครงสรางรับแรงลม งานแรกท่ีตองทําคือการแปลงจากความเร็วลมหรือแรงดัน
ลมใหเปนแรงกระทําท่ีจุดตอ, น้ําหนักกระจายบนองคอาคาร หรือ แรงดันบนผนังอาคาร เรา
สามารถหลีกเล่ียงการคํานวณสวนใหญไดโดยการใชเครื่องมือสรางน้ําหนักบรรทุกของ 
STAAD โดยคํานวณจากแรงดันลมท่ีแปรตามความสูง แลวแปลงเปนแรงกระทําท่ีจุดตอ 

< เริ่มโดยการนิยามแรงลม DEFINE WIND LOAD โดยไปท่ีหนา General > Load 

คลิกเลือกรายการ Definitions ในหนาตาง Load แลวคลิกปุม Add…  
 

 
 

< เลือกรายการ Wind ในชอง Type No = 1 เราสามารถสรางแรงลมไดหลายชนิดในหนึ่ง
โมเดล คลิกปุม Add และ Close รายการในหนาตาง Load จะกลายเปน 
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< คลิกเลือกรายการ TYPE 1 คลิกปุม Add… จะมีหนาตางแสดงขึ้นมาเพ่ือใหเราใสคา
แรงดันลมตามระดับความสูง 

 

 
 

< ถาเรารูคาอยูแลวก็ใสคาลงไปไดเลย หรือจะใหโปรแกรมคํานวณใหก็คลิกปุม Calculate 

as per ASCE-7 เพ่ือเขาสูการคํานวณตามมาตรฐาน ASCE-7  
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< ในหนาตางถัดมา หัวขอ Common Data จะใหเรากรอกขอมูลท่ัวไป ไดแก มาตรฐานท่ี
ใช, ประเภทอาคาร, ความเร็วลม, การเปดโลงของภูมิประเทศ, ชนิดโครงสราง และเปนลม
พัดขึ้นเขาหรือไม ใสขอมูลเสร็จแลวกดปุม Apply  
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< คลิกรายการตอมา Main Building Data ใสขอมูลของอาคารเชนขนาดดานตางๆ สวน
ความถ่ีธรรมชาติถาไมรูอาจใชสูตรประมาณคือ คาบการแกวง: T = 0.1×จํานวนช้ัน เชน
ในตัวอยางเปนตึกสองช้ันก็ใช T = 0.2 วินาที แปลงเปนความถ่ี F = 1/0.2 = 5 Hz ใส
ขอมูลเสร็จแลวกดปุม Apply  

 

  
 

< ในรายการตอมา Building Design Pressure ใหเลือกวาจะเปนผนังอาคารท่ีจะรับ
แรงลมวาเปนดานปะทะลม(Windward), ดานหลบลม(Leeward) หรือดานขาง(Side 

Wall) เสร็จแลวกดปุม Apply  
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< เม่ือคลิกปุม OK จะกลับมาท่ีหนาตาง Add New : Wind Definition เดิมพรอมขอมูล
แรงดันลมท่ีคํานวณได 
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< คลิกปุม Add โปรแกรมจะใหเราใสคา Exposure Factor เสร็จแลวคลิกปุม Add  

 

< คลิกปุม Close ใตรายการ Wind Definition จะมีรายการเพ่ิมขึ้นมา 

 

< รายการ Exposure 0.900000 ยังมีเครื่องหมายคําถามอยู เราตองคลิกเลือกแลวกําหนด
ใหกับจุดตองท่ีจะรับแรงลมท่ีมีลักษณะพิเศษเชนเปนชองเปดในโครงสราง 

< เปล่ียนมุมมองเปน View from +X ใชเคอรเซอรโหนดตีกรอบเลือกโหนดท่ีตองการ แลว
คลิกเลือก Assign To Selected Nodes 
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< สรางกรณีน้ําหนักบรรทุกขึ้นใหมสําหรับแรงลมจากการคลิก Load Cases Details แลว
กดปุม Add… ในหนาตาง Primary เลือก Loading Type = Wind ตั้งช่ือแลวกดปุม 
Add  
 

 

< เม่ือมีรายการของกรณีบรรทุกใหมของแรงลมแสดงขึ้นในรายการ ใหเลือกแลวคลิกปุม 
Add… เลือกรายการ Wind Load ในหนาตาง Add New : Load Items  
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< เลือกชนิด Type 1 ตามท่ีตั้งไวตอนนิยามแรงลม เลือกทิศทาง และกําหนด Y Range, X 

Range และ Z Range เปนพ้ืนท่ีบนโครงสรางท่ีรับแรงดันลม 

< โปรแกรมจะสรางแรงลมดังแสดงในรูป 
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Example Problem 14:  
Seismic load generation on a spaceframe 

โครงสรางเฟรมสามมิติในตัวอยางนี้จะถูกวิเคราะหโดยใชเครื่องมือการสรางแผนดินไหวตาม
มาตรฐาน UBC 

< เริ่มตนสรางโมเดลใหมแบบ Space ตั้งช่ือวา BLDEQK ใช Structure Wizard สราง 
Bay Frame ดังในรูปขางลาง 

 

 

 

< ในหนา Property เลือกหนาตัดจากตาราง  South Korean มาสองหนาตัดคือ 
W300X300X87 มาเปนเสา และ W400X300X94 มาเปนคาน ใชวิธีเลือกและการ
เปล่ียนมุมมองชวยในการกําหนดหนาตัดใหกับองคอาคารท่ีตองการ 
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< กําหนดจุดรองรับเปนแบบ FIXED : ไปท่ีหนายอย Support สรางจุดรองรับแบบ 
FIXED แลวกําหนดใหแกฐานเสาทุกตน 
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< ไปท่ีหนายอย Load เลือกรายการ Definitions แลวคลิกปุม Add… 

< เลือกรายการ Seismic เลือกมาตรฐานและกําหนดคาพารามิเตอรตางๆ 

 

< เม่ือคลิกปุม Add รายการในหนาตาง Load จะกลายเปน 

 
< คลิกรายการท่ีนิยามขึ้นใหมแลวคลิกปุม Add… 
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มีขั้นตอนในการกําหนดน้ําหนักบรรทุกแผนดินไหวคือ ในขั้นแรกกําหนดพารามิเตอรท่ี
เกี่ยวของเชน Zone factor, Importance factor, Site coefficient etc. และน้ําหนัก
บรรทุกในแนวดิ่งซ่ึงจะใชในการคํานวณแรงเฉือนท่ีฐาน(base shear) ในตัวอยางนี้เราจะใช
แต Self Weight ดังนั้นเลือกรายการนี้แลวกดปุม Add แลว Close 

 ขั้นตอนท่ีสองจะสรางกรณีบรรทุกแลวใสน้ําหนักท่ีนิยามไวกระทําในทิศทางท่ีตองการ 

< เลือกรายการ Load Cases Details คลิกปุม Add… ในหนาตาง Primary เลือก Load 

Type = Seismic ปลอยเปนช่ือ LOAD CASE 1 ก็ได แลวคลิกปุม Add 

< สราง LOAD CASE 2 ในลักษณะเดียวกัน รายการในหนาตาง Load จะเพ่ิมขึ้นเปน 

 

< คลิกเลือก LOAD CASE 1 แลวคลิกปุม Add… 

< ในหนาตาง Add New : Load Item เลือกรายการ Seismic Loads เพ่ือกําหนดทิศทาง
และคาแฟกเตอรดังในรูป 

< คลิกเลือก X Direction และใสคา Factor = 0.75 แลวคลิกปุม Add 
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< สําหรับ LOAD CASE 2 เลือก Z Direction และ Factor = 0.75 คลิกปุม Add 

 

< ในแตละ LOAD CASE เราจะใสน้ําหนักในแนวดิ่งเชนในตัวอยางนี้เราจะใสน้ําหนัก
ตัวเอง เนื่องจากเราตองการจะวิเคราะหแบบ P-Delta ตอไป ใหคลิกท่ีรายการแตละ 
LOAD CASE แลวเลือก SELF WEIGHT Y -1 รายการจะเพ่ิมเปน 
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6 

 

การวิเคราะหและแสดงผล 
 

เนื้อหาที่จะกลาวถึงในบทนี้ 
n Analysis/Print 

n Beam 2D 

n Post Processing  

n Truss 2D 

n User Customized Report 

n Special Problem : Internal Hinge 

n Special Problem : Inclined Support 

n Special Problem : Support Settlement 
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Analysis/Print 
< ในบทนี้เราจะกลาวถึงการใชคําส่ังวิเคราะหและการแสดงผล  

< เริ่มโปรแกรมใหม เลือกโครงสรางแบบ Plane ตั้งช่ือไฟลวา Beam2D 

< ลองคลิกท่ีหนา Analysis/Print โปรแกรมจะนําเราเขาหนายอย Analysis และแสดง
หนาตาง Analysis/Print Commands ขึ้นมา 

 

เพ่ือใหผูใชเลือกคําส่ังท่ีจะใชในการคํานวณวิเคราะหโครงสราง สําหรับปญหาโดยท่ัวไปแล ว 
เราจะใชแถบ Perform Analysis ส วนตัวเลือกอ่ืน เชน PDelta Analysis ซ่ึงอาจจะใชบาง 
จะเปนการวิเคราะหแบบพิเศษเฉพาะตัว 

คําส่ังท่ีเราสามารถเลือกใชไดในแถบ Perform Analysis คือการกําหนดส่ิงท่ีจะพิมพออกมา
ในไฟลผลลัพธ (Output File) ไดแก 

• No Print ไมพิมพ 

• Load Data พิมพข อมูลน้ําหนักบรรทุก 

• Statics Check ตรวจสอบผลรวมของแรงภายนอก แรงปฏิกิริยาท่ีจุดรองรับ รวมท้ัง
โมเมนต ของแรงดังกลาวท่ีจุดกําเนิด 

• Statics Load เช นเดียวกับ Statics Check แต เพ่ิมการแสดงผลรวมของแรง
ภายนอกและแรงภายใน ท่ีแต ละจุดต อด วย 
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• Mode Shapes พิมพคาโหมดการส่ันไหวสําหรับการวิเคราะหแบบพลศาสตร 

• Both มีค าเทากับ Load Data รวมกับ Statics Check 

• All มีค าเทากับ Load Data รวมกับ Statics Load 

ใน STAAD.Pro รุนใหม เรามีโหมด Post Processing ซ่ึงสามารถแสดงผลการวิเคราะหได
อยางละเอียดและเปนกราฟก นอกจากนั้นยังมีการสรางรายงานแบบผูใชกําหนดเองไดอีก 

ดังนั้นการพิมพผลในไฟลผลลัพธซ่ึงเปนไฟลตัวอักษรเทานั้น จึงลดความนาสนใจลง มักใชใน
กรณีพิเศษเทานั้น โดยท่ัวไปจึงมักเลือกเปน No Print 

< คลิก Close เพ่ือปดหนาตาง แลวกลับไปเริ่มสรางโมเดลท่ีหนา Geometry กอน  

< โมเดล Beam2D เปนคานตอเนื่องรับน้ําหนักดังแสดงในรูปขางลาง 

 
 

< ใช Snap Node/Beam ในมุมมอง View From +Z สรางโมเดลดังในรูป 
 

 

1200 kg 
500 kg/m 

4 m 1 m 2 m 
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< ไปท่ีหนา General > Property เพ่ือความรวดเร็ว เลือกหนาตัดจากตารางเหล็กมาตรฐาน 
แลวกําหนดใหแกองคอาคาร 

 

< ไปท่ีหนา General > Support สรางเพ่ือท่ีจะใสจุดรองรับให แก โครงสร าง ซ่ึงมีท้ังหมด 

3 แบบ คือ แบบยึดแน น (Fixed) แบบหมุนได  (Pinned) และเล่ือนได  (Roller) โดยสร 
างรูปแบบจุดรองรับท้ัง 3 ขึ้นมาก อนด วยคําส่ัง Add แล วจึง Assign ให แก จุดต อท่ีต อง
การทีละจุดตามลําดับ ด วย Node Cursor 

สําหรับจุดรองรับแบบ Roller ใหเลือกแถบ Fixed But คลิกเลือกดีกรีอิสระท่ีตองการ 
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รายการแสดงจุดรองรับจะเปนดังในรูป 

 

< กําหนดจุดรองรับใหกับโหนดท้ังสามดังแสดงในรูป 

 

< ไปท่ีหนา General > Load สรางกรณีบรรทุกใหม โดยคลิกรายการ Load Cases 

Details แลวคลิกปุม Add…  

< คลิกรายการกรณีบรรทุกท่ีสรางขึ้นมาใหม คลิกปุม Add ในหนาตาง Add New : Load 

Items ใสน้ําหนักบรรทุกแบบ Concentrated Force และ Uniform Force ดังในรูป 
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< ในรายการจะแสดงน้ําหนักบรรทุกท้ังสองขึ้นมาดังในรูปใหคลิกเลือกแลว Assign ใหคาน
ท่ีตองการ 

 

< เพ่ือใหการแสดงภาพดูดีขึ้น ใหคลิกขวาแลวเลือกรายการ Labels คลิกเลือกใหแสดงคา
น้ําหนักบรรทุก 

 

 

< ความยาวลูกศรน้ําหนักบรรทุกจะขึ้นกับขนาดน้ําหนักบรรทุก เราสามารถปรับขนาดไดโดย
ปรับสเกล คลิกเมาทขวา เลือก Structure Diagrams… เลือกแถบ Scales แลวเลือก
ปรับคาตามหัวขอท่ีตองการ 
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< เม่ือปรับสเกลเสร็จจะไดรูปคานรับน้ําหนักดังในรูป 

 

< ไปท่ีหนา Analysis/Print เลือก Print Option = All เพ่ือใหพิมพผลลัพธทุกอยาง
ออกมาในไฟลแสดงผล (.ANL) คลิกปุม Add แลว Close 
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< สังเกตหนาตาง Analysis-Whole Structure ดานขาง จะมีรายการคําส่ังเหมือนในไฟล
คําส่ังแสดงใหเราดูเพ่ือใหตรวจสอบความถูกตอง บางครั้งคําส่ังเรียงสลับกันก็ทําใหเกิด
ผิดพลาดตอนรันคํานวณได จะเห็นรายการท่ีเราพ่ึงส่ังใหพิมพผลแสดงเปนตัวเขม 

 

< นอกจากนี้ถาเราลองคลิกหนายอย Pre-Print หรือ Post-Print แลวคลิกปุม Define 

Commands… จะมีหนาตางแสดงขึ้นมาใหเราเลือกรายการท่ีเราสามารถกําหนดใหพิมพ
แสดงผลได 
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< ส่ังใหโปรแกรมรันการคํานวณ เลือกเมนู Analyze > Run Analysis… หรือกด 
Ctrl+F5 เลือก STAAD Analysis แลวคลิกปุม Run Analysis 

 

หนาตางแสดงสถานการณทํางานจะปรากฏขึ้นมา 
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ถาไมมีขอผิดพลาด (0 Error) และคําเตือน (0 Warning) เม่ือเสร็จส้ินการคํานวณ ผลลัพธจะ
ถูกพิมพออกมาในไฟลแสดงผลนามสกุล .anl ในตัวอยางนี้คือ Beam2D.anl 

เรามีทางเลือกสามทางคือ 1) View Output File : ดูไฟลแสดงผล 2) Go to Post 

Processing Mode : ไปยังโหมดหลังการคํานวณ หรือ 3) Stay in Modeling Mode : อยู
ในโหมดสรางโมเดลเหมือนเดิม 

< คลิกเลือก View Output File แลวกดปุม Done โปรแกรมจะเปดหนาตางใหมขึ้นมา 
แสดงขอมูลในไฟลแสดงผล 

                                                                    
             **************************************************** 
             *                                                  * 
             *           STAAD.Pro                              * 
             *           Version  200X Bld US                   * 
             *           Proprietary Program of                 * 
             *           Research Engineers, Intl.              * 
             *           Date=    MMM DDD, YYYY                 * 
             *           Time=    XX:XX:XX                      * 
             *                                                  * 
             *      USER ID:  XXX                               * 
             **************************************************** 
 
      1. STAAD PLANE 
INPUT FILE: Beam2D.STD 
     2. START JOB INFORMATION 
     3. ENGINEER DATE 11-JUN-08 
     4. END JOB INFORMATION 
     5. INPUT WIDTH 79 
     6. UNIT METER KN 
     7. JOINT COORDINATES 
     8. 1 0 0 0; 2 4 0 0; 3 8 0 0 
     9. MEMBER INCIDENCES 
    10. 1 1 2; 2 2 3 
    11. DEFINE MATERIAL START 
    12. ISOTROPIC STEEL 
    13. E 2.05E+008 
    14. POISSON 0.3 
    15. DENSITY 76.8195 
    16. ALPHA 1.2E-005 
    17. DAMP 0.03 
    18. END DEFINE MATERIAL 
    19. MEMBER PROPERTY AMERICAN 
    20. 1 2 TABLE ST W12X230 
    21. CONSTANTS 
    22. MATERIAL STEEL ALL 
    23. SUPPORTS 
    24. 1 FIXED 
    25. 2 PINNED 
    26. 3 FIXED BUT FX FZ MX MY MZ 
    27. LOAD 1 LOADTYPE NONE  TITLE LOAD CASE 1 
    28. MEMBER LOAD 
    29. 1 CON GY -1.2 2 
    30. 2 UNI GY -0.8 
    31. PERFORM ANALYSIS PRINT ALL 
     
  
            P R O B L E M   S T A T I S T I C S 
            ----------------------------------- 
  
     NUMBER OF JOINTS/MEMBER+ELEMENTS/SUPPORTS =     3/     2/     3 
     ORIGINAL/FINAL BAND-WIDTH=     1/     1/      3 DOF 
     TOTAL PRIMARY LOAD CASES =    1, TOTAL DEGREES OF FREEDOM =      3 
     SIZE OF STIFFNESS MATRIX =        0 DOUBLE  KILO-WORDS 
     REQRD/AVAIL. DISK SPACE  =     12.0/  93731.5 MB 
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   LOADING     1  LOADTYPE NONE  TITLE LOAD CASE 1 
   ----------- 
   
   MEMBER LOAD - UNIT KN   METE 
  
   MEMBER     UDL      L1     L2      CON       L     LIN1     LIN2 
  
      1                            -1.2000 GY   2.00 
      2    -0.8000 GY   0.00    4.00 
  
 FOR LOADING -     1 
APPLIED JOINT EQUIVALENT LOADS 
 JOINT   FORCE-X     FORCE-Y     FORCE-Z      MOM-X       MOM-Y       MOM-Z 
     1 0.00000E+00-6.00000E-01 0.00000E+00 0.00000E+00 0.00000E+00-6.00000E-01 
     2 0.00000E+00-2.20000E+00 0.00000E+00 0.00000E+00 0.00000E+00-4.66667E-01 
     3 0.00000E+00-1.60000E+00 0.00000E+00 0.00000E+00 0.00000E+00 1.06667E+00 
  
          STATIC LOAD/REACTION/EQUILIBRIUM SUMMARY FOR CASE NO.     1 
          LOADTYPE NONE  TITLE LOAD CASE 1 
  
    ***TOTAL APPLIED LOAD ( KN   METE ) SUMMARY (LOADING    1 ) 
       SUMMATION FORCE-X =        0.00 
       SUMMATION FORCE-Y =       -4.40 
       SUMMATION FORCE-Z =        0.00 
  
      SUMMATION OF MOMENTS AROUND THE ORIGIN- 
      MX=           0.00  MY=           0.00  MZ=         -21.60 
  
    ***TOTAL REACTION LOAD( KN   METE ) SUMMARY (LOADING     1 ) 
       SUMMATION FORCE-X =        0.00 
       SUMMATION FORCE-Y =        4.40 
       SUMMATION FORCE-Z =        0.00 
  
      SUMMATION OF MOMENTS AROUND THE ORIGIN- 
      MX=           0.00  MY=           0.00  MZ=          21.60 
  
    MAXIMUM DISPLACEMENTS (  CM  /RADIANS) (LOADING      1) 
             MAXIMUMS    AT NODE 
      X =  0.00000E+00       0 
      Y =  0.00000E+00       0 
      Z =  0.00000E+00       0 
      RX=  0.00000E+00       0 
      RY=  0.00000E+00       0 
      RZ=  6.99740E-06       3 
  
    EXTERNAL AND INTERNAL JOINT LOAD SUMMARY ( KN   METE )- 
  
   JT     EXT FX/   EXT FY/   EXT FZ/    EXT MX/    EXT MY/    EXT MZ/ 
          INT FX    INT FY    INT FZ     INT MX     INT MY     INT MZ 
  
                                                                      SUPPORT=1 
     1      0.00     -0.60      0.00       0.00       0.00      -0.60 
            0.00      0.19      0.00       0.00       0.00       0.23  111111 
  
     2      0.00     -2.20      0.00       0.00       0.00      -0.47 
            0.00     -0.47      0.00       0.00       0.00       0.47  111110 
  
     3      0.00     -1.60      0.00       0.00       0.00       1.07 
            0.00      0.28      0.00       0.00       0.00      -1.07  011110 
  
    ************ END OF DATA FROM INTERNAL STORAGE ************ 
   
    32. FINISH 
  
         *********** END OF THE STAAD.Pro RUN *********** 
  

< เราสามารถดูไฟลนี้ไดโดยเลือกไอคอน  บนทูลบารขางๆไอคอนสําหรับดูไฟลคําส่ัง 
หรือเลือกเมน ูFile > View > Output File > STAAD Output 
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Post Processing Mode : โหมดหลังการคํานวณ 
< เปนโหมดท่ีเราใชดูผลท่ีไดจากการคํานวณ ลองเลือกเมนู Mode ดูจะพบวาท้ังหมดท่ีผาน

มานั้นเราอยูในโหมดสรางโมเดล(Modeling Mode)เทานั้น ซ่ึงเราจะไปโหมดอ่ืนไดก็
ตอเม่ือรันการคํานวณผานแลวเทานั้น 

< การเขาสูโหมดหลังคํานวณทําไดโดยคลิกไอคอน  หรือเลือกเมนู Mode > Post 
Processing 

 

< ในหนาตางตอมาจะใหเรากําหนดผลลัพธท่ีจะแสดง เชนเลือกกรณีน้ําหนักบรรทุก องค
อาคารท่ีจะใหแสดง หรือมุมมอง ในท่ีนี้เรามีกรณีบรรทุกเดียว คลิกปุม Apply แลว OK 

 

Node Displacements 
<  เม่ือเขาสูโหมด  Post Processing ผลท่ีแสดงขึ้นมาจะอยู ในหนา  Node > 

Displacement ใหลองปรับสเกล Displacement = 0.01 mm/m  
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สังเกตไอคอน Displacement บนทูลบารเราสามารถเลือกคลิกท่ีไอคอนเพ่ือกลับมาดู
ผลไดอีกอยางรวดเร็ว 

 

< หนาตางดานขวาเปนตารางแสดงคาตางๆ เชนถาคลิกเลือกแถบ Max Relative 

Displacements จะแสดงคาการแอนตัวมากท่ีสุดในทิศทางตางและตําแหนงท่ีเกิด 

 

Node Reactions 
<  ไปท่ีหนา Beam > Reactions โปรแกรมจะแสดงคาแรงปฎิกิริยาท่ีโหนด 

 

Beam Forces 
<  ไปท่ีหนา Beam > Forces โปรแกรมจะแสดงคาแรงภายในตางๆท่ีเกิดขึ้นในคาน ซ่ึงเรา

สามารถเลือกไดจากทูลบารเชน Bending Z Moment  

 

หรือ Shear Y Force  เม่ือปรับสเกลใหเหมาะสมจะได 
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การแสดงคาบนแผนภูมิแรง/โมเมนต 
<  เลือกเมน ูResult > View Value… คลิกแถบ Ranges แลวเลือก All 

< เลือกแถบ Beam Results คลิก Ends และ Midpoint สําหรับ Bending คลิก 
Annotate แลว Close 
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Beam Stresses 

<  ไปท่ีหนา Beam > Stresses โปรแกรมจะแสดงการกระจายหนวยแรงในองคอาคาร โดย
เราสามารถเล่ือนสไลดเปล่ียนหนาตัดท่ีแสดงไดอยางสะดวก 

 

Beam Graphs 

<  ไปท่ีหนา Beam > Graphs โปรแกรมจะแสดงแผนภูมิแรงภายในเชนโมเมนตดัด แรง
เฉือนของแตละองคอาคาร คลิกเลือกองคอาคารท่ีตองการใหแสดง และคลิกขวาในแผนภูมิ
ดานขางแลวเลือก Diagrams… เพ่ือเลือกแรงท่ีตองการใหแสดง 
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Truss 2D : โครงถักสองมิติ 
< ลักษณะปญหา การวิเคราะหโครงถักสองมิติ ใหเริ่มตนโปรแกรมใหม เลือกชนิดโครงสราง

เปนแบบ TRUSS ตั้งช่ือไฟลวา Truss2D ในหัวขอนี้เราจะมาวิเคราะหโครงถัก กําหนด
ให E = 2 x 108 kN/m2 และ A = 6 x 10-4 m2 สําหรับทุกช้ินสวน 

 

< ใชหนวยความยาวเปน Meter และหนวยแรงเปน KiloNewton 

< เลือกระนาบ X-Y กําหนดเสนกริด X: 0 → 6, Spacing = 0.5 และ Y : 0 → 1, 

Spacing = 0.7 สรางโครงสรางดังแสดงในรูป 
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< ไปท่ีหนา General > Property เพ่ือกําหนดคุณสมบัติใหแก องค อาคาร สําหรับตัวอยางนี้
เราจะกําหนดพ้ืนท่ีหน าตัด (A) ส วนคุณสมบัติวัสดุโจทย กําหนดค าโมดูลัสยืดหยุ น (E) 

มาให  ซ่ึงพอเพียงสําหรับโครงสร างแบบ TRUSS คลิกปุม Define… เลือก General 

เพ่ือใสคาพ้ืนท่ีหน าตัด 

 

< เราตองการใสคาพ้ืนท่ีในชอง AX โดยอาจใชเครื่องมือแปลงหนวยชวยโดยกดปุม F2 แลว
ใสคา 6 cm2  

< ในชอง Material ใหคลิกเครื่องหมายถูกออก เพราะเราจะกําหนดเองภายหลัง 

< คลิกปุม Add แลว Assign To View ใหทุกองคอาคาร 
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< ไปท่ีหนา General > Support ใสจุดรองรับแบบ Pinned และแบบ Roller ท่ีแตละขาง
ของโครงถักดังในรูปลาง 

 

TIPS 

 

ในกรณีท่ีตองการลบจุดรองรับออกจากโครงสรางทําไดโดย Assign S1 (No Support) 
ใหแกจุดตอท่ีมีจุดรองรับเดิมอยู 

 
< ไปท่ีหนา General > Load คลิก Load Cases Details แลวคลิกปุม Add เพ่ือสราง

Load Case 1 แลวคลิกปุม Add เลือก Nodal Load ใสคา Fy = -120 kN ดังในรูป
ขางลาง 
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< ทําซํ้าเปล่ียน Fy = -150 kN ในรายการจะแสดงน้ําหนักบรรทุกท้ังสองขึ้นมาดังในรูปให 

 
 

< ปรับสเกลและกําหนดการแสดงคาใหน้ําหนักบรรทุกจนไดดังในรูปขางลาง 

 
< ปรับสเกลและกําหนดการแสดงคาใหน้ําหนักบรรทุกจนไดดังในรูปขางลาง 

< ทําการบันทึกภาพ ไว เพ่ือใชประกอบรายงานโดยคลิกไอคอน Take Picture  

< ขั้นตอมาเราจะกําหนดคุณสมบัติวัสดุโดยเลือกเมนู  Commands > Material 

Constants > Elasticity… แลวกําหนดค าใหแก ท้ังโครงสร าง 

 

< ไปท่ีหนา Analysis/Print เลือก Print Option = No Print แลวคลิกปุม Add 

< เลือกเมนู Analyze > Run Analysis… เลือกทําการวิเคราะหด วย STAAD 
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< เข าสู โหมด Post Processing เลือกใหแสดงแรงปฏิกิริยา (Reactions) และการเสีย
รูปทรง (Displacements) แลว Take Picture เก็บไว 

 

User Customized Report : รายงานผูใชกําหนดเอง 
แตเดิมรายการคํานวณจาก STAAD จะมีเฉพาะไฟลแสดงผลเปนตัวอักษร(Output File)

นามสกุล .ANL ดังไดกลาวถึงมาแลว ซ่ึงเปนรูปแบบท่ีถูกกําหนดมาแลวยากแกการทําความ
เขาใจ ใน STAAD.Pro ยุดใหมจะมีฟงกช่ันสราง “รายงานผูใชกําหนดเอง” ซ่ึงนอกจากจะมี
รูปแบบท่ีสวยงามแลวยังใหผูใชสามารถกําหนดเนื้อหาไดเอง โดยเราสามารถแทรกรูปกราฟก
และตารางแสดงผลตางเขาดวยกันไดตามตองการ 

< เริ่มโดยการไปยังหนา Reports หรือคลิกไอคอนจากเมนูบาร  Report Setup  เม่ือ
เลือกรายการท่ีต องการแล วสามารถดูตัวอย างก อน พิมพ ได ด วยไอคอน Print Preview 

 จะได รายงานท่ีจัดพิมพสําเร็จรูป หนาตาง Report Setup จะแสดงขึ้นมา 
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แถบ Items : ใชกําหนดหัวขอท่ีจะแสดงในรายงาน รายการ Available แสดงหัวขอท่ีมีให
เลือกโดยจะมีอยูหลายประเภทแตท่ีใชบอยคือ Input, Output และ Pictures รายการ Input 

จะเปนขอมูลท่ีผูใชใสเขาไป สวนรายการ Output จะเปนผลท่ีไดจากการคํานวณ รายการ 
Pictures จะเปนรูปท่ีถายเอาไวซ่ึงดูไดจากแถบ Picture Album 

เเม่ือเลือกเสร็จแลว คลิกปุม OK รายงานจะถูกสรางขึ้นใหตรวจดูไดกอนพิมพในลักษณะ 
Print Preview ถาตองการแกไขใหคลิกปุม Setup Report เพ่ือกลับมาแกไขใหม 

แถบ Load Cases : ใชกําหนดกรณีบรรทุกท่ีจะแสดงในรายงาน 

แถบ Modes : ใชในการวิเคราะหแบบพลศาสตร เพ่ือเลือกรูปแบบการส่ันไหวท่ีตองการให
แสดง 

แถบ Ranges : ใหกําหนดองคอาคารท่ีตองการแสดง ปกติจะเลือกไวเปน All แตเราอาจเลือก
ใหแสดงเฉพาะบางองคอาคารได 

แถบ Picture Album : เปนอัลบ้ัมรูปภาพท่ีถูกถายเก็บเอาไว โดยเราสามารถกําหนดขนาด
ของภาพท่ีจะแสดงได รวมถึงเขียนขอความอธิบายใตภาพในชอง Caption 

 

แถบ Options : ใชกําหนดทางเลือกตางของรายงานเชน Header, Page Outline และ 
Footer เลขท่ีหนา รูปแบบตาราง 
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แถบ Name and Logo : ใชใสช่ือบริษัทและโลโกลงในรายงาน โดยเราสามารถพิมพช่ือ
บริษัทลงไปพรอมเลือกชนิดและขนาดฟอนท สวนโลโกตองเปนไฟลภาพชนิด Windows 

Metafile (.wmf) หรือ .bmp 
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แถบ Load/Save : ใชจัดเก็บเนื้อหารายงานผูใชกําหนดเอง และโหลดรายงานท่ีถูกเก็บไวขึ้นมา 

แถบ Steel Design : จะนําผลการออกแบบเหล็กท่ีคํานวณไวระหวางการวิเคราะหมาใสลงในรายงาน 

จุดหมุนภายใน (Internal Hinge) 
จากตัวอยางคานสองชวงมีจุดหมุนภายในระหวางชวงคานขางซายใตแรงกระทําเปนจุดดังในรูป
ขางลาง 

 

< เริ่มตนสรางโมเดลใหมหรือเปดแฟมขอมูลขอมูลเดิมของตัวอยางคานมาแกไข โดยใชคําส่ัง 
File > Save As… แลวบันทึกเปนแฟมงานใหม 

< แทรกจุดตอโดยคลิกเลือกคาน แลวเลือกเมนู Geometry > Insert Node… หรือคลิก
เมาทขวาคางไวแลวเลือก Insert Node จากรายการท่ีแสดงขึ้นมา 

1200 kg 
500 kg/m 

4 m 1 m 2 m 
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< ใสระยะ 2 เมตร คลิกปุม Add New Point แลวคลิก OK โมเดลจะกลายเปน 

 

จุดตอท่ีแทรกใหมจะเปนเบอร 4 ซ่ึงเราอาจเรียงใหมเพ่ือใหสะดวกตอการอางอิงและความ
รวดเร็วในการคํานวณ 

< คลิกเลือกจุดตอท้ังหมดโดยเลือกเมน ูSelect > By All > All Nodes 

< เลือกเมนู Geometry > Renumber > Nodes… กลองโตตอบจะแสดงขึ้นมา 

< เลือก X Coordinate เปนเง่ือนไขในการเรียงแบบ Ascending แลวคลิกปุม Accept 

 

< ทําเชนเดียวกันสําหรับคาน เม่ือเรียงเสร็จจะไดดังในรูปขางลาง 

 

< ไปท่ีหนา General > Spec เพ่ือทําการ Release องคอาคารใหไมรับโมเมนตก็จะ
กลายเปนจุดหมุน โดยคลิกท่ี Beam… ในกลองโตตอบ Specifications 

< คลิกแถบ Release เลือก Location: Start เลือกโมเมนตท่ีจะ Release คือ Mz แลวคลิก 
Add  →  START MZ 
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< ทําซํ้า เลือก Location: End, Mz แลวคลิก Add  →  END MZ 

< รายการในกลอง Specification จะแสดงขึ้นดังในรูปขางลาง 

 

< กําหนดการรีลีสโมเมนต ให องค อาคารท่ีต องการ ด วยตัวเลือก Assign To Selected 

Beams โดยกําหนด START MZ ใหแก คานหมายเลข 2 และกําหนด END MZ ให แก 
คานหมายเลข 1 

 

 

1 

2 

3 
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< ถาเปดดูไฟลคําส่ังจะมีรายการเพ่ิมขึ้นคือ 

MEMBER RELEASE 
2 START MZ 
1 END MZ 

< ทําการวิเคราะหตอไปตามปกติจะไดผลการวิเคราะหดังนี ้

 

 

 

 

จุดรองรับแบบเอียง (Inclined Support) 
สําหรับปญหาโครงข อหมุนรูปสามเหล่ียมด านเท าความยาวเท ากับ 3 m มีค าโมดูลัสยืดหยุ น E = 

210 kN/mm2 พ้ืนท่ีหน าตัด A = 4 x 103 mm2 สําหรับทุกช้ินสวน 
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< เริ่มสรางโมเดลใหม เลือกชนิดโครงสรางเปนแบบ Truss ตั้งช่ือวา Truss2DSK ใช
หนวย m และ kN  

< ในปญหานี้คานยาว 3 m เอียงทํามุม 60 องศา แตกริดท่ีเราใชเปนตารางของเสนในแนวดิ่ง
และแนวนอนจึงไมสะดวกตอการวาด ถาพิกัดเป นตัวเลขก็อาจไม ลงตัวพอดีนัก เพ่ือใหได  
ค าพิกัดท่ีถูกต อง เราจะใชเทคนิคการหมุนระนาบ (Angle of Plane) ดังนี้ 

< ตั้งคาระนาบ X-Y และระยะกริด : 
Construction Lines : X : Left = 0, Right = 5, Spacing = 1 

Y : Left = 0, Right = 5, Spacing = 1 

< หมุนระนาบ Z-Z ไป 30 องศา เพ่ือสรางองคอาคารหมายเลข 1 ดังในรูปขางลาง 

 

< หมุนระนาบ Z-Z กลับไปยังท่ีเดิม แลวสรางองคอาคารท่ีเหลือ อยาลืมคลิกเลือก Snap to 

existing nodes too แลวสรางโมเดลตอจนไดรูปสามเหล่ียม 
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< ไปท่ีหนา General > Property เปล่ียนหนวยโดยเลือกเมนู Tools > Set Current 

Unit ใหเปน Millimeter  

< คลิกปุม Define… เลือก General ใสขอมูลพ้ืนท่ี Ax: 4000 mm2 แลวคลิกเครื่องหมาย
ถูกท่ี Material ออก 

< คลิก Add เลือก Assign To View แลวคลิกปุม Assign 

< กําหนดโมดูลัสยืดหยุ นโดย ใช คําส่ัง Commands > Material Constants > 

Elasticity… แลวกําหนดค าใหแก ท้ังโครงสร างโดย Assign To View 

 

< ไปหน าย อย General > Support เพ่ือท่ีจะใส จุดรองรับให แก โครงสร าง ซ่ึงมีท้ังหมด 2 

แบบ คือ แบบหมุนได  (Pinned) และเล่ือนได  (Roller) โดยสร างรูปแบบจุดรองรับท้ัง 2 

ขึ้นมาก อนด วยคําส่ัง Add แตเนื่องจากจุดรองรับเปนแบบเอียงใหเลือกแถบ Inclined 

แลวกรอกขอมูล 

NOTES 
 

จุดอางอิง (Incline Reference Point) ของท่ีรองรับแบบเอียงคือจุดสมมุติท่ีเทียบกับ
จุดรองรับ โดยวัดแกนพิกัดโลคอลเทียบกับแกนพิกัดโกลบอล ในแกนพิกัดโลคอล X จะ
มีทิศทางจากจุดรองรับไปยังจุดอางอิง ดังแสดงในรูปขางลาง 

 

Global 

X 

Y 

Reference 
point 

30o 

30o 

-1 

-1.732 

X 

Y 
Local 
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< สรางจุดรองรับเอียงอีกจุดใช Incline Reference Point Coordinate X = 1, Y = -

1.732 และ Z = 0 เลือก Support Type เปนแบบ Pinned 

< ไปท่ีหนาหน าย อย General >Load สราง Load Case 1 คลิกปุม Add เลือก Nodal 

Load ใสคาแรงและโมเมนต ดังในรูปขางลาง 
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< ปรับสเกลและกําหนดการแสดงคาใหน้ําหนักบรรทุกจนไดดังในรูปขางลาง 

 

< ไปท่ีหนา Analysis/Print เลือกแบบ No Print 

< ส่ังให โปรแกรมทําการวิเคราะห ด วยคําส่ังจากเมนูบาร  Analyze > Run Analysis… 

เลือกทําการวิเคราะหด วย STAAD 

< หลังการคํานวณ ลองตรวจดูแรงปฏิกิริยาท่ีจุดรองรับดูวาถูกตองหรอืไม 
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จุดรองรับทรุดตัว (Support Settlement) 
พิจารณาโครงข อหมุน ซ่ึงมีค าโมดูลัสยืดหยุ น E = 210 kN/mm2 และเกิดการทรุดตัว 20 mm ท่ี
โหนดหมายเลข 2 ดังภาพ 
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< เริ่มสรางโมเดลใหม เลือกชนิดโครงสรางเปนแบบ Truss ตั้งช่ือวา TrussSET ใชหนวย 
m และ kN  

< ตั้งคาระนาบ X-Y และระยะกริด : X : Left = 0, Right = 22, Spacing = 0.5 

 Y : Left = 0, Right = 10, Spacing = 0.5 

< คลิกปุม Snap Node/Beam แลวสรางโมเดลดังในรูปขางลาง 

 

< เข าสูหน าย อย General > Property เพ่ือกําหนดคุณสมบัติให แก องค อาคาร โดยกําหนด
หนวยคําส่ัง Tools > Set Current Unit ใหเปน Centimeter คลิกปุม Define… เลือก 

General เพ่ือสร างหน าตัด  

ซ่ึงโจทย ข อนี้มี 3 หน าตัดคือ AX = 20 cm2, 40 cm2 และ 60 cm2 อยาลืมคลิกชอง 
Material ออก เม่ือสรางเสร็จแลวอาจคลิกปุม Value… เพ่ือดูคาหนาตัดท้ังหมด 

 

< จากนั้นกําหนดหนาตัดใหแก องค อาคารทีละช้ินด วย Assign To Selected Beam… 
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< กําหนดโมดูลัสยืดหยุ นโดย ใช คําส่ัง Commands > Material Constants > 

Elasticity… แลวกําหนดค าใหแก ท้ังโครงสร างโดยเลือกตัวเลือก Assign To View 

 

< เลือกหน าย อย General > Support เพ่ือท่ีจะใส จุดรองรับให แก โครงสร าง ซ่ึงมีท้ังหมด 

2 แบบ คือ แบบหมุนได  (Pinned) และเล่ือนได  (Roller)  

< ในการสรางจุดรองรับท่ีเปน Roller นั้นใหเลือกแถบ Fixed But แลวคลิกเลือก Release 

ทุกชองยกเวน FY แตท่ีจุดนี้โปรแกรมมักมีขอบกพรอง เม่ือสรางเสร็จใหตรวจสอบดูอีก
ครั้งโดยเลือกเมนู View > Table… คลิกเลือก Supports แลวกดปุม OK จะมีตารางจุด
รองรับแสดงขึ้นมาดังในรูปขางลาง คลิกแถบ Fixed But 
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ถาเปนอยางในรูปขางบนถือวาผิด เนื่องจาก Release จะตรงขามกับ Restraint ใน
ตัวอยางนี้เรา Release หมดยกเวน FY (หรือ Restraint เฉพาะ FY) นั่นคือรับแรงได
เฉพาะทิศทาง Y แตในตารางกลับแสดงผลเปนตรงขาม 

< กําหนดจุดรองรับแบบ Pinned ใหโหนด 1 และจุดรองรับแบบ Roller ใหโหนด 3 และ 4 

ถาดูในไฟลคําส่ังจะพบวา 

SUPPORTS 
1 PINNED 
3 4 FIXED BUT FX FZ MX MY MZ 

ซ่ึงถูกตองตามตองการ วิธีแกใหส่ัง Save แลวปดโปรแกรม เม่ือเปดขึ้นมาใหมจะกลายเปน 

 

 

< ไปท่ีหน าย อย General > Load สร างชุดน้ําหนักบรรทุกขึ้นมา ซ่ึงจะเปนน้ําหนักกระทํา
เปนจุด (Concentrated Force) และแรงเนื่องจากการทรุดตัวของจุดรองรับ (Support 
Displacement)  

< คลิกเลือก Load Cases Details แลวคลิกปุม Add เพ่ือสรางน้ําหนักบรรทุกกรณี 1 
(Load Case 1) คลิกเลือกรายการท่ีสรางขึ้นแลวคลิกปุม Add เลือก Nodal Load ใส
คาแรงและการทรุดตัวของจุดรองรับดังในรูปขางลาง 
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< Assign แรงท้ังสองลงในโครงสราง ณ จุดตอท่ีตองการ 

< ปรับสเกลและกําหนดการแสดงคาใหน้ําหนกับรรทุกจนไดดังในรูปขางลาง 

 

< ไปยังหนา Analysis/Print เลือก No Print แลวส่ัง Run Analysis… 
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< ไปยังโหมด Post Processing เพ่ือดูผลการคํานวณ 
 
Reaction: 

 
 

 
Displacement: 
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การวิเคราะหแบบ P-Delta 
เปนการวิเคราะหแบบทุติยภูมิของการรับน้ําหนักบรรทุกในแนวดิ่งของโครงซ่ึงมีการเซ
เนื่องจากแรงดานขาง เพราะการเซของโครงจะทําใหโมเมนตจากน้ําหนักบรรทุกเพ่ิมขึ้นทําให
การเซมากขึ้นได การวิเคราะห P-∆ จะทําหลายครั้งจนการเซคงท่ี 

< เริ่มตนโดยการสรางโมเดล Portal2D ดังในรูปขางลาง ถาเคยสรางมาแลวใหเปดขึ้นมา
แกไขก็ได 

 

< สรางโมเดลเปนโครงกวาง 6 เมตร สูง 4 เมตร จากตารางเหล็กของ South Korean เลือก
วัสดุ เป น  STEEL กํ าหนดหน า ตั ด  W300X200X56 เ ปน เสา ท้ั งสอง  และ 
W350X250X69 เปนคาน 

< สรางจุดรองรับแบบ Fixed และ Pinned แลวกําหนดใหจุดรองรับท้ังสอง 

 

6 m 

1 

W300 x 56.8 

1 

W300 x 56.8 

3 

4 

4 m 

W350 x 59.2 2 

2 3 
Wind = 5 ton 

DL = 1 ton/m 
LL = 2 ton/m 
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< สรางน้ําหนักบรรทุกกรณี 1 เปน DEAD LOAD เพ่ิมน้ําหนักตัวเอง Self Weight และ 
Uniform Load ทิศทาง GY ขนาด -1 Mton/m 

< สรางน้ําหนักบรรทุกกรณี 2 เปน LIVE LOAD เพ่ิมน้ําหนัก Uniform Load ทิศทาง 
GY ขนาด -2 Mton/m 

< สรางน้ําหนักบรรทุกกรณี 3 เปน WIND LOAD เพ่ิมน้ําหนัก Nodal Load ทิศทาง Fx 
ขนาด 5 Mton 

< กําหนด Uniform Load ของ DEAD LOAD และ LIVE LOAD ใหแกคาน และ 
Nodal Load ของ WIND LOAD ใหแกโหนดหมายเลข 2 ท่ีมุมดังแสดงในรูป 

 

< สรางน้ําหนักบรรทุกกรณี 4 เปน Primary Load ตั้งช่ือวา 0.75[DL+LL+W] คลิกปุม 
Add… เลือกรายการ Repeat Load ซ่ึงจะใชแทน Load Combination เพ่ือใหการ
วิเคราะห P-∆ มีความถูกตอง ใชคาตัวคูณ 0.75 กับทุกกรณีบรรทุกดังในรูป 
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< รายการในหนาตาง Load จะเปนดังในรูปขางลาง 

 

< ไปท่ีหนา Analysis/Print ในแถบ Perform Analysis เลือก Print Option = No 
Print 

< ส่ัง Run Analysis… ไปยังโหมด Post Processing เลือกใหแสดงกรณีบรรทุก 4 ดูคา 
Displacement ของโหนดท่ีมุมบน ในตัวอยางนี้คือ Node 2 และ 3  
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< กลับมาท่ีโหมด Modeling ไปหนา Analysis/Print ลบรายการ Perform Analysis 

ในหนาตางดานขวาออก 

 

< คราวนี้คลิกเลือกแถบ PDelta Analysis เลือก Print Option = No Print นอกจากนั้น
จะมีอีกสองชองคือ Iterations ตัวเลขท่ีใสในชองนี้จะเปนจํานวนครั้งท่ีจะทําการคํานวณ
ซํ้า ถาไมใสจะถูกกําหนดเปน 1 ครั้ง สวนอีกชองคือ Converge ถาเราใสจํานวนในชองนี้ 
โปรแกรมจะทําการคํานวณซํ้าไปจนคาการเคล่ือนท่ีของโหนดไมเปล่ียนแปลง หรือจํานวน
ครั้งการคํานวณถึงคานี้กอน  

< ใหคลิกชอง Converge ใสคามากหนอยเชน 100 ดังรูป 
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< ส่ัง Run Analysis… ไปยังโหมด Post Processing เลือกใหแสดงกรณีบรรทุก 4 ดูคา 
Displacement ของโหนดท่ีมุมบน ในตัวอยางนี้คือ Node 2 และ 3  

 

< จะเห็นวามีคามากกวาการวิเคราะหแบบปกต ิ 
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7 

 

การออกแบบโครงสรางเหล็ก 
 

เนื้อหาที่จะกลาวถึงในบทนี้ 
n สรางโมเดล Portal 2D 

n กําหนดรายการน้ําหนักบรรทุก 

n กําหนดพารามิเตอร 

n คําส่ังออกแบบ 

n วิเคราะหอีกคร้ัง 

n ตรวจสอบการออกแบบ 

n ส่ังวิเคราะหและดูผลการคํานวณ 

n ไฟลคําส่ัง และไฟลแสดงผล 

n คํานวณตัวคูณความยาวประสิทธิผลอัตโนมัต ิ

n ออกแบบแผนรองฐานเสาใน STAAD.etc > Component Design 

n ออกแบบองคอาคารเหล็กใน STAAD.etc > Steel Design 
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สรางโมเดล Portal 2D 
< ในบทนี้เราจะกลาวถึงการออกแบบโครงสรางเหล็ก โดยใชโมเดลเปนโครงเหล็กหนึ่งชอง

หนึ่งช้ันรับน้ําหนักบรรทุกคงท่ี น้ําหนักบรรทุกจร และแรงลมดังแสดงในรูปขางลาง 

 

< เริ่มโปรแกรมใหม กอนสรางโมเดลใหม ตรวจสอบหนวยกอนวาเปนระบบเมตริกหรือไม 
เลือกเมน ูFile > Configure… เลือก Base Unit = Metric คลิก Accept 

< เริ่มสรางโมเดลใหม เลือกเมนู File > New เลือกโครงสรางแบบ Plane ตั้งช่ือไฟลวา 
Portal2D ใชหนวย Meter – Metric Ton 

< สรางโมเดลเปนโครงกวาง 6 เมตร สูง 4 เมตร จากตารางเหล็กของ South Korean เลือก
วัสดุ เป น  STEEL กํ าหนดหน า ตั ด  W300X200X56 เ ปน เสา ท้ั งสอง  และ 
W350X250X69 เปนคาน 

< สรางจุดรองรับแบบ Fixed และ Pinned แลวกําหนดใหจุดรองรับท้ังสอง 

< ลองแสดงโมเดลในสามมิติ โดยคลิกขวาเลือก Structure Diagram… ในแถบ 
Structure ในกรอบ 3D Section เลือก Full Sections 

6 m 

1 

W300 x 56.8 

1 

W300 x 56.8 

3 

4 

4 m 

W350 x 59.2 2 

2 3 
Wind = 5 ton 

DL = 1 ton/m 
LL = 2 ton/m 
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< สรางน้ําหนักบรรทุกกรณี 1 เปน DEAD LOAD เพ่ิมน้ําหนักตัวเอง Self Weight และ 
Uniform Load ทิศทาง GY ขนาด -1 Mton/m 
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< สรางน้ําหนักบรรทุกกรณี 2 เปน LIVE LOAD เพ่ิมน้ําหนัก Uniform Load ทิศทาง 
GY ขนาด -2 Mton/m 

< สรางน้ําหนักบรรทุกกรณี 3 เปน WIND LOAD เพ่ิมน้ําหนัก Nodal Load ทิศทาง Fx 
ขนาด 5 Mton 

< กําหนด Uniform Load ของ DEAD LOAD และ LIVE LOAD ใหแกคาน และ 
Nodal Load ของ WIND LOAD ใหแกโหนดหมายเลข 2 ท่ีมุมดังแสดงในรูป 

 

< สรางน้ําหนักบรรทุกกรณ ี4 เปน Load Combination = 1.2DL+1.6LL 

< สรางน้ําหนักบรรทุกกรณ ี5 เปน Load Combination = 0.75[DL+LL+W] 

< รายการในหนาตาง Load จะเปนดังในรูปขางลาง 

 

< ไปท่ีหนา Analysis/Print เลือก Print Option = No Print 
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กําหนดรายการน้ําหนักบรรทุก 
< ในหัวขอนี้เราจะเริ่มกลาวถึงคําส่ังท่ีใชในการออกแบบโครงสรางเหล็ก คําส่ังแรกคือ 

LOAD LIST เปนการบอกโปรแกรมวาจะออกแบบเพ่ือรับน้ําหนักบรรทุกกรณีไหนบาง 
ซ่ึงโดยท่ัวไปจะเปน Combination Load Case ในตัวอยางนี้คือ Load 4 และ Load 5 

< คําส่ังท่ีใชคือ : LOAD LIST 4 5 

< เลือกเมน ูCommand > Loading > Load List… 

< ในหนาตางท่ีแสดงขึ้นมาใหเลือก Load Case 4 และ 5 ดังในรูป 

  

กําหนดพารามิเตอร 
< ไปท่ีหนา Design > Steel เลือกมาตรฐานท่ีใชออกแบบ Current Code: AISC ASD 

จากหนาตางทางดานขวามือ 

< เปล่ียนหนวยเปน Centimeter – Kilogram 

< คลิกปุม Define Parameters… 
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< ในหนาตาง Design Parameters จะแสดงรายการพารามิเตอรมากมายใหเราเลือกกําหนด
ได ตัวแรกท่ีเราจะตองกําหนดคือ กําลังครากของเหล็ก เลือกรายการ FYLD ใสคา 2500 

kg/cm2 แลวคลิกปุม Add 

 



STAAD.Pro : Steel Design  7 - 7 
 

< ตอมาใหเลือกรายการ TRACK ซ่ึงเปนการกําหนดการพิมพผลการออกแบบ เลือกแบบ 2 
จะพิมพผลละเอียดท่ีสุด(เปลืองกระดาษท่ีสุด) 

 

< คลิกปุม Add แลวตามดวย Close หนาตาง Steel Design จะมีรายการเพ่ิมขึ้น 

 

< จะเห็นวาหนารายการ FYLD และ TRACK ยังเปนเครื่องหมายคําถามอยู ใหเลือกแตละ
รายการแลว Assign ใหทุกองคอาคาร 

 

คําสั่งออกแบบ : Design Commands 
< คลิกปุม Commands… ในหนาตาง Steel Design หนาตางคําส่ังออกแบบจะแสดง

ขึ้นมา  

< เลือกรายการ SELECT ซ่ึงจะเปนคําส่ังใหโปรแกรมเลือกหนาตัดท่ีเบาท่ีสุดท่ีผาน
ขอกําหนด 

< คลิกปุม Add แลวตามดวย Close 

< คลิกท่ีรายการ SELECT ท่ีเพ่ิมขึ้นมาซ่ึงยังมีเครื่องหมายคําถามหนารายการ 

< Assign ใหกับคานหมายเลข 2 โดยใช Use Cursor to Assign หรือเลือกคานแลวคลิก 
Assign to Selected Beams ก็ได 
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วิเคราะหอีกครั้ง 
< ในการสรางโมเดลเราไดมีการเลือกหนาตัดใหแกองคอาคาร ตอมาเม่ือทําการออกแบบเลือก

หนาตัดใหม โครงสรางจึงเปล่ียนไปทําใหตองวิเคราะหอีกครั้ง 

< ไปท่ีหนา Analysis/Print > Analysis คลิกตัวเลือก No Print  

< คลิกปุม Add และ Close จะปรากฏรายการ PERFORM ANALYSIS อีกรายการตอ
จากคําส่ัง SELECT ดังในรูป 
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ตรวจสอบการออกแบบ 
< หลังการวิเคราะหครั้งท่ีสอง จะทําใหแรงในองคอาคารชุดใหมตางไปเล็กนอยจากเดิม เรา

สามารถตรวจสอบดูวาโครงสรางปลอดภัยหรือไมตามขอกําหนด โดยใชคําส่ัง : 

CHECK  CODE  ALL 

< คลิกปุม Command ในหนาจอ Steel Design เลือกแถบ Check Code แลวคลิกปุม 
Add แลวตามดวย Close 

< เนื่องจากคําส่ัง CHECK CODE ตอง assign ใหทุก member วิธีการท่ีงายท่ีสุดคือ 
คลิกปุม Assign to View 

สั่งวิเคราะหและดูผลการคํานวณ 
< เลือกเมนู Analyze > Run Analysis… แลวคลิกปุม Run Analysis เพ่ือเริ่มการ

คํานวณ 

 

< ถาไมมีขอผิดพลาด 0 Error(s), 0 Warning(s) ใหคลิกเลือก View Output File แลว
กดปุม Done 
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ไฟลคําสั่ง : Portal2D 
 

STAAD PLANE 
START JOB INFORMATION 
ENGINEER DATE 14-Jun-08 
END JOB INFORMATION 
INPUT WIDTH 79 
UNIT METER MTON 
JOINT COORDINATES 
1 0 0 0; 2 0 4 0; 3 6 4 0; 4 6 0 0; 
MEMBER INCIDENCES 
1 1 2; 2 2 3; 3 3 4; 
DEFINE MATERIAL START 
ISOTROPIC STEEL 
E 2.09042e+007 
POISSON 0.3 
DENSITY 7.83341 
ALPHA 1.2e-005 
DAMP 0.03 
END DEFINE MATERIAL 
MEMBER PROPERTY KOREAN 
1 3 TABLE ST W300X200X56 
2 TABLE ST W350X250X69 
CONSTANTS 
MATERIAL STEEL ALL 
SUPPORTS 
1 FIXED 
4 PINNED 
LOAD 1 LOADTYPE None  TITLE DEAD LOAD 
SELFWEIGHT Y -1 
MEMBER LOAD 
2 UNI GY -1 
LOAD 2 LOADTYPE None  TITLE LIVE LOAD 
MEMBER LOAD 
2 UNI GY -2 
LOAD 3 LOADTYPE None  TITLE WIND LOAD 
JOINT LOAD 
2 FX 5 
LOAD COMB 4 1.2DL+1.6LL 
1 1.2 2 1.6  
LOAD COMB 5 0.75[DL+LL+W] 
1 0.75 2 0.75 3 0.75  
PERFORM ANALYSIS 
LOAD LIST 4 5 
UNIT CM KG 
PARAMETER 1 
CODE AISC 
FYLD 2500 ALL 
TRACK 2 ALL 
SELECT MEMB 2 
PERFORM ANALYSIS 
PARAMETER 2 
CODE AISC 
CHECK CODE ALL 
FINISH 
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ไฟลแสดงผล(บางสวน) 
< ผลจากคําส่ัง SELECT 
 

STAAD.PRO MEMBER SELECTION - (AISC 9TH EDITION) 
*********************************************** 

 
  |--------------------------------------------------------------------------| 
  |                                                    Y        PROPERTIES   | 
  |*************                                       |        IN  CMS UNIT | 
  |            *  |=============================|   ===|===     ------------ | 
  |MEMBER   2  *  |  KOREAN SECTIONS            |      |        AX =  88.20  | 
  |            *  | ST  W350X250X69             |      |   --Z  AY =  25.46  | 
  |DESIGN CODE *  |                             |      |        AZ =  39.91  | 
  | AISC-1989  *  ===============================   ===|===     SY = 248.19  | 
  |            *                                                SZ =1101.19  | 
  |            *  |<---LENGTH (M)=     6.00 --->|               RY =   5.92  | 
  |*************                                                RZ =  14.48  | 
  |                                                                          | 
  |                120.7 (KNS-METRE)                                         | 
  |PARAMETER        |               L4  L4                      STRESSES     | 
  |IN KNS  CMS      |                       L4                  IN NEWTON MMS| 
  |---------------  +                                           -------------| 
  | KL/R-Y= 101.37  |                                       L4  FA  =  88.81 | 
  | KL/R-Z=  41.43  +           L4                              fa  =   2.42 | 
  | UNL   = 600.00  |L4                         L4              FCZ = 122.63 | 
  | CB    =   1.00  +                                           FTZ = 147.10 | 
  | CMY   =   0.85  |       L5                                  FCY = 183.87 | 
  | CMZ   =   0.85  +   L5                              L5      FTY = 183.87 | 
  | FYLD  =  24.52  |                               L4          fbz = 109.60 | 
  | NSF   =   1.00  +---+---+---+---+---+---+---+---+---+---|   fby =   0.00 | 
  | DFF   =   0.00  22.2                                        Fey = 102.73 | 
  | dff=      0.00               ABSOLUTE MZ ENVELOPE           Fez = 615.05 | 
  |                                 (WITH LOAD NO.)             FV  =  98.07 | 
  |                                                             fv  =   1.06 | 
  |                                                                          | 
  |                      MAX FORCE/ MOMENT SUMMARY  (KNS-METRE)              | 
  |                      -------------------------                           | 
  |                                                                          | 
  |                AXIAL      SHEAR-Y    SHEAR-Z    MOMENT-Y    MOMENT-Z     | 
  |                                                                          | 
  |      VALUE      21.3       134.6        0.0         0.0       120.7      | 
  |   LOCATION       0.0         6.0        0.0         0.0         3.0      | 
  |    LOADING         4           4          0           0           4      | 
  |                                                                          | 
  |**************************************************************************| 
  |*                                                                        *| 
  |*                         DESIGN SUMMARY  (KNS-METRE)                    *| 
  |*                         --------------                                 *| 
  |*                                                                        *| 
  |*       RESULT/     CRITICAL COND/     RATIO/         LOADING/           *| 
  |         FX              MY             MZ           LOCATION             | 
  |        ======================================================            | 
  |          PASS        AISC- H1-3       0.921              4               | 
  |         21.31 C          0.00      -120.69             3.00              | 
  |*                                                                        *| 
  |**************************************************************************| 
  |                                                                          | 
  |--------------------------------------------------------------------------| 
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< ผลจากคําส่ัง CHECK CODE 
 

                        
STAAD.PRO CODE CHECKING - (AISC 9TH EDITION) 
******************************************** 

 
 
  |--------------------------------------------------------------------------| 
  |                                                    Y        PROPERTIES   | 
  |*************                                       |        IN  CMS UNIT | 
  |            *  |=============================|   ===|===     ------------ | 
  |MEMBER   2  *  |  KOREAN SECTIONS            |      |        AX =  88.20  | 
  |            *  | ST  W350X250X69             |      |   --Z  AY =  25.46  | 
  |DESIGN CODE *  |                             |      |        AZ =  39.91  | 
  | AISC-1989  *  ===============================   ===|===     SY = 248.19  | 
  |            *                                                SZ =1101.19  | 
  |            *  |<---LENGTH (M)=     6.00 --->|               RY =   5.92  | 
  |*************                                                RZ =  14.48  | 
  |                                                                          | 
  |                120.7 (KNS-METRE)                                         | 
  |PARAMETER        |               L4  L4                      STRESSES     | 
  |IN KNS  CMS      |                       L4                  IN NEWTON MMS| 
  |---------------  +                                           -------------| 
  | KL/R-Y= 101.37  |                                       L4  FA  =  88.81 | 
  | KL/R-Z=  41.43  +           L4                              fa  =   2.42 | 
  | UNL   = 600.00  |L4                         L4              FCZ = 122.63 | 
  | CB    =   1.00  +                                           FTZ = 147.10 | 
  | CMY   =   0.85  |       L5                                  FCY = 183.87 | 
  | CMZ   =   0.85  +   L5                              L5      FTY = 183.87 | 
  | FYLD  =  24.52  |                               L4          fbz = 109.60 | 
  | NSF   =   1.00  +---+---+---+---+---+---+---+---+---+---|   fby =   0.00 | 
  | DFF   =   0.00  22.2                                        Fey = 102.73 | 
  | dff=      0.00               ABSOLUTE MZ ENVELOPE           Fez = 615.05 | 
  |                                 (WITH LOAD NO.)             FV  =  98.07 | 
  |                                                             fv  =   1.06 | 
  |                                                                          | 
  |                      MAX FORCE/ MOMENT SUMMARY  (KNS-METRE)              | 
  |                      -------------------------                           | 
  |                                                                          | 
  |                AXIAL      SHEAR-Y    SHEAR-Z    MOMENT-Y    MOMENT-Z     | 
  |                                                                          | 
  |      VALUE      21.3       134.6        0.0         0.0       120.7      | 
  |   LOCATION       0.0         6.0        0.0         0.0         3.0      | 
  |    LOADING         4           4          0           0           4      | 
  |                                                                          | 
  |**************************************************************************| 
  |*                                                                        *| 
  |*                         DESIGN SUMMARY  (KNS-METRE)                    *| 
  |*                         --------------                                 *| 
  |*                                                                        *| 
  |*       RESULT/     CRITICAL COND/     RATIO/         LOADING/           *| 
  |         FX              MY             MZ           LOCATION             | 
  |        ======================================================            | 
  |          PASS        AISC- H1-3       0.921              4               | 
  |         21.31 C          0.00      -120.69             3.00              | 
  |*                                                                        *| 
  |**************************************************************************| 
  |                                                                          | 
  |--------------------------------------------------------------------------| 
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คํานวณตัวคูณความยาวประสิทธิผลอัตโนมัต ิ
< ตั้งแตเวอรช่ัน 2006 โปรแกรมไดเพ่ิมความสามารถใหมในการคํานวณตัวคูณความยาว

ประสิทธิผล (Effective Length Factor, KY) ตามมาตรฐาน AISC ASD 

< กลับมาท่ีโมเดล Portal2D เดิมของเรา สมมุติวาเราจะลองใชความสามารถนี้กับเสา
หมายเลข 3 ไปท่ีหนา Design > Steel 

< คําส่ัง KY ซ่ึงเปนการกําหนดพารามิเตอร ตองถูกแทรกอยางถูกขั้นตอน ตําแหนงท่ีตองการ
คือหลังคําส่ัง FYLD 2500  

< ใหคลิกเลือกเสาหมายเลข  3 กอน แลวคลิกรายการ  FYLD จากนั้นกดปุม Define 
Parameters 

 

< ในหนาตาง Define Parameters คลิกเลือกรายการ KY หรือ KZ โปรแกรมจะใหเรา
กําหนดคาความยาวประสิทธิผลของเสา ในเวอรช่ันเกาผูใชจะตองกําหนดเอง แตในเวอร
ช่ันใหมส่ิงท่ีเพ่ิมขึ้นมาคือมีปุม Calculate  

< เม่ือกดปุม Calculate โปรแกรมจะถามวาเปนโครงแบบ braced หรือ unbraced ให
คลิกปุม No เลือกเปน unbraced 
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< คา KY จะถูกคํานวณแสดงออกมา ลองเลือกแบบ braced เพ่ือดูความแตกตาง 

< ตามปกติคําส่ังนี้จะถูกกําหนดตอจาก  FYLD ก็ทําเหมือนเดิมคือคลิกปุม Add แลว 
Assign ใหองคอาคารท่ีตองการ แตในตัวอยางนี้เปนการแทรกคําส่ัง ถาเราคลิก Add 
รายการจะถูกเพ่ิมตอทายทําใหผิดขั้นตอน ดังนั้นจึงตองคลิกเลือกชอง After Current ซ่ึง
อยูติดกับปุม Add แลวจึงคลิกปุม Add แลวตามดวย Close 
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< รายการ KY จะถูกแทรกเขาไป ใหคลิกเลือกแลว Assign ใหเสาหมายเลข 3 

 

< ตอมาเราควรแกไขคําส่ัง SELECT ใหเลือกหนาตัดใหเสาหมายเลข 3 ดวย คลิกเลือก
รายการ SELECT จะเห็นคานหมายเลข 2 ถูกเลือกอยู 

< ใช Use Cursor to Assign คลิกปุม Assign แลวไปคลิกท่ีคานหมายเลข 3 สังเกตใน
ชอง Assign To Edit List จะเพ่ิมเปน 2 3 

 

< การแกไขเชนนี้ในไฟลคําส่ังจะเร็วกวามาก เปดดูในไฟลคําส่ังจะเห็นสวนท่ีเพ่ิมขึ้นซ่ึงเรา
อาจพิมพลงในไฟลคําส่ังเองเลยก็ได 
... 
PARAMETER 1 
CODE AISC 
FYLD 2500 ALL 
KY 1.85343 MEMB 3 
TRACK 2 ALL 
SELECT MEMB 2 3 
PERFORM ANALYSIS 
PARAMETER 2 
CODE AISC 
CHECK CODE ALL 
FINISH 

< ส่ัง Analyze > Run Analysis… ดูความแตกตางในไฟลแสดงผลระหวางเสาหมายเลข 
1 และ 3 จะพบวา 

องคอาคาร KL/R-Y FA 

1 85.09 101.87 

3 150.77 46.44 
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ออกแบบแผนรองฐานเสาใน STAAD.etc  
STAAD.etc เปนโมดูลเพ่ิมเติมในการออกแบบสวนประกอบโครงสรางไดแก ฐานราก แผน
เหล็กรองฐานเสา และการออกแบบพ้ืน 

< หลังทําการวิเคราะหเสร็จส้ินแลว ใหเลือกแถบ Component Design หรือเลือกเมนู 
Mode > Interactive Design > Component Design หนาตางของแถบ 
Component Design จะแสดงขึ้นมาโดยมีใหเลือกคํานวณ 3 โมดูลดังในรูป 

 

< คลิกเลือกไอคอน Base Plate แลวลากไปยังจุดตอท่ีตองการใหออกแบบในโครงสราง 

 

< หนาตาง Staad.etc Interactive Design จะแสดงขึ้นมาดังในรูปขางลาง กรอกขอมูลท่ี
ตองการแลวคลิก OK 
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< หนาตางผลการออกแบบจะแสดงขึ้นมามีสามแถบใหเลือกดูคือ แถบ Results 
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< แถบ Calculations แสดงรายการคํานวณ 
 

 
 

< และแถบ Output Drawing แสดงแบบรายละเอียด 
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ออกแบบองคอาคารเหล็กใน STAAD.etc > Steel Design  
การออกแบบใน STAAD.etc จะเปนแบบปฏิสัมพัทธ ซ่ึงตางจากเดิมท่ีใชคําส่ังไวลวงหนา
แลวส่ังรันการคํานวณ ทําใหผูใชสามารถปรับเปล่ียนแกไขไดสะดวกรวดเร็วขึ้น 

< หลังทําการวิเคราะหเสร็จส้ินแลว ใหเลือกแถบ Steel Design หรือเลือกเมนู Mode > 

Interactive Design > Steel Design หนาตางของแถบ Steel Design จะแสดงขึ้นมา 

< เริ่มโดยใหเราเลือกกรณีบรรทุกท่ีจะนํามาพิจารณาในการออกแบบ คลิกปุม New 

Envelope เลือกกรณีท่ี 4 และ 5 ดังในรูป 

 

< ไปท่ีหนา Member Design > Member Setup เพ่ือกําหนดองคอาคารท่ีจะทําการ
ออกแบบ คลิกเลือกคานหมายเลข 2 

< เลือกเมนู Member Design > Physical Members > Form Members 
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< ไปยังหนา Member Design > Restraints ตรวจสอบและปรับแกการยึดรั้งองคอาคาร 

< ไปยังหนา Briefs/Groups เพ่ือกําหนดคําส่ังออกแบบ และจัดกลุมองคอาคารท่ีจะ
ออกแบบ 

< คลิกปุม New Brief ในหนาตาง Design Briefs จะได 

 

< กําหนดคา FYLD = 2500 kg/cm2 แลวคลิก OK จะมีรายการแสดงขึ้นมา 

 

< ตอมาคลิกปุม New Design Grp ในหนาตาง Design Groups จะได 
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< คลิกปุม Add เลือกรายการ M1 เขามาในกลุม คลิกปุม OK จะมีรายการแสดงขึ้นมา 

 

< เลือกเมน ูMember Design > Perform Group Design จะมีใหเลือกสามคําส่ังคือ 

 

< ลองเลือกดูทีละคําส่ัง แลวดูผลการคํานวณท่ีแสดงออกมา เริ่มจาก Design Result Table 

ในหนา Member Design > Results/Reports 

 

< เลือกองครายการในตารางแลวเลือกเมนู Member Design > View Design 

Calculation เพ่ือแสดงรายการคํานวณ 

    
 Design Of Member No. 1 As Per AISC   
    
 Input Parameters   
    
 Member Section   W350X250X69              
     
 Cross Sectional Area Ax (cm 2)   88.20 
 Shear Area Along Y Axis Ay (cm 2)   3.95 
 rz (cm)    14.48 
 ry (cm)    5.92 
 Section Modulus About Z Axis - Tension Edge Stz (cm 3)   1101.19 
 Section Modulus About Z Axis - Compression Edge Szz (cm 3)   1101.19 
 Section Modulus About Y Axis - Tension Edge Sty (cm 3)   248.19 
 Section Modulus About Y Axis - Compression Edge Syy (cm 3)   248.19 
 Unsupported Length - Z Axis For Slenderness Check Lz (cm)   600.00 
 Unsupported Length - Y Axis For Slenderness Check Ly (cm)   600.00 
 Effective Length For Allowable Bending Stress Calculation Unl (cm)  600.00 
 Yield Stress fy (MPa)   245.00 
 Ultimate tensile strength fu (MPa)   414.00 
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 Allowable Ratio For Interaction Check   1.00 
    
 Design Forces   
    
 Combined Axial Force & Bi-axial moment   
 Axial Load Fx (kg )   2277.41 
 Torsion Mx (kg cm)   0.00 
 Z Axis Moment Mz (kg cm)   -1204327.13 
 Y Axis Moment My (kg cm)   0.00 
 Critical Loadcase No.   4 
 Critical Section (cm)   300.00 
 Beam No.   2 
    
 No Shear Force Developed Along Z Axis   
    
 Shear Along Y Axis   
 Shear Along Y Axis Fy (kg )    13775.34 
 Critical Loadcase No.   4 
 Critical Section (cm)   600.00 
 Beam No.   2 
    
 Details Of Calculation   
    
 Slenderness Checking   
    
 Lez (cm)    600.00 
 Ley (cm)    600.00 
 Lez / rz  41.43 
 Ley / ry  101.37 
 Actual Slenderness Ratio   101.37 
 Allowable Slenderness Ratio   200.00 
 Status   SAFE 
    
 Check Against Axial Compression And Bi-Axial Bending   
    
 Actual Compressive Stress fc (MPa)    
 =Fx / Ax  2.53 
    
 Calculation Of Allowable Axial Compressive Stress :   
    
 E (MPa)   205000.95 
 Critical ratio L / r (Maximum Of Lz / rz and Ly / ry )   101.37 
 Qa ( Due To Web Slenderness ) = Effective Area / Actual Area   1.00 
 Stress Reduction Factor Qs   1.00 
 Cc    
 =( 2 p 2 E / ( Q a Q s fy ))0.5  128.47 
 L / r is less than Cc   
 F1a (ksi)    
 =Q a Q s fy ( 1 - 0.5 * ( L / r * Cc)2 )   24.49 
 F2a   
 =1.667 + 0.375 * L / r * Cc - 0.125 * ( L / r * Cc )3  1.90 
 Allowable Axial Compressive Stress fc_allowable (MPa)    
 =F1a / F2a   88.80 
    
 Bending about Z Axis :   
    
 Actual Bending Compressive Stress - Z Axis fcz (MPa)    
 =Mz / Szz  107.25 
    
 No Bending Moment Developed Along Y Axis   
    
 Calculation of Allowable Bending Compressive Stress About Z and Y Axis :   
    
 Limiting Width - Thickness Ratio = 0.5 * bf / tf  10.37 
 Limiting Width - Thickness Ratio is less than 65 / fy0.5. The section is compact. 
  
 Lc   
 =Min ( 76bf / fy0.5, 20000 / (( d / Af ) fy )) (in)    124.94 
 Laterally unsupported length of the compression flange, Unl, is greater than Lc 
  
 rT (in)    
 =(( 0.5Iy- 1/12 * 2/3 * ( d/2 - tf ) tw3 ) / ( 0.5Ax- 2/3 * ( d/2 - tf ) tw ))0.5 
 2.59 
 lrt =Unl / rT  91.32 
 Cb  1.00 
 lrT is greater than 319.374( Cb / fy)0.5and lrT is less than 714.143( Cb / fy)0.5 
  
 Allowable Bending Compressive Stress - Z Axis fbz_allowable (ksi)    
 =(2/3 - fy ( lrt )2 / 1530000Cb ) )fy  16.83 
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 Maximum Allowable Bending Compressive Stress - Z Axis (ksi) fbz_max =0.6fy 
 21.34 
 fbz_allowable is less than fbz_max   
 Area Of Compression Flange Af ( sq. inch )   4.63 
 For any value of lrt, fbz (ksi)    
 = 12000Cb Af / (Unl*d)   17.79 
 Allowable Bending Compressive Stress - Z Axis fcz_allowable (ksi)    
 = ( Maximum of fbz and fbz_allowable )   17.79 
 Allowable Bending Compressive Stress - Y Axis fby_allowable (ksi)    
 =fy (1.075 - 0.005bf fy0.5 / 2tf )   26.67 
 Maximum Allowable Bending Compressive Stress - Y Axis (ksi) fby_max =0.75fy 
 26.67 
 Minimum Allowable Bending Compressive Stress - Y Axis (ksi) fby_min =0.6fy 
 21.34 
 fby_allowable is less than fby_max and greater than fby_min   
 Allowable Bending Compressive Stress - Y Axis fcy_allowable (ksi)   26.67 
 Stress Reduction Factor Qs   1.00 
 fb_max (ksi)    
 =0.6Qsfy  21.34 
 Allowable Bending Compressive Stress ( Modified ) - Z Axis fcz_allowable (MPa)  
  
 = Max ( fcz_allowable calculated above , fb_max )   122.63 
 Allowable Bending Compressive Stress ( Modified ) - Y Axis fcy_allowable (MPa)  
  
 = Max ( fcy_allowable calculated above , fb_max )   183.87 
    
 Interaction Checking   
    
 Factor by which all allowable stresses/capacities to be multiplied   1.00 
 Interaction ratio    
 =fc / fc_allowable + fcz / fcz_allowable + fcy / fcy_allowable  0.90 
 Status   SAFE 
    
 Check Against Shear   
    
 Shear Stress Along Y Axis Vy (MPa)    
 =Fy / Ay  53.07 
 Vf (MPa)    
 =0.4fy  98.07 
 f    
 =( dw - 2tf ) / tw*fy0.5  232.56 
 f is less than 380.   
 Allowable Shear Stress V_allowable (MPa)    
 =0.4fy  98.07 
 Interaction ratio (Along Y Axis)    
 =Vy / V_allowable  0.54 
 
 Status   SAFE 

    
 

 



STAAD.Pro : Concrete Design  8 - 1 
 

 
8 

 

การออกแบบคอนกรีตเสริมเหล็ก 
 

เนื้อหาที่จะกลาวถึงในบทนี้ 
n สรางโมเดล RC Frame 

n กําหนดรายการน้ําหนักบรรทุก 

n กําหนดพารามิเตอร 
n คําส่ังออกแบบ 

n วิเคราะหและออกแบบ 

n ตรวจสอบการออกแบบ 

n ส่ังวิเคราะหและดูผลการคํานวณ 

n ไฟลคําส่ัง และไฟลแสดงผล 

n ออกแบบฐานรากใน STAAD.etc > Component Design 

n ออกแบบองคอาคารโดยใช RC Designer 

n RC Designer > Beam Design 

n RC Designer > Column Design 

n RC Designer > Slab Design 
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สรางโมเดล RC Frame 
< ในบทนี้เราจะกลาวถึงการออกแบบคอนกรีตเสริมเหล็ก โดยสรางโมเดลใหมดังในรูป รับ

น้ําหนักบรรทุกคงท่ี น้ําหนักบรรทุกจร และแรงลมดังแสดงในรูปขางลาง 

 

< เริ่มโปรแกรมใหม กอนสรางโมเดลใหม ตรวจสอบหนวยกอนวาเปนระบบเมตริกหรือไม 
เลือกเมน ูFile > Configure… เลือก Base Unit = Metric คลิก Accept 

< เริ่มสรางโมเดลใหม เลือกเมนู File > New เลือกโครงสรางแบบ Space ตั้งช่ือไฟลวา 
RCFrame ใชหนวย Meter – Metric Ton 

< สรางโมเดลเปนโครงกวาง 6 เมตร สูง 3.5 เมตร ในระนาบ X-Y กอนดังในรูปขางลาง 

 

< คลิกเลือกองคอาคารหมายเลข 1 และ 2 ส่ัง Circular Repeat ใสขอมูลตามในรูปขางลาง 

3.5 m 

1 

2 

4 

3 

1 

2 

3 

5 

4 

5 

6 

6 m 
6 m Y 

X 

Z 
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< จะไดโมเดลสามมิตดิังในรูป 
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< เปล่ียนหนวยความยาวจาก m เปน cm หรือใชคําส่ัง UNIT CM MTON 

< กําหนดหนาตัดสําหรับองคอาคารคอนกรีตเสริมเหล็กจะเปนหนาตัดส่ีเหล่ียม ไปท่ีหนา 
General > Property คลิกปุม Define… ในหนาตาง Properties เลือกรายการ 
Rectangular ใสคา YD = 30 cm และ ZD = 30 cm คลิกไมเลือก Material ดังในรูป 

 

< สรางหนาตัดท่ีสองขนาด YD = 50 cm และ ZD = 30 cm ตามขั้นตอนเดิม 

 

< กําหนดหนาตัด 1 : Rect 0.30x0.30 ใหเสาท้ังหมด 

< กําหนดหนาตัด 2 : Rect 0.50x0.30 ใหคานท้ังหมด 
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< เปล่ียนหนวยความยาวจากเปน cm และแรงเปน kg 

< กําหนดคุณสมบัติวัสดุ เลือกเมนู Command > Material Constants > Elasticity… 

ใสคา 233,928 kg/cm2 

 

< เปล่ียนหนวยความยาวเปน m แลวใสคา Density = 2,400 kg/m3 

< กําหนดคา Poisson’s Ratio = 0.17 ตรวจดูไฟลคําส่ังรายการท่ีเพ่ิมขึ้นคือ 

UNIT CM KG 
CONSTANTS 
E 233928 ALL 
DENSITY 0.0024 ALL 
POISSON 0.17 ALL 

< ไปท่ีหนา General > Support สรางจุดรองรับแบบ Fixed แลวกําหนดใหทุกฐานเสา 
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< ไปท่ีหนา General > Load เพ่ือกําหนดน้ําหนักบรรทุก เปล่ียนหนวยเปน ความยาวเปน 
m และแรงเปน kg 

< สรางน้ําหนักบรรทุกกรณี 1 เปน DEAD LOAD เพ่ิมน้ําหนักตัวเอง Self Weight และ 
Uniform Load ทิศทาง GY ขนาด -400 kg/m 

< สรางน้ําหนักบรรทุกกรณี 2 เปน LIVE LOAD เพ่ิมน้ําหนัก Uniform Load ทิศทาง 
GY ขนาด -600 kg/m 

< สรางน้ําหนักบรรทุกกรณี 3 เปน WIND LOAD เพ่ิมน้ําหนัก Uniform Load ทิศทาง 
Gx ขนาด 300 kg/m 

< กําหนด Uniform Load ของ DEAD LOAD และ LIVE LOAD ใหแกคาน และ 
Uniform Load ของ WIND LOAD ใหแกเสาดังแสดงในรูป 
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< สรางน้ําหนักบรรทุกกรณี 4 และ 5 แตคราวนี้เราจะไมใช Load Combination แบบท่ี
เคยทํามา แตจะใช REPEAT LOAD เนื่องจากจะทําการวิเคราะหแบบ P-Delta ซ่ึงจะ
คิดผลของแรงกระทําดานขางและแรงในแนวดิ่งพรอมกัน 

< สรางน้ําหนักบรรทุกกรณี 4 เหมือนกรณีท่ี 1 – 3 คือเปนแบบ Primary Load ตั้งช่ือ 
1.2DL+1.6LL 

< เลือกรายการน้ําหนักบรรทุกกรณี 4 คลิกปุม Add… เลือกรายการ Repeat Load 

 

< สรางน้ําหนักบรรทุกกรณ ี5 เปน Primary Load ตั้งช่ือ 0.75[DL+LL+W] 

 

< รายการในหนาตาง Load จะเปนดังในรูปขางลาง 
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< ไปท่ีหนา Analysis/Print คลิกแถบ PDelta Analysis เลือก Print Option = No 

Print คลิกปุม Add 

< ลองรันการวิเคราะหดูวามีขอผิดพลาดหรือไมกอนเริ่มการออกแบบ เลือกเมนู Analyze > 

Run Analysis… เลือก STAAD Analysis แลวคลิกปุม Run Analysis 

กําหนดรายการน้ําหนักบรรทุก 
< ในหัวขอนี้เราจะเริ่มกลาวถึงคําส่ังท่ีใชในการออกแบบโครงสรางเหล็ก คําส่ังแรกคือ 

LOAD LIST เปนการบอกโปรแกรมวาจะออกแบบเพ่ือรับน้ําหนักบรรทุกกรณีไหนบาง 
ซ่ึงโดยท่ัวไปจะเปน Combination Load Case ในตัวอยางนี้คือ Load 4 และ Load 5 

< เลือกเมนู Command > Loading > Load List… เลือก Load Case 4 และ 5  
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กําหนดพารามิเตอร 
< ตัวแปรตางในการออกแบบคอนกรีตเสริมเหล็กนั้น ผูใชสามารถท่ีจะกําหนดไดเชน เกรด

ของคอนกรีตหรือขนาดเหล็กเสนใหญท่ีสุดท่ีอยากจะใช คาพารามิเตอรกําหนดคาโดยใช
คําส่ังดังนี้ 
UNIT CM KG 
CODE ACI 
CLT 2.5 ALL 
CLB 3 ALL 
CLS 2.5 ALL 
FC 240 ALL 
FYMAIN 4000 ALL 
TRACK 1 ALL 

< ไปท่ีหนา Design > Concrete เลือกมาตรฐานท่ีใชออกแบบ Current Code: ACI 

จากหนาตางทางดานขวามือ 

< เปล่ียนหนวยเปน Centimeter – Kilogram แลวคลิกปุม Define Parameters… 

< ในหนาตาง Design Parameters จะแสดงรายการพารามิเตอรใหเลือก คลิกแถบ Clt 
ระยะหุมดานบน ใสคา 2.5 cm คลิก Add 

< ใสคาท่ีเหลือจนครบ แลวกดปุม Close หนาจอ Concrete Design จะแสดงดังรูป 

 
< เครื่องหมายคําถามแสดงวายังไมถูก Assign ใหองคอาคาร เลือกวิธี Assign To View 

แลวกดปุม Assign 
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กําหนดคําสั่งออกแบบ 
คําส่ังออกแบบท่ีเราจะใชคือการออกแบบคานสําหรับ member 2 และ 5 และออกแบบเสา
สําหรับ member 1, 3 และ 4 คําส่ังท่ีใชคือ 
DESIGN BEAM 2 5 
DESIGN COLUMN 1 3 4 

< คําส่ังออกแบบจะถูกสรางไดจากหนาจอ Concrete Design โดยกดปุม Command… 

< เม่ือหนาจอ Design Command แสดงขึ้นมาใหเลือกแถบ Design Beam คลิกปุม Add 
ตอมาเลือกแถบ Design Column คลิกปุม Add แลวจึงคลิกปุม Close หนาจอจะเปนดัง
ในรูป 

 

< คลิกรายการ DESIGN BEAM  แลว Assign ใหกับคาน 2, 5 และรายการ DESIGN 

COLUMN แลว Assign ใหกับเสา 1, 3, และ 4 

วิเคราะหและออกแบบ 
< เลือกเมนู Analysis > Run Analysis… เม่ือหนาจอแสดงขึ้นมาใหเลือก STAAD 

Analysis แลวคลิกปุม Run Analysis 

< ขณะทําการคํานวณจะมีหลายขอความแสดงขึ้นมา หากไมมีขอผิกพลาด เม่ือเสร็จแลวให
เลือก View Output File แลวคลิกปุม Done  
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ไฟลคําสั่ง : RCFrame 
 

STAAD SPACE 
START JOB INFORMATION 
ENGINEER DATE 16-Jun-08 
END JOB INFORMATION 
INPUT WIDTH 79 
UNIT METER MTON 
JOINT COORDINATES 
1 0 0 0; 2 0 3.5 0; 3 6 3.5 0; 4 6 0 0; 5 6 0 6; 6 6 3.5 6; 
MEMBER INCIDENCES 
1 1 2; 2 2 3; 3 3 4; 4 5 6; 5 6 3; 
UNIT CM MTON 
MEMBER PROPERTY AMERICAN 
1 3 4 PRIS YD 30 ZD 30 
2 5 PRIS YD 50 ZD 30 
UNIT CM KG 
DEFINE MATERIAL START 
ISOTROPIC MATERIAL1 
E 233928 
POISSON 0.17 
DENSITY 0.0024 
END DEFINE MATERIAL 
CONSTANTS 
MATERIAL MATERIAL1 ALL 
SUPPORTS 
1 4 5 FIXED 
UNIT METER KG 
LOAD 1 LOADTYPE None  TITLE DEAD LOAD 
SELFWEIGHT Y -1 
MEMBER LOAD 
2 5 UNI GY -400 
LOAD 2 LOADTYPE None  TITLE LIVE LOAD 
MEMBER LOAD 
2 5 UNI GY -600 
LOAD 3 LOADTYPE None  TITLE WIND LOAD 
MEMBER LOAD 
1 4 UNI GX 300 
LOAD 4 LOADTYPE None  TITLE 1.2DL+1.6LL 
REPEAT LOAD 
1 1.2 2 1.6  
LOAD 5 LOADTYPE None  TITLE 0.75[DL+LL+W] 
REPEAT LOAD 
1 0.75 2 0.75 3 0.75  
PDELTA ANALYSIS 
LOAD LIST 4 5 
START CONCRETE DESIGN 
CODE ACI 
UNIT CM KG 
CLT 2.5 ALL 
CLB 3 ALL 
CLS 2.5 ALL 
FC 240 ALL 
FYMAIN 4000 ALL 
TRACK 1 ALL 
DESIGN BEAM 2 5 
DESIGN COLUMN 1 3 4 
END CONCRETE DESIGN 
FINISH 



STAAD.Pro : Concrete Design  8 - 12 
 

ไฟลแสดงผล(บางสวน) 
 

=========================================================================           
BEAM  NO.     2 DESIGN RESULTS - FLEXURE PER CODE ACI 318-02 

 
 LEN -  6000. MM  FY -  392.  FC -  24.  MPA, SIZE -  300. X  500. MMS  
 
 LEVEL    HEIGHT     BAR INFO       FROM          TO           ANCHOR 
           (MM)                      (MM)         (MM)         STA  END 
 ______________________________________________________________________ 
  
   1        49.          5 - 12MM         0.           5795.         YES  NO 
 |----------------------------------------------------------------| 
 |   CRITICAL POS MOMENT=     58.48 KN-MET  AT  3000.MM, LOAD    4| 
 |   REQD STEEL=   476.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 
 |   MAX/MIN/ACTUAL BAR SPACING=   295./   37./   53. MMS         | 
 |   REQD. DEVELOPMENT LENGTH =   396. MMS                        | 
 |----------------------------------------------------------------| 
  
     Cracked Moment of Inertia Iz at above location =    70612.0 cm^4 
  
  2        456.     5 - 12MM         0.          456.        YES  NO 
 |----------------------------------------------------------------| 
 |   CRITICAL NEG MOMENT=     23.05 KN-MET  AT     0.MM, LOAD    4| 
 |   REQD STEEL=   481.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 
 |   MAX/MIN/ACTUAL BAR SPACING=   295./   37./   53. MMS         | 
 |   REQD. DEVELOPMENT LENGTH =   396. MMS                        | 
 |----------------------------------------------------------------| 
  
     Cracked Moment of Inertia Iz at above location =    72320.8 cm^4 
  
  3        456.     5 - 12MM      4794.         6000.        NO   YES 
 |----------------------------------------------------------------| 
 |   CRITICAL NEG MOMENT=     25.22 KN-MET  AT  6000.MM, LOAD    4| 
 |   REQD STEEL=   481.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 
 |   MAX/MIN/ACTUAL BAR SPACING=   295./   37./   53. MMS         | 
 |   REQD. DEVELOPMENT LENGTH =   396. MMS                       | 
 |----------------------------------------------------------------| 
  
     Cracked Moment of Inertia Iz at above location =    72320.8 cm^4 
  
  
          B E A M  N O.     2 D E S I G N  R E S U L T S - SHEAR 
  
 
    AT START SUPPORT - Vu=   46.55 KNS  Vc=  198.11 KNS  Vs=    0.00 KNS 
    Tu=    3.24 KN-MET  Tc=    4.3 KN-MET  Ts=    0.0 KN-MET  LOAD     4 
                       STIRRUPS ARE NOT REQUIRED. 
    AT END   SUPPORT - Vu=   47.27 KNS  Vc=  198.11 KNS  Vs=    0.00 KNS 
    Tu=    3.24 KN-MET  Tc=    4.3 KN-MET  Ts=    0.0 KN-MET  LOAD     4 
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ไฟลแสดงผล(บางสวน) 
 

  ___   2J____________________  6000X 300X  500_____________________   3J____ 
 |                                                                           | 
 ||====                                                      ===============|| 
 | 5No12 H 456.   0.TO  456                         5No12 H 456.4794.TO 6000 | 
 |                                                                           | 
 | 5No12 H  49.   0.TO 5795                                                  | 
 ||========================================================================  | 
 |                                                                           | 
 |___________________________________________________________________________| 
  _________    _________    _________    _________    _________     _________ 
 |         |  |         |  |         |  |         |  |         |   |         | 
 |  ooooo  |  |         |  |         |  |         |  |  ooooo  |   |  ooooo  | 
 | 5#12    |  |         |  |         |  |         |  | 5#12    |   | 5#12    | 
 |         |  |         |  |         |  |         |  |         |   |         | 
 | 5#12    |  | 5#12    |  | 5#12    |  | 5#12    |  | 5#12    |   |         | 
 |  ooooo  |  |  ooooo  |  |  ooooo  |  |  ooooo  |  |  ooooo  |   |         | 
 |         |  |         |  |         |  |         |  |         |   |         | 
 |_________|  |_________|  |_________|  |_________|  |_________|   |_________| 
  
   ===================================================================== 
  
          BEAM  NO.     5 DESIGN RESULTS - FLEXURE PER CODE ACI 318-02 
  
   LEN -  6000. MM  FY -  392.  FC -  24.  MPA, SIZE -  300. X  500. MMS 
  
   LEVEL    HEIGHT     BAR INFO       FROM          TO           ANCHOR 
             (MM)                     (MM)         (MM)         STA  END 
   _____________________________________________________________________ 
  
 
     1         49.     5 - 12MM         0.         5795.        YES  NO 
   |----------------------------------------------------------------| 
   |   CRITICAL POS MOMENT=     58.48 KN-MET  AT  3000.MM, LOAD    4| 
   |   REQD STEEL=   476.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 
   |   MAX/MIN/ACTUAL BAR SPACING=   295./   37./   53. MMS         | 
   |   REQD. DEVELOPMENT LENGTH =   396. MMS                        | 
   |----------------------------------------------------------------| 
  
     Cracked Moment of Inertia Iz at above location =    70612.0 cm^4 
  
     2        456.     5 - 12MM         0.          456.        YES  NO 
   |----------------------------------------------------------------| 
   |   CRITICAL NEG MOMENT=     23.05 KN-MET  AT     0.MM, LOAD    4| 
   |   REQD STEEL=   481.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 
   |   MAX/MIN/ACTUAL BAR SPACING=   295./   37./   53. MMS         | 
   |   REQD. DEVELOPMENT LENGTH =   396. MMS                        | 
   |----------------------------------------------------------------| 
  
     Cracked Moment of Inertia Iz at above location =    72320.8 cm^4 
  
     3        456.     5 - 12MM      5294.         6000.        NO   YES 
   |----------------------------------------------------------------| 
   |   CRITICAL NEG MOMENT=     25.22 KN-MET  AT  6000.MM, LOAD    4| 
   |   REQD STEEL=   481.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 
   |   MAX/MIN/ACTUAL BAR SPACING=   295./   37./   53. MMS         | 
   |   REQD. DEVELOPMENT LENGTH =   396. MMS                        | 
   |----------------------------------------------------------------| 
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ออกแบบฐานรากใน STAAD.etc > Component Design  
STAAD.etc เปนโมดูลเพ่ิมเติมในการออกแบบสวนประกอบโครงสรางไดแก ฐานราก แผน
เหล็กรองฐานเสา และการออกแบบพ้ืน 

< หลังทําการวิเคราะหเสร็จส้ินแลว ใหเลือกแถบ Component Design หรือเลือกเมนู 
Mode > Interactive Design > Component Design หนาตางของแถบ 
Component Design จะแสดงขึ้นมาโดยมีใหเลือกคํานวณ 3 โมดูลดังในรูป 

 

< คลิกเลือกไอคอน Footing แลวลากไปยังจุดตอท่ีตองการใหออกแบบในโครงสราง 
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< หนาตาง Staad.etc Interactive Design จะแสดงขึ้นมาดังในรูปขางลาง กรอกขอมูลท่ี
ตองการแลวคลิก OK 
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< หนาตางผลการออกแบบจะแสดงขึ้นมามีสามแถบใหเลือกดูคือ แถบ Results 

 

< แถบ Calculations แสดงรายการคํานวณ 

 

< และแถบ Output Drawing แสดงแบบรายละเอียด 
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ออกแบบองคอาคารคอนกรีตโดยใช RC Designer  
การออกแบบคอนกรีตอาจทําโดยใช RC Designer ซ่ึงเปนโปรแกรมยอยใน STAAD.Pro 

< เริ่มตนโดยการเปดไฟลตัวอยางใน STAAD.Pro ขึ้นมา โดยจะอยูท่ีโฟลเดอร 
 ../STAAD/Examp/US/EXAMP09.STD 

 

< หลังจากเปดขึ้นมาแลวใหส่ัง Run Analysis ใหไดผลการวิเคราะหออกมากอน 

<  แปลงโมเดลเขาสู RC Designer โดยคลิกแถบ Concrete Design 
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< RC Designer จะเริ่มท่ีหนาใหเรากรอกขอมูล Job Information ซ่ึงจะไมใสก็ได 

< เราเลือกกรณีบรรทุกท่ีจะนํามาพิจารณาในการออกแบบ ไปท่ีหนา Des. Layer > 

Envelopes คลิกปุม New Env. ตั้งช่ือวา Envelope 1 ดังในรูป 

 

< หนาตาง Define Envelopes จะแสดงขึ้นมา จะเห็นน้ําหนักกรณี C3 รายการเดียว
เนื่องจากทางเลือก Show Combination Only ถูกเลือกอยู ใหคลิกเอาออกแลวกดปุม 
>> เพ่ือยายน้ําหนักทุกกรณีคือ L1, L2 และ C3 เขาไปใน Envelope E1 แลวกด OK 

 

< ไปท่ีหนายอย Members เพ่ือกําหนดองคอาคารท่ีจะทําการออกแบบ คลิกเลือกทุกองค
อาคารโดยใชเมาทลากตีกรอบหรือเลือกเมน ูSelect > Select All 

< เลือกเมนู Members > AutoForm Members ทุกองคอาคารจะถูกกําหนดหมายเลขใน
การออกแบบให สังเกตวาบางองคอาคารมีหมายเลขเดียวกัน 

< สําหรับหมายเลขท่ีถูกสรางขึ้นนั้น จะพบวาคานในแนวราบและเสามุมถูกกําหนดถูกตอง
แลว แตเสากลางถูกแบงเปนหลายสวน(M8, M9, M10, M11 และ M12, M13, M14, 
M15) 
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< เพ่ือรวมใหเปนเสาตนเดียว กอนอ่ืนใหเลือกท่ีละสวนโดยใช Member Cursor  แลว

กดปุม Delete ลบการกําหนดหมายเลขท่ีไมตองการออก (M8, M9, M10, M11 และ 
M12, M13, M14, M15) 

 
< เปล่ียนกลับไปใช Element Cursor  เลือกองคอาคารท้ังส่ีท่ีประกอบกันเปนเสาท่ีแต

ละดาน เลือกเมน ูMembers > Form Member จะไดเสาแตละขางเปน M8 และ M9 
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< ไปยังหนายอย Slabs คลิกไอคอน Side View  แลวใช Plate Cursor ตี
กรอบเลือกทุกแผนท่ีเปนพ้ืนช้ันบน (ระวังอยาเลือกผนังแผนบน) 

 

< เลือกเมนู Slabs > Form Slabs ดูในตาราง Slabs ดานขางจะเห็นวามี 32 แผนท่ีถูกสราง
ฟอรมขึ้นมา ถาทําผิดใหใช Select Slabs Cursor  เลือกแลวกด Delete แลวทําใหม 

< Beam Design Brief 

ไปท่ีหนา Groups/Briefs คลิกปุม New Brief ในหนาตาง Design Briefs ตั้งช่ือวา 

 

< จะมีรายการแสดงขึ้นมาในตาราง ในการตั้งคาพารามิเตอรใหดับเบิลคลิกท่ีปาย B1 ของ
รายการ 

 

< จะมีหนาตางแสดงขึ้นมาใหเรากําหนดพารามิเตอรในการออกแบบ 
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< Column Design Brief 

กลับมาท่ีตาราง Design Briefs  คลิกปุม New Brief ตั้งช่ือวา B2 Column Brief เลือก 
Design Code เปน ACI Column ดับเบ้ิลคลิกชอง B2 เพ่ือเปล่ียนตัวแปรในการ
ออกแบบตามตองการ เลือกแถบ Member Loadcases เลือกทุกกรณีโดยกดปุม >> 

 

< Slab Design Brief 

กลับมาท่ีตาราง Design Briefs  คลิกปุม New Brief ตั้งช่ือวา B3 Slab Brief เลือก 
Design Code เปน BS8110 Slab (เนื่องจากไมมี ACI Slab ใหเลือก) ดับเบ้ิลคลิกชอง 
B3 เพ่ือเปล่ียนตัวแปรในการออกแบบตามตองการ 
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< Beam Design Group 

ใช Member Cursor  เลือกคานท้ังหาท่ีอยูรอบพ้ืนและท่ีอยูบนผนังกลาง (M1, 

M2, M3, M4 และ M5) 

 

คลิกปุม New Design Group ในหนาตาง Design Groups และตั้งช่ือ 

 

ในชอง Design Brief เลือก B1 Beam Brief 

เพ่ือใหแนใจวาคานท่ีตองการเลือกอยูในกลุมจริง ดับเบ้ิลคลิกชอง G1 ในตาราง 
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< Column Design Group 

ใช Member Cursor  เลือกเสาท้ังหกตนรวมท้ังสองตนท่ีอยูดานขางผนังกลาง 
(M6, M7, M8, M9, M16 และ M17) 

 

คลิกปุม New Design Group ในหนาตาง Design Groups ตั้งช่ือ Column Design 

Group 1 ในชอง Design Brief เลือก B2 Column Brief 

 

เพ่ือใหแนใจวาเสาท่ีตองการเลือกอยูในกลุมจริง ดับเบ้ิลคลิกชอง G2 ในตาราง 
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< Slab Design object 

ในหนาตาง Design Groups คลิกแถบ Slabs แลวคลิกปุม New Design Slab 

 

 

< มาถึงขั้นนี้ โมเดลของเราพรอมท่ีจะทําการออกแบบแลว 

RC Designer > Beam Design  
< ไปยังหนา Concrete Member เริ่มเขาหนายอย Summary กลุมท่ีถูกแสดงขึ้นในตาราง

ขางซายของจอคือ G1 : Beam Design Group 1 ถาไมใชใหเลือกจากทูลบารดานบน 

 

สังเกตดูในตารางจะเห็นวา M4 และ M5 ถูกจัดเปนคานสองชวงโดยอัตโนมัติ 

< ไปยังหนายอย Design หนาตาง Design Options จะแสดงขึ้นมา แสดงหมายเลของค
อาคารท่ีสามารถออกแบบได เลือกท้ังหมดแลวคลิกปุม Design  
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< ไปยังหนายอย Main Layout แลวเลือก M4 จากรายการบนทูลบารดานบน ปรับตัวแบง
ชองหนาตางจนไดคานดังในรูปขางลาง 

 

รูปหนาตัดท่ีแสดงสามารถถูกเล่ือนไปมาไดโดยลากแนวหนาตัดในมุมมองดานขางหรือ
กําหนดคาในชองใตหนาตัดโดยตรง 

< เลือกเมนู File > ACI 318 Report Setup บนแถบ Items ในหนาตางท่ีแสดงขึ้นมา 
เลือกรายการ Design Detail จากชองทางซายแลวคลิก > ยายไปชองทางขวา 
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< คลิกแถบ Members คลิกปุม << เพ่ือไมเลือกทุกองคอาคาร แลวเลือกเฉพาะ M4 ยายไป
ชองดานขวาโดยคลิกปุม > เสร็จแลวคลิกปุม OK เพ่ือยอมรับการกําหนดคารายงาน 

< เพ่ือดูรายงาน เลือกเมน ูFile > Print Preview ประมาณหนาท่ี 5 
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RC Designer > Column Design  
< ไปยังหนา Concrete Member เริ่มเขาหนายอย Summary กลุมท่ีถูกแสดงขึ้นในตาราง

ขางซายของจอคือ G2 : Column Design Group 2 ถาไมใชใหเลือกจากทูลบารดานบน 

< ไปยังหนายอย Design หนาตาง Design Options จะแสดงขึ้นมา แสดงหมายเลของค
อาคารท่ีสามารถออกแบบได เลือกท้ังหมดแลวคลิกปุม Design  

< ถาเสารับโมเมนตดัดมากกวาแรงอัด โปรแกรมอาจแสดงคําเตือนแนะนําใหออกแบบเปน
คาน เม่ือออกแบบผานหมด เสาทุกตนจะเปนสีเขียว 

< ไปยังหนายอย Main Layout แลวเลือกรายการ M6  

< อาจเปล่ียนหนวยท่ีแสดงไดโดยเลือกเมนู View > Option 

 



STAAD.Pro : Concrete Design  8 - 28 
 

< รายการคํานวณ 

เลือกเมนู File > ACI 318 Report Setup บนแถบ Items ในหนาตางท่ีแสดงขึ้นมา 
เลือกรายการ Design Detail 

< คลิกแถบ Members คลิกปุม << เพ่ือไมเลือกทุกองคอาคาร แลวเลือกเฉพาะ M6 ยายไป
ชองดานขวาโดยคลิกปุม > เสร็จแลวคลิกปุม OK เพ่ือยอมรับการกําหนดคารายงาน 

< เพ่ือดูรายงาน เลือกเมน ูFile > Print Preview ประมาณหนาท่ี 2 
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RC Designer > Slab Design  
< ไปยังหนา Concrete Slab เริ่มเขาหนายอย Summary ในโมเดลนี้มีพ้ืนเพียงหนึ่งเดียว

คือ SD1 : Slab Design 1 ถามีมากกวานี้ใหเลือกพ้ืนท่ีตองการจากทูลบารดานบน 

< คลิกท่ีหนายอย Displacement  

 

< คลิกท่ีหนายอย Regions พ้ืนจะถูกวาดเปนแผนเดียวกันอยู การแบงพ้ืนทําโดยเลือกเมนู 
Regions > Draw Boundaries ลากเสนเช่ือมโหนดคูกลางดังในรูป 
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< ในตาราง Regions ดานขวา คลิกรายการ Reg 1 เปล่ียน Orientation เปน 90o ดังในรูป 

 

< คลิกท่ีหนายอย Design หนาตางขอกําหนดการออกแบบจะแสดงขึ้นมาใหกดปุม Design 
เพ่ือเริ่มทําการออกแบบ 

< เปล่ียนรายการเลือกในทูลบารดานบนเปน Bottom : Y และ Reqd. Steel 

< เลือกเมนู View > Diagram คลิกแถบ Design Contour เลือก Style = Filled แลว
คลิก OK จะไดรูปขางลาง 

 

< รายการคํานวณ 

เลือกเมนู File > BS8110 Report Setup ตรวจดูวารายการท่ีถูกเลือกใหแสดงคือ 

Job Information 
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Slab Brief Detail 
Slab Information 
Region Information 
Design Information 

< เพ่ือดูรายงาน เลือกเมน ูFile > Print Preview ประมาณหนาท่ี 2 
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